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1 Introduction 
1.1 About this Manual 

This manual provides information on how to set and configure the device 
parameters of a netX based Sercos Slave device within a FDT Framework 
using the Sercos Slave DTM, and what can be read from the diagnosis 
panes. 

In a network project the Sercos Slave DTM can be dropped: 

• to the root line (Stand-Alone Slave), 

• or to the Master busline of a Sercos Master DTM. 
 

 
Note: This manual edition first provides information for the case if the 
Sercos Slave DTM is dropped to the root line (Stand-Alone Slave) and in 
addition important information for the case if the Sercos Slave DTM is 
dropped to the Master busline of a Sercos Master DTM. 
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1.1.1 Descriptions of the Dialog Panes 
The table below gives an overview for the individual dialog panes 
descriptions: 
 

Section Subsection Manual  
Page 

Settings Overview Settings  32 
 Driver 35 
 Device Assignment 45 
 Firmware Download 51 
Offline Parameterization Support for Multi-Slave Devices 57 
 Electronic Label 62 
 Overview Configuration 64 
 General 66 
 User-defined Parameters 93 
 FSP IO 102 
 FSP Drive 116 
Online Parameterization  - 
 Upper Part of Dialog Pane 129 
 Lower Part of Dialog Pane 137 
Online Functions Connecting/Disconnecting Device 140 
 Download Configuration 142 
Diagnosis Overview Diagnosis 144 
 General Diagnosis  145 
 Firmware Diagnosis 147 
Extended Diagnosis Overview Extended Diagnosis 148 

Table 1: Descriptions Dialog Panes 

 
 

1.1.2 Online Help 
The Sercos Slave DTM contains an integrated online help facility. 

 To open the online help, click on Help or press F1. 
 

1.1.3 List of Revisions 
Index Date Version Chapter Revision 
4 17-02-17 1.1000 1.4.1  Section Requirements Internet access added, Windows 8.1 and 

Windwos 10 added. 
Terminology adapted to current Sercos convention (“sercos” => 
“Sercos”). 

5 18-02-14 1.1000  
2.5.1, 
 
3.2,  
4.5, 7.2     

Versioning information revised (title page and this section).  
Safety Message or warning added: Sections Power Disconnect 
while dowloading Firmware or Configuration,  
Safety Messages on Firmware or Configuration Download, 
Firmware Download and Download Configuration. 
Safety communication in the document revised in general. 

Table 2: List of Revisions 
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1.1.4 Conventions in this Manual 

Notes, operation instructions and results of operation steps are marked as 
follows: 

Notes 
 
 

 

Important: <important note you must follow to avoid malfunction> 

 

 

Note:  <general note> 

 

 

<note, where to find further information> 

 

Operation Instructions 
 

1. <instruction> 

2. <instruction> 
 

or 
 

 <instruction> 

 

Results 
 

 <result> 
 
 

Positions in Figures 

The Positions , ,  ... or , ,  ... or , ,  ...  refer to the 
figure used in that section. If the numbers reference to a section outside the 
current section then a cross reference to that section and figure is 
indicated. 
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1.2 Legal Notes 

Copyright 
© Hilscher Gesellschaft für Systemautomation mbH 

All rights reserved. 

The images, photographs and texts in the accompanying materials (in the 
form of a user's manual, operator's manual, Statement of Work document 
and all other document types, support texts, documentation, etc.) are 
protected by German and international copyright and by international trade 
and protective provisions. Without the prior written consent, you do not 
have permission to duplicate them either in full or in part using technical or 
mechanical methods (print, photocopy or any other method), to edit them 
using electronic systems or to transfer them. You are not permitted to make 
changes to copyright notices, markings, trademarks or ownership 
declarations. Illustrations are provided without taking the patent situation 
into account. Any company names and product designations provided in 
this document may be brands or trademarks by the corresponding owner 
and may be protected under trademark, brand or patent law. Any form of 
further use shall require the express consent from the relevant owner of the 
rights. 

Important notes 
Utmost care was/is given in the preparation of the documentation at hand 
consisting of a user's manual, operating manual and any other document 
type and accompanying texts. However, errors cannot be ruled out. 
Therefore, we cannot assume any guarantee or legal responsibility for 
erroneous information or liability of any kind. You are hereby made aware 
that descriptions found in the user's manual, the accompanying texts and 
the documentation neither represent a guarantee nor any indication on 
proper use as stipulated in the agreement or a promised attribute. It cannot 
be ruled out that the user's manual, the accompanying texts and the 
documentation do not completely match the described attributes, standards 
or any other data for the delivered product. A warranty or guarantee with 
respect to the correctness or accuracy of the information is not assumed. 

We reserve the right to modify our products and the specifications for such 
as well as the corresponding documentation in the form of a user's manual, 
operating manual and/or any other document types and accompanying 
texts at any time and without notice without being required to notify of said 
modification. Changes shall be taken into account in future manuals and do 
not represent an obligation of any kind, in particular there shall be no right 
to have delivered documents revised. The manual delivered with the 
product shall apply. 

Under no circumstances shall Hilscher Gesellschaft für Systemautomation 
mbH be liable for direct, indirect, ancillary or subsequent damage, or for 
any loss of income, which may arise after use of the information contained 
herein. 

Liability disclaimer 
The hardware and/or software was created and tested by Hilscher 
Gesellschaft für Systemautomation mbH with utmost care and is made 
available as is. No warranty can be assumed for the performance or 
flawlessness of the hardware and/or software under all application 
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conditions and scenarios and the work results achieved by the user when 
using the hardware and/or software. Liability for any damage that may have 
occurred as a result of using the hardware and/or software or the 
corresponding documents shall be limited to an event involving willful intent 
or a grossly negligent violation of a fundamental contractual obligation. 
However, the right to assert damages due to a violation of a fundamental 
contractual obligation shall be limited to contract-typical foreseeable 
damage. 

It is hereby expressly agreed upon in particular that any use or utilization of 
the hardware and/or software in connection with 

• Flight control systems in aviation and aerospace; 

• Nuclear fusion processes in nuclear power plants; 

• Medical devices used for life support and 

• Vehicle control systems used in passenger transport 

shall be excluded. Use of the hardware and/or software in any of the 
following areas is strictly prohibited: 

• For military purposes or in weaponry; 

• For designing, engineering, maintaining or operating nuclear systems; 

• In flight safety systems, aviation and flight telecommunications systems; 

• In life-support systems; 

• In systems in which any malfunction in the hardware and/or software 
may result in physical injuries or fatalities. 

You are hereby made aware that the hardware and/or software was not 
created for use in hazardous environments, which require fail-safe control 
mechanisms. Use of the hardware and/or software in this kind of 
environment shall be at your own risk; any liability for damage or loss due 
to impermissible use shall be excluded. 

Warranty 
Hilscher Gesellschaft für Systemautomation mbH hereby guarantees that 
the software shall run without errors in accordance with the requirements 
listed in the specifications and that there were no defects on the date of 
acceptance. The warranty period shall be 12 months commencing as of the 
date of acceptance or purchase (with express declaration or implied, by 
customer's conclusive behavior, e.g. putting into operation permanently). 

The warranty obligation for equipment (hardware) we produce is 36 
months, calculated as of the date of delivery ex works. The aforementioned 
provisions shall not apply if longer warranty periods are mandatory by law 
pursuant to Section 438 (1.2) BGB, Section 479 (1) BGB and Section 634a 
(1) BGB [Bürgerliches Gesetzbuch; German Civil Code] If, despite of all 
due care taken, the delivered product should have a defect, which already 
existed at the time of the transfer of risk, it shall be at our discretion to 
either repair the product or to deliver a replacement product, subject to 
timely notification of defect. 

The warranty obligation shall not apply if the notification of defect is not 
asserted promptly, if the purchaser or third party has tampered with the 
products, if the defect is the result of natural wear, was caused by 
unfavorable operating conditions or is due to violations against our 
operating regulations or against rules of good electrical engineering 
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practice, or if our request to return the defective object is not promptly 
complied with. 

Costs of support, maintenance, customization and product care 
Please be advised that any subsequent improvement shall only be free of 
charge if a defect is found. Any form of technical support, maintenance and 
customization is not a warranty service, but instead shall be charged extra. 

Additional guarantees 
Although the hardware and software was developed and tested in-depth 
with greatest care, Hilscher Gesellschaft für Systemautomation mbH shall 
not assume any guarantee for the suitability thereof for any purpose that 
was not confirmed in writing. No guarantee can be granted whereby the 
hardware and software satisfies your requirements, or the use of the 
hardware and/or software is uninterruptable or the hardware and/or 
software is fault-free. 

It cannot be guaranteed that patents and/or ownership privileges have not 
been infringed upon or violated or that the products are free from third-party 
influence. No additional guarantees or promises shall be made as to 
whether the product is market current, free from deficiency in title, or can be 
integrated or is usable for specific purposes, unless such guarantees or 
promises are required under existing law and cannot be restricted. 

Confidentiality 
The customer hereby expressly acknowledges that this document contains 
trade secrets, information protected by copyright and other patent and 
ownership privileges as well as any related rights of Hilscher Gesellschaft 
für Systemautomation mbH. The customer agrees to treat as confidential all 
of the information made available to customer by Hilscher Gesellschaft für 
Systemautomation mbH and rights, which were disclosed by Hilscher 
Gesellschaft für Systemautomation mbH and that were made accessible as 
well as the terms and conditions of this agreement itself. 

The parties hereby agree to one another that the information that each 
party receives from the other party respectively is and shall remain the 
intellectual property of said other party, unless provided for otherwise in a 
contractual agreement. 

The customer must not allow any third party to become knowledgeable of 
this expertise and shall only provide knowledge thereof to authorized users 
as appropriate and necessary. Companies associated with the customer 
shall not be deemed third parties. The customer must obligate authorized 
users to confidentiality. The customer should only use the confidential 
information in connection with the performances specified in this 
agreement. 

The customer must not use this confidential information to his own 
advantage or for his own purposes or rather to the advantage or for the 
purpose of a third party, nor must it be used for commercial purposes and 
this confidential information must only be used to the extent provided for in 
this agreement or otherwise to the extent as expressly authorized by the 
disclosing party in written form. The customer has the right, subject to the 
obligation to confidentiality, to disclose the terms and conditions of this 
agreement directly to his legal and financial consultants as would be 
required for the customer's normal business operation. 
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Export provisions 
The delivered product (including technical data) is subject to the legal 
export and/or import laws as well as any associated regulations of various 
countries, especially such laws applicable in Germany and in the United 
States. The products / hardware / software must not be exported into such 
countries for which export is prohibited under US American export control 
laws and its supplementary provisions. You hereby agree to strictly follow 
the regulations and to yourself be responsible for observing them. You are 
hereby made aware that you may be required to obtain governmental 
approval to export, reexport or import the product. 
 

 

1.3 Registered Trademarks 
Windows® XP, Windows® Vista, Windows® 7, Windows® 8, Windows® 8.1 
and Windows® 10 are registered trademarks of Microsoft Corporation. 

Sercos and Sercos interface are registered trademarks of Sercos 
international e. V., Suessen, Germany. 

CODESYS® is a registered trademark of 3S-Smart Software Solutions 
GmbH, Deutschland. 

All other mentioned trademarks are property of their respective legal 
owners. 
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1.4 About Sercos Slave DTM 
You can use the Sercos Slave DTM to configure Sercos Slave devices 
within a FDT Framework and to view the device diagnosis. 

In a network project the Sercos Slave DTM can be dropped: 

• to the root line (Stand-Alone Slave), 

• or to the Master busline of a Sercos Master DTM. 

 

Slave DTM at the Root-Line (Stand-Alone Slave) 
Insert the Sercos Slave DTM to the root busline if you intend to configure 
only one single Sercos Slave device. 

Slave DTM at the Master Busline 
Insert the Sercos Slave DTM to the Master busline of the Sercos Master 
DTM if within the network project the Slave device and the Master device 
are used, i. e. if you intend to configure the Slave device and the Master 
device. 
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1.4.1 Requirements 
System Requirements 

• PC with 1 GHz processor or higher 

• Windows® XP SP3,  
Windows® Vista (32-Bit) SP2,   
Windows® 7 (32-Bit and 64-Bit) SP1,   
Windows® 8 (32-Bit and 64-Bit),  
Windows® 8.1 (32-Bit and 64-Bit),   
Windows® 10 (32-Bit and 64-Bit) 

• Administrator privilege required for installation 

• Internet Explorer 5.5 or higher 

• RAM: min. 512 MByte, recommended 1024 MByte 

• Graphic resolution: min. 1024 x 768 pixel 

• Keyboard and Mouse 

• Restriction: Touch screen is not supported. 
 

 

Note: If the project file is used on a further PC,  

 this PC must also comply with the above system requirements, 

 the device description files of the devices used in the project must be 
imported into the configuration software SYCON.net on the new PC, 

 and the DTMs of the devices used in the project must also be installed 
on that further PC. 

 
 
 

Requirements Sercos Slave DTM 
To configure the Sercos Slave device with the Sercos Slave DTM the 
following requirements have to be accomplished: 

• Completed hardware installation of a netX based DTM-compatible 
Sercos Slave device, inclusive loaded firmware and loaded configuration 
file 

• Installed FDT/DTM V 1.2 compliant frame application 

• Installed Sercos Master DTM (If Slave DTM is dropped to the Master 
busline.) 

• Loaded DTM in the Device Catalog of the FTD Framework 
 

 
Note: If the Sercos Slave DTM and the Sercos Slave device are installed 
on the same PC, the cifX Device Driver must be installed on that PC, as 
you can connect the DTM to the device.  

 

 

For more information to the hardware installation, please refer to the 
corresponding User Manual of your device.  

 
 

 



Introduction 15/189 

DTM for Hilscher Sercos Slave Device | Configuration of Hilscher Slave Devices  
DOC110701OI05EN | Revision 5 | English | 2018-04 | Released | Public  © Hilscher, 2012-2018 

1.5 Dialog Structure of the Sercos Slave DTM 
The graphical user interface of the DTM is composed of different areas and 
elements listed hereafter: 

1. A header area containing the General Device Information, 

2. The Navigation Area (area on the left side), 

3. The Dialog Pane (main area on the right side), 

4. OK, Cancel, Apply, Help, 

5. The Status Line containing information e. g. the online-state of the 
DTM. 

 

 
Figure 1: Dialog Structure of the Sercos Slave DTM 
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1.5.1 General Device Information 
 

Parameter Meaning 
IO Device Name of the device 

Vendor Vendor name of the device 

Device ID Identification number of the device 

Vendor ID Identification number of the vendor 

Table 3: General Device Information 

 
 

1.5.2 Navigation Area 
The Navigation Area contains folders and subfolders to open the dialog 
panes of the DTM. 

 

Figure 2: Navigation Area 

 To access a DTM dialog pane select the respective item of the 
navigation tree structure. 

 Select the required folder and subfolder. 

 The corresponding Dialog pane is displayed.  

Hide / display Navigation 
 

 Hiding the navigation area (above right side). 

 
Opening the navigation area (below left side). 
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1.5.3 Dialog Panes 
At the dialog pane the Settings, Configuration, Diagnosis/Extended 
Diagnosis or the Tools panes are opened via the corresponding folder in 
the navigation area. 
 

Settings 
   Driver To establish a connection from the Sercos Slave DTM to the Sercos Slave device, on 

the pane Driver you can verify if the default driver is checked and respectively check 
another driver or multiple drivers. For further information, refer to section Driver on 
page 35. 

    Device Assignment On the pane Device Assignment you select the device and assign the device to the 
driver. For further information, refer to section Device Assignment on page 45. 

   Firmware Download The dialog on the pane Firmware Download is used to load a new firmware into the 
device. A detailed description can be found in section Firmware Download on page 51. 

Offline Parameterization 
   Electronic Label At the Electronic Label pane all information about the device which has been stored in 

the electronic label can be displayed. These are mainly identification data. 
More information on this topic is available in section Electronic Label on page 62 . 

   General At the pane General the current Station Address of the Sercos Slave device is 
displayed. Further the information whether the device has a fixed or a variable 
configuration can be found there. 
You can find more about these topics in section General on page 66 . 

   Configuration On the pane Configuration you can access a lot of Sercos specific configuration 
parameters. Read more in section Configuration  on page 67. 

   User-defined 
Parameters 

The User-defined Parameters pane displays information on the IDN parameter sets of 
different communication phases. See section User-defined Parameters on page 93. 

   FSP IO The FSP IO pane allows it to change the parameter settings of the modules. This 
window is only present if supported by the device profile. You find a detailed description 
in section FSP IO on page 102. 

   FSP Drive At the FSP Drive pane you can access inputs and outputs. 
This window is only present if supported by the device profile. It is described in detail in 
section FSP Drive on page 116. 

Online Parameterization 
… Online 
Parameterization 

The online configuration window  is divided in two parts.  

• The upper part is described in section Upper Part of Dialog Pane at page 129. 
• The lower part is described in section Lower Part of Dialog Pane at page 137.. 

Diagnosis 

   Diagnosis/ 
   Extended Diagnosis 

At the Diagnosis panes information can be read for troubleshooting. For further 
information, refer to section Overview Diagnosis on page 144. 

Table 4: Overview Dialog Panes 

 

 
Note: Accessing the Diagnosis panes of the Sercos Slave DTM requires 
an online connection from the Sercos Slave DTM to the Sercos Slave 
DTM.  

 

For further information, refer to section Connecting/Disconnecting Device 
on page 140. 
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1.5.4 OK, Cancel, Apply and Help 
OK, Cancel, Apply and Help you can use as described hereafter. 
 

 Meaning 
OK To confirm your latest settings, click OK. All changed values will be applied on the frame application 

database.  
The dialog then closes. 

Cancel To cancel your latest changes, click Cancel.  
Answer to the safety query Configuration data has been changed. Do you want to save the data? 
by Yes, No or Cancel. 
Yes: The changes are saved or the changed values are applied on the frame application database.  
The dialog then closes. 
No: The changes are not saved or the changed values are not applied on the frame application 
database.  
The dialog then closes. 
Cancel: Back to the DTM. 

Apply To confirm your latest settings, click Apply. All changed values will be applied on the frame application 
database.  
The dialog remains opened. 

Help To open the DTM online help, click Help.  

Table 5: OK, Cancel, Apply and Help 

 

1.5.5 Table Lines 
In the DTM dialog pane table lines can be selected, inserted or deleted. 
 

 Meaning 

 
To select the first line of a table use First Line. 

 
To select the previous line of a table use Previous Line. 

 
To select the next line of a table use Next Line. 

 
To select the last line of a table use Last Line. 

 
Create a new Line inserts new lines into the table. 

 
Delete selected Line deletes the selected line from the table.  

Table 6: Selecting, inserting, deleting Table Line 
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1.5.6 Status Bar 
The Status Bar displays information about the current state of the DTM. 
The current activity, e.g. download, is signaled graphically via icons in the 
status bar. 

 
Figure 3: Status Bar – Status Fields 1 to 6 

 

Status 
Field 

Icon / Meaning 

1 DTM Connection States 
 

 
Connected: Icon closed = Device is online 

 
 

Disconnected: Icon opened = Device is offline 

2 Data Source States 
 

 
Data set: The displayed data are read out from the instance data set 
(database). 

 
 

Device: The displayed data are read out from the device. 

3 States of the instance Date Set 
 

 
Valid Modified: Parameter is changed (not equal to data source). 

4 Changes directly made on the Device 
 

 
Load/configure diagnosis parameters: Diagnosis is activated. 

6 Device Diagnosis Status 

 
 

Save operation succeeded: The save operation has been successful. 

Further messages due to successful handling of device data. 
   Firmware Download: Firmware Download is running 

 
 

Save operation failed: The save operation has failed. 

Further fail operation messages due to incorrect communication due to 
malfunction in the field device or its peripherals. 

Table 7: Status Bar Icons [1] 

 

Offline State 
 

 
Save operation 
succeeded  

 
Firmware Download 

 
 

Firmware Download 
successful  

 
Online State and 
Diagnosis  

Figure 4: Status Bar Display Examples 
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2 Safety 
 
 

2.1 General Note 
The documentation in the form of a user manual, an operating instruction 
manual or other manual types, as well as the accompanying texts have 
been created for the use of the products by educated personnel. When 
using the products, all Safety Messages, Integrated Safety Messages, 
Property Damage Messages and all valid legal regulations must be obeyed. 
Technical knowledge is presumed. The user has to assure that all legal 
regulations are obeyed. 
 

2.2 Intended Use 
The Sercos Master DTM serves for configuration and diagnosis of Sercos 
Master devices.  
 

2.3 Personnel Qualification 
Personnel responsible for the application of the network system shall be 
aware of the system behavior and shall be trained in using the system. 
 
 

2.4 Safety Instructions 
To ensure your own personal safety and to avoid personal injury, you 
necessarily must read, understand, and comply with the safety instructions 
and safety messages in this manual before you install and operate your 
system. 

For cases if both, personal injury as well as property damage (damage of 
equipment or device) may occur together, you find the safety instructions in 
this section. 
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2.4.1 Communication Stop during Firmware or Configuration 
Download 

If you want to perform either a firmware update (as a download) or a 
configuration download, both via the Sercos Slave DTM, be aware of the 
following: 

• Together with the firmware download, an automated reset to the device 
is performed that will interrupt all network communication and all 
established connections will drop. 

• If you download the configuration during bus operation, the 
communication between master and slaves is stopped. 

Possible faulty System Operation 

• An unpredictable and unexpected behavior of machines and plant 
components may cause personal injury and property damage. 

 Stop the application program, before starting the firmware update or 
before downloading the configuration. 

 Make sure that your equipment operates under conditions that prevent 
personal injury or property damage. All network devices should be 
placed in a fail-safe mode, before starting the firmware update or before 
downloading a configuration. 

Loss of Device Parameters, Overwriting of Firmware 

• Both the firmware download and the configuration download erase the 
configuration data base. The firmware download overwrites the existing 
firmware in the network device. 

 To complete the firmware update and to make the device operable 
again, re-load the configuration after the firmware update has been 
finished. 

• Device parameters that have been saved volatile, e. g. as the 
temporarily set IP address parameters, are getting lost during the reset. 

 In order to prevent loss of configuration data, make sure that your 
project configuration data are saved non-volatile, before you initiate a 
firmware update or download the configuration. 

 

2.4.2 Mismatching System Configuration 
Mismatching system configuration loaded into the device could result in 
faulty data mapping in the application program and thus unexpected 
equipment operation may cause personal injury or damage of equipment. 

 In the device use only a configuration suitable for the system. 
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2.5 Property Damage 
To avoid property damage and damage to your system or to your 
equipment, you necessarily must read, understand, and comply with the 
safety instructions and safety messages in this manual before you 
configure your system. 
 
 

2.5.1 Power Disconnect while dowloading Firmware or Configuration  
 

If during the process of downloading a firmware or configuration 

• the power supply to a PC with the software application is interrupted, 

• or the power supply to the Sercos Slave device is interrupted, 

• or a reset to the device is performed, 

this may lead to the following consequences: 

Loss of Device Parameters, Firmware Corruption 

• The firmware download or the configuration download will be interrupted 
and remains incomplete. 

• The firmware or the configuration database will be corrupted and device 
parameters will be lost. 

• Device damage may occur as the device cannot be rebooted. 

Whether these consequences occur depends on when the power 
disconnect occurs during the download. 
 

Power Drop during Write and Delete Accesses in the File System 
The FAT file system in the netX firmware is subject to certain limitations in 
its operation. Write and delete accesses in the file system (firmware 
update, configuration download etc.) can destroy the FAT (File Allocation 
Table) if the accesses cannot be completed if the power drops. Without a 
proper FAT, a firmware may not be found and cannot be started. 

Make sure that the power supply to the device is not interrupted during 
write and delete accesses in the file system (firmware update, configuration 
download, etc.). 
 
 

2.5.2 Invalid Firmware 
Loading invalid firmware files could render your device unusable.  

 Only download firmware files to the device that are valid for this device. 

Otherwise you might be forced to return your device for repair. 
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2.6 Labeling of Safety Messages 
• The Section Safety Messages at the beginning of a chapter are 

pinpointed particularly and highlighted by a signal word according to the 
degree of endangerment. The type of danger is specified by the safety 
message text  

• The Integrated Safety Messages within an instruction description are 
highlighted with a signal word according to the degree of endangerment. 
The kind of danger is specified exactly by the safety message text.  

 

Signal Word Meaning (International) Meaning (USA) 

 Indicates a direct hazard with high risk, which 
will have a consequence of death or grievous 
bodily harm if it is not avoided. 

Indicates a hazardous situation which if not 
avoided, will result in death or serious injury. 

 Indicates a possible hazard with medium risk, 
which will have a consequence of death or 
(grievous) bodily harm if it is not avoided. 

Indicates a hazardous situation which if not 
avoided, could result in death or serious injury. 

 Indicates a minor hazard with medium risk, 
which could have a consequence of minor or 
moderate bodily harm if it is not avoided. 

Indicates a hazardous situation which if not 
avoided, may result in minor or moderate injury. 

 Indicates a property damage message. Indicates a property damage message. 

Table 8: Signal Words 

 

Note: The ANSI Z535.6 standard specifies in section 4.8: "Messages 
about hazards that could result in both, physical injury and property 
damage are considered safety messages, not property damage 
messages." Thus depending of the type of danger and its consequences, 
warning messages marked by a signal word DANGER, WARNING or 
CAUTION may include both, messages on physical injury and property 
damage. 

 

In this document all Safety Instructions and Safety Messages are designed 
according both to the international used safety conventions as well as to 
the ANSI Z535.6 standard, refer to safety reference [S1]. 
 

In this document the signal words ‘WARNING’, ‘CAUTION’ and ‘NOTICE’ are used 
according to ANSI Z535.6 standard. The meaning given in ISO/IEC 26514 [S4] section 
‘11.11 Contents of warnings and cautions’ is not relevant in this manual. 

2.7 References Safety 
 

[S1] ANSI Z535.6-2011 American National Standard for Product Safety Information in 
Product Manuals, Instructions, and Other Collateral Materials 

 
 

[S4] 26514-2010  -  IEEE Standard for Adoption of ISO/IEC 26514:2008 Systems and 
Software Engineering--Requirements for Designers and Developers of User 
Documentation 
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3 Getting started 
 

3.1 Configuration Steps 
The following overview provides to you the step sequence on how to 
configure a netX based Sercos Slave device with Sercos Slave DTM as it is 
typical for many cases. At this time it is presupposed that the hardware 
installation was done. 

The overview lists all the steps in a compressed form. For detailed 
descriptions of each step refer to the sections noted in the column For 
detailed information see section. 

The following two cases are considered: 

• Slave DTM at the Root-Line (Stand-Alone Slave)  

• and Slave DTM at the Master busline.  
 

3.1.1 Slave DTM at the Root-Line (Stand-Alone Slave) 
 

# Step Short Description For detailed information 
see section 

Page 

1 Load device 
catalog 

Depending of the FDT Container: 
For netDevice: 
- select Network > Device Catalog, 
- select Reload Catalog. 

 
(See Operating Instruction 
Manual netDevice and 
netProject) 

- 

2 Create new 
project / Open 
existing project 

Depending of the frame application. 
For the configuration software: 
- select File > New or File > Open. 

(See Operating Instruction 
Manual of the Frame 
Application) 

- 

3 Insert Slave into 
configuration 

Depending of the FDT Container: 
For netDevice: 
- in the Device Catalog under Gateway / Stand-
Alone Slave click to the Slave, 
- and insert the Slave via drag and drop  
to the root line in the network view. 

 
(See Operating Instruction 
Manual netDevice and 
netProject) 

- 

4 Open the Slave 
DTM configu-
ration dialog 

Open the Slave DTM configuration dialog. 
- Double click to the device icon of the Slave. 
- The Slave DTM configuration dialog is 
displayed. 

- - 
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# Step Short Description For detailed information 
see section 

Page 

5 Verify or adapt 
Driver Settings 

In the Slave DTM configuration dialog: 
- select Settings > Driver. 

 
• Note! For PC cards cifX the cifX 

Device Driver is preset as a default 
driver. For all the other Hilscher 
devices the netX Driver is preset as 
a default driver.Use the cifX Device 
Driver if the Sercos Slave DTM is 
installed on the same PC as the 
Sercos Slave device. 

• Use the netX Driver to establish a 
USB, Serial (RS232) or TCP/IP 
connection from the Sercos Slave 
DTM to the Sercos Slave device. 

• The 3SGateway Driver for netX 
(V3.x) is used only in relationship 
with CODESYS. 

To search for devices you can check 
one or multiple drivers simultaneously. 

- Verify that the default driver is checked. 
- If necessary, check another driver or multiple 
drivers. 

Settings for Driver and 
Device Assignment 
and 
Driver  

33 
 
 
35 

6 Configure Driver If you use the netX Driver, you respectively must 
configure it. 
For netX Driver and communication via TCP/IP 
set the IP address of the device: 
- Select Settings > Driver > netX Driver > TCP 
Connection. 
- Via  add an IP range. 
- Under IP Address enter the IP Address of the 
device or an IP range. 
- Click Save. 
Adjust the driver parameters netX Driver 
USB/RS232 only if they differ from the default 
settings. 

 

Note!  
• The cifX Device Driver requires no 

configuration. 
• The configuration of the 3SGateway 

Driver for netX (V3.x) is carried out 
via the CODESYS surface. 

 

 
Configuring netX Driver 
 
 

 
38 
 

7 Assign Slave 
device (with or 
without firmware) 

Assign the device to this driver. 
In the Slave DTM configuration dialog: 
- select Settings > Device Assignment, 
- select a Slave device (with or without firmware), 
- therefore check the appropriate checkbox, 
- select Apply. 

Selecting the Device (with 
or without firmware) 

48 

8 Select and 
download 
firmware 

If not yet a firmware was loaded to the device: 
- Adhere to the necessary safety precautions to 
prevent personnel injury and property damage. 
In the Slave DTM configuration dialog: 
- select Settings > Firmware Download, 
- select Browse.., 
- select a firmware file, 
- select Open, 
- select Download and Yes. 

Safety Messages on 
Firmware or Configuration 
Download 
 
Firmware Download 

31 
 
 
 
51 
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# Step Short Description For detailed information 
see section 

Page 

9 Assign Slave 
device once 
more (with 
firmware and 
system chanal) 
For repeated 
download this 
step is omitted. 

In the Slave DTM configuration dialog: 
- select Settings > Device Assignment, 
- select Scan, 
- select the Slave device (with loaded firmware 
and defined system channel), 
- therefore check the appropriate checkbox, 
- select Apply, 
- close the Slave DTM configuration dialog via 
OK. 

Selecting the Device once 
more (with Firmware) 

49 

10 Configure Slave 
device 

Configure the Slave device. 
- Select the device icon of the Slave and select 
Configuration in context menu. 
- The Slave DTM configuration dialog is  
displayed.  
In the Slave DTM configuration dialog: 
- Select the slave device to be configured 
   as described in section Support for Multi-Slave 
Devices 
- select Electronic Label, 
- check the device-specific information,  
- select General,  
   check Sercos address 
- select Configuration, 
- set the Interface, Ident and Slave-specific  
parameters,  
- select  
   User-defined Parameters 
   in the navigation area.  
- set user-defined parameters 
   of the device:  
- in case of an FSP IO device select 
 FSP IO  
- and set the module Parameters,  
- in case of an FSP Drive select 
 FSP Drive, and  
perform detailed parameterization,  
- close the Slave DTM configuration dialog via  
the button OK. 

Setting Slave Parameters 
 
 
 
 
 
 
 
 
Electronic Label 
 
General 
 
Configuration 
 
 
 
User-defined Parameters 
 
 
 
 
FSP IO 
 
 
FSP Drive 

59 
 
 
 
 
 
 
 
 
62 
 
66 
 
67 
 
 
 
93 
 
 
 
 
102 
 
 
116   

11 Save project Depending of the frame application. 
For the configuration software: 
- select File > Save. 

(See Operating Instruction 
Manual of the Frame 
Application) 

- 

12 Connect Slave 
device 

Depending of the FDT Container. 
For netDevice: 
- right click to the device icon of the Slave, 
- select Connect. 

Connecting/Disconnecting 
Device 

140 

13 Download 
Configuration 

- Adhere to the necessary safety precautions to 
prevent personnel injury and property damage. 
Depending of the FDT Container. 
For netDevice:  
- right click to the device icon of the Slave, 
- select Download. 

Safety Messages on 
Firmware or Configuration 
Download 
 
Download Configuration  

31 
 
 
 
142   
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# Step Short Description For detailed information 
see section 

Page 

14 Diagnosis Depending of the FDT Container. 
For netDevice: 
- right click to the device icon of the Slave, 
- select Diagnosis. 
- The Slave DTM diagnosis dialog is displayed. 
(1) Check whether the communication is OK: 
Diagnosis > General Diagnosis > Device 
status "Communication" must be green! 
(2) „Communication“ is green: Open thel IO 
Monitor and test the input or output data. 
(3) „Communication“ is not green: Use 
Diagnosis and Extended diagnosis for 
troubleshooting. 
- close the Slave DTM diagnosis dialog via OK. 

Overview Diagnosis 144 

16 Disconnect Depending of the FDT Container. 
For netDevice:  
- right click to the device icon of the Slave, 
- select Disconnect. 

Connecting/Disconnecting 
Device 

140 

Table 9: Getting started - Configuration Steps  (Slave DTM at the Root-Line (Stand-Alone 
Slave)) 

3.1.2 Slave DTM at the Master bus line 
 

# Step Short Description For detailed information 
see section 

Page 

1 Load device 
catalog 

Depending of the FDT Container: 
For netDevice: 
- select Network > Device Catalog, 
- select Reload Catalog. 

 
(See Operating Instruction 
Manual netDevice and 
netProject) 

- 

2 Create new 
project / Open 
existing project 

Depending of the frame application. 
For the configuration software: 
- select File > New or File > Open. 

(See Operating Instruction 
Manual of the Frame 
Application) 

- 

3 Insert Master or 
Slave into 
configuration 

For netDevice: 
- in the Device Catalog click to the Master, 
- and insert the device via drag and drop  
to the root line in the network view, 
- in the Device Catalog click to the Slave, 
- and insert the device via drag and drop  
to the Master bus line in the network view. 

 
(See Operating Instruction 
Manual netDevice and 
netProject) 

- 

4 Open the Slave 
DTM configuration 
dialog  

Open the Slave DTM configuration dialog. 
- Double click to the device icon of the Slave. 
- The Slave DTM configuration dialog is 
displayed. 

- - 
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# Step Short Description For detailed information 
see section 

Page 

5 Verify or adapt 
Driver Settings 

In the Salve DTM configuration dialog: 
- select Settings > Driver. 

 
• Note! For PC cards cifX the cifX 

Device Driver is preset as a default 
driver. For all the other Hilscher 
devices the netX Driver is preset as 
a default driver.Use the cifX Device 
Driver if the Sercos Slave DTM is 
installed on the same PC as the 
Sercos Slave device. 

• Use the netX Driver to establish a 
USB, Serial (RS232) or TCP/IP 
connection from the Sercos Slave 
DTM to the Sercos Slave device. 

• The 3SGateway Driver for netX 
(V3.x) is used only in relationship 
with CODESYS. 

To search for devices you can check 
one or multiple drivers simultaneously. 

 

- Verify that the default driver is checked. 
- If necessary, check another driver or multiple 
drivers. 

Settings for Driver and 
Device Assignment 
and 
Driver  

33 
 
 
35 

6 Configure Driver If you use the netX Driver, you respectively must 
configure it. 
For netX Driver and communication via TCP/IP 
set the IP address of the device: 
- Select Settings > Driver > netX Driver > TCP 
Connection. 
- Via  add an IP range. 
- Under IP Address enter the IP Address of the 
device or an IP range. 
- Click Save. 
Adjust the driver parameters netX Driver 
USB/RS232 only if they differ from the default 
settings. 

 

Note!  
• The cifX Device Driver requires no 

configuration. 
• The configuration of the 3SGateway 

Driver for netX (V3.x) is carried out 
via the CODESYS surface. 

 

 
Configuring netX Driver 
 
 

 
38 
 

7 Assign Slave 
device (with or 
without firmware) 

Assign the device to this driver. 
In the Slave DTM configuration dialog: 
- select Settings > Device Assignment, 
- select a Slave device (with or without firmware), 
- therefore check the appropriate checkbox, 
- select Apply. 

Selecting the Device (with 
or without firmware) 

48 

8 Select and 
download 
firmware 

If not yet a firmware was loaded to the device: 
- Adhere to the necessary safety precautions to 
prevent personnel injury and property damage. 
In the Slave DTM configuration dialog: 
- select Settings > Firmware Download, 
- select Browse.., 
- select a firmware file, 
- select Open, 
- select Download and Yes. 

 
Safety Messages on 
Firmware or Configuration 
Download 
 
Firmware Download 

 
31 
 
 
 
51   



Getting started 29/189 

DTM for Hilscher Sercos Slave Device | Configuration of Hilscher Slave Devices  
DOC110701OI05EN | Revision 5 | English | 2018-04 | Released | Public  © Hilscher, 2012-2018 

# Step Short Description For detailed information 
see section 

Page 

9 Assign Slave 
device once more 
(with firmware and 
system chanal) 
For repeated 
download this step 
is omitted. 

In the Slave DTM configuration dialog: 
- select Settings > Device Assignment, 
- select Scan, 
- select the Slave device (with loaded firmware 
and defined system channel), 
- therefore check the appropriate checkbox, 
- select Apply, 
- close the Slave DTM configuration dialog via 
OK. 

Selecting the Device once 
more (with Firmware) 

49 

10 Configure Slave 
device 

Configure the Slave device. 
- Select the device icon of the Slave and 
   select Configuration in context menu 
- The Slave DTM configuration dialog is  
displayed.  
In the Slave DTM configuration dialog: 
- Select the slave device to be configured 
   as described in section Support for Multi-Slave 
Devices 
- select Electronic Label, 
- check the device-specific information,  
- select General,  
   check Sercos address 
- select Configuration, 
- set the Interface, Ident and Slave-specific  
parameters,  
- select  
   User-defined Parameters 
   in the navigation area.  
- set user-defined parameters 
   of the device: 
- in case of an FSP IO device select 
 FSP IO  
- and set the module Parameters,  
- in case of an FSP Drive select 
 FSP Drive, and  
perform detailed parameterization,  
- close the Slave DTM configuration dialog via  
the button OK. 

Setting Slave Parameters 
 
 
 
 
 
 
 
 
Electronic Label 
 
General 
 
Configuration 
 
 
 
User-defined Parameters 
 
 
 
 
FSP IO 
 
 
FSP Drive 

59 
 
 
 
 
 
 
 
 
62 
 
66 
 
67 
 
 
 
93 
 
 
 
 
102 
 
 
116   

11 Configure Master 
device  

Configure the Master device via the Sercos 
Master DTM netX. 

(See Operating Instruction 
Manual DTM for Sercos 
Master devices) 

- 

12 Save project Depending of the frame application. 
For the configuration software: 
- select File > Save. 

(See Operating Instruction 
Manual of the Frame 
Application) 

- 

13 Connect Slave 
device 

Depending of the FDT Container. 
For netDevice: 
- right click to the device icon of the Slave, 
- select Connect. 

Connecting/Disconnecting 
Device 

140 

14 Download 
Configuration 

- Adhere to the necessary safety precautions to 
prevent personnel injury and property damage. 
Depending of the FDT Container. 
For netDevice:  
- right click to the device icon of the Slave, 
- select Download. 

Safety Messages on 
Firmware or Configuration 
Download 
 
Download Configuration  

31 
 
 
 
142   
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# Step Short Description For detailed information 
see section 

Page 

15 Diagnosis Depending of the FDT Container. 
For netDevice: 
- right click to the device icon of the Slave, 
- select Diagnosis. 
- The Slave DTM diagnosis dialog is displayed. 
(1) Check whether the communication is OK: 
Diagnosis > General Diagnosis > Device 
status "Communication" must be green! 
(2) „Communication“ is green: Open thel IO 
Monitor and test the input or output data. 
(3) „Communication“ is not green: Use 
Diagnosis and Extended diagnosis for 
troubleshooting. 
- close the Slave DTM diagnosis dialog via OK. 

Overview Diagnosis 144 

16 Disconnect Depending of the FDT Container. 
For netDevice:  
- right click to the device icon of the Slave, 
- select Disconnect. 

Connecting/Disconnecting 
Device 

140 

Table 10: Getting started - Configuration Steps (Slave DTM at the Master bus line) 
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3.2 Safety Messages on Firmware or Configuration Download 
If you perform a firmware download or a configuration download via the 
Sercos Slave DTM be aware of the following: 
 

  
Communication Stop caused by Firmware or Configuration Download 
Initiating a firmware or configuration dowload process during bus operation 
will stop the communication and a subsequent plant stop may cause 
unpredictable and unexpected behavior of machines and plant 
components, possibly resulting in personal injury and damage to your 
equipment. 
The firmware download overwrites the existing firmware. The 
communication stop may cause loss of device parameters and possible 
device damage may occur. 
 Stop the application program, before you start the firmware or 

configuration dowload. 

 Make sure that all network devices are placed in a fail-safe condition. 
 
 

  
Mismatching System Configuration 
Mismatching system configuration loaded into the device could result in 
faulty data mapping in the application program and thus unexpected 
equipment operation may cause personal injury or damage of equipment. 
 In the device use only a configuration suitable for the system. 
 
 

 
 

 

 
Power Disconnect while dowloading Firmware or Configuration 
If the power supply to the PC or device is interrupted while the firmware or 
configuration is being downloaded, the download will be aborted, the 
firmware may be corrupted, the device parameters may be lost, and the 
device may be damaged. 
 During firmware or configuration download process do not interrupt the 

power supply to the PC, or to the device and do not perform a reset to 
the device! 

 
 
 

 

 

 
Invalid Firmware 
Loading invalid firmware files could render your device unusable. 
 Only proceed with a firmware version valid for your device. 
 

 
 
 



Settings 32/189 

DTM for Hilscher Sercos Slave Device | Configuration of Hilscher Slave Devices  
DOC110701OI05EN | Revision 5 | English | 2018-04 | Released | Public  © Hilscher, 2012-2018 

4 Settings 
4.1 Overview Settings 

Settings Dialog Panes 
The table below gives an overview for the individual Settings dialog panes 
descriptions: 
 

Sercos Slave DTM Folder Name / 
Section 

Subsection Manual 
Page 

 
Navigation Area – 
Settings (Example) 
Additional drivers can be 
displayed. 

Driver  35 

 Verify or adapt Driver Settings 35 

 cifX Device Driver 37 

 netX Driver 37 
  Configuring netX Driver 38 

Device Assignment  45 

 Scanning for Devices 45 

  Scanning for all Devices or for suitable only 47 

 Selecting the Device (with or without firmware) 48 

 Selecting the Device once more (with Firmware) 49 
Firmware Download  51 

Table 11: Descriptions of the Dialog Panes Settings 

 
 

 
Note: To edit the Settings dialog panes you need User Rights for 
“Maintenance”. 

 
 

 

Notice the descriptions in the section Settings for Driver and Device 
Assignment on page 33. 

 

To access to the online help with the descriptions of the drivers: 

 Select Settings > Driver > [Name of the assigned driver]. 

 Press the F1 key. 
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4.2 Settings for Driver and Device Assignment 
 

The following steps are needed to establish a connection from the Sercos 
Slave DTM to the Sercos Slave device: 

Verifying or adapting Driver Settings 
Verify the Driver Settings and adapt them if necessary. 
 

1. Open the DTM configuration dialog. 

 In the FDT container netDevice double click to the Sercos Slave device 
icon. 

2. Verify that the default driver is checked and respectively check another 
or multiple drivers. 

 

 Select Settings > Driver. 
 

 
Note! For PC cards cifX the cifX Device Driver is preset as a default 
driver. For all the other Hilscher devices the netX Driver is preset as a 
default driver. 
 Use the cifX Device Driver if the Sercos Slave DTM is installed on the 

same PC as the Sercos Slave device. 
 Use the netX Driver to establish an USB, Serial (RS232) or TCP/IP 

connection from the Sercos Slave DTM to the Sercos Slave device. 
 The 3SGateway Driver for netX (V3.x) is used only in relationship with 

CODESYS. 
 To search for devices on the network you can check one or multiple 

drivers simultaneously. 
 

 Verify that the default driver for your device is checked. 

 If necessary, check another driver or multiple drivers. 

Configuring Driver 
 

 
Note! 
 The cifX Device Driver requires no configuration. 
 The configuration of the 3SGateway Driver for netX (V3.x) is carried 

out via the CODESYS surface. 
 

If you use the netX Driver, you respectively must configure it. 

3. Configure the netX Driver if necessary. 

For the driver netXDriver an individual driver dialog window can be opened 
where you can configure the driver. 

 Select Settings > Driver > netX Driver. 
 For netX Driver and communication via TCP/IP set the IP address of 

the device. 

Adjust the driver parameters netX Driver USB/RS232 only if they differ 
from the default settings. 
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Assigning the Slave device to the DTM 
4. Scan for and select the devices (with or without firmware). 

 Select Settings > Device Assignment. 
 Under Device selection select suitable only or all and then Scan. 

 In the table check the required devices. 

 Select Apply. 

Selecting and downloading the Firmware 
5. If not yet a firmware was loaded to the device, select and download the 

firmware. 

 Select Settings > Firmware Download. 

 Select and download the firmware via Download. 

 Select Apply. 

6. Scan for and select the devices (with firmware and defined system 
channel) once more. 

For repeated download this step is omitted. 

 Select Settings > Device Assignment. 
 Select Scan. 

 In the table check the required device. 

7. Close the DTM configuration dialog via OK. 

Connecting the Device 
8. In netDevice put a right-click on the Sercos Slave device icon. 

9. Select the Connect command from the context menu. 

 In the network view the device description at the device icon of the 
Slave is displayed with a green colored background. The Sercos Slave 
device now is connected to the Sercos Slave DTM via an online 
connection. 

Further Information 

 

For descriptions about these steps refer to the sections following here-
after.  
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4.3 Driver 
The Driver dialog pane displays the drivers to be used for a Sercos Slave 
DTM to establish a device communication connection.  
 

 
Note! A default driver is set in the configuration software.  

 

 
Figure 5: Default Driver ‚cifX Device Driver’ for PC cards cifX  

Parameter Meaning 
Driver Name of the driver (for more details see descriptions hereafter) 

Version  ODMV3 Version of the respective driver 

ID ID of the driver (driver identification) 

Table 12: Driver Selection List Parameters 

To establish a connection from the Sercos Slave DTM to the Sercos Slave 
device, verify if the default driver is checked and respectively check another 
driver or multiple drivers. 
 

4.3.1 Verify or adapt Driver Settings 
Proceed as follows: 

1. Select Settings > Driver in the navigation area. 

 The Driver dialog pane is displayed with the available drivers and the 
setting for the default driver.  

 
Figure 6: Default Driver ‚cifX Device Driver’ for PC cards cifX (example) 

 
Figure 7: Default Driver ‚netX Driver’ for Hilscher devices except for PC cards cifX (example) 

2. Verify that the default driver is checked. 
 

 Verify that the default driver for your device is checked. 
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Default Driver (Pre-settings in the Configuration Software): For PC cards 
cifX the cifX Device Driver is preset as a default driver. For all the other 
Hilscher devices the netX Driver is preset as a default driver. 
 

3. Respectively check another driver. 
 

 
Note! The driver used for the connection from the Sercos Slave DTM to 
the Sercos Slave device must be supported by the device and must be 
available for the device. 

 

• Use the cifX Device Driver if the Sercos Slave DTM is installed on the 
same PC as the Sercos Slave device. 

• Use the netX Driver to establish a USB, Serial (RS232) or TCP/IP 
connection from the Sercos Slave DTM to the Sercos Slave device. 

• The 3SGateway Driver for netX (V3.x) is used only in relationship with 
CODESYS. The version V3.x refers to the driver version defined by 3S-
Smart Software Solutions GmbH. 

 Check the checkbox for the driver in the selection list. 
 

4. Respectively check multiple drivers. 

To search for devices on the network you can check multiple drivers 
simultaneously. 

 
Figure 8: Manual Selection of multiple drivers (Example) 
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4.3.2 cifX Device Driver 
In the Sercos Slave-DTM for the cifX Device Driver no driver dialog pane 
is available, since for the cifX Device Driver no driver settings are 
required. 

The cifX Device Driver will be used if the Sercos Slave DTM is installed in 
the same PC as the Sercos Slave device.  
 

 
Note: To establish a connection from a DTM to a Slave device via the 
cifX Device Driver, the cifX Device Driver must be installed and the 
driver must have access to the Slave device. 

 

 

 

4.3.3 netX Driver 
The netX Driver is used to connect the DTM to the device via different 
connection types. The DTM communicates with the device via an USB 
connection, a serial (RS232) connection or a TCP/IP connection. The netX 
Driver establishes 

• via the USB interface of the device and the USB port of the PC an USB 
connection to the device, 

• via the RS232 interface of the device and the COM port of the PC a 
serial connection (RS232) to the device 

• and via Ethernet a TCP/IP connection to the device. 
 

To connect the DTM to the physical layer of the device the netX Driver 
software works in combination with the software components: 

• “USB/COM connector” for the USB connection and for the serial 
connection (RS232) and  

• “TCP/IP connector” for the Ethernet connection. 
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4.3.4 Configuring netX Driver 
The following steps are required to configure the netX Driver: 

USB/RS232 Connection 
To set the driver parameters for an USB/RS232 connection note: 
 

 
Note: Adjust the driver parameters netX Driver USB/RS232 only if they 
differ from the default settings. After saving the changed driver 
parameters, these parameters are used for the device assignment when 
scanning devices. 

 

For setting the driver parameters for an USB connection or a serial 
connection: 

1. Select Settings > Driver > netX Driver > USB/RS232 Connection. 

 Set the driver netX Driver USB/RS232 parameters. 
 

TCP/IP Connection 
For setting the driver parameters for a TCP/IP connection: 

1. Select Settings > Driver > netX Driver > TCP Connection. 

2. Set IP Address of the device: 

 Add an IP Range via Select IP Range . 

3. Under IP Range Configuration > IP Address enter the IP Address of 
the device (Use IP Range is unchecked). 

Or 

4. Set IP Range: 

 Check Use IP Range. 

 Under IP Range Configuration > IP Address enter the start address 
(left side) and the ending address of the IP scanning range (right side). 

5. Click Save, to save the IP address or the IP range. 

 After saving the changed driver parameters, these parameters are used 
for the device assignment when scanning devices. 
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4.3.5 netX Driver - USB/RS232 Connection 
The communication from the DTM to the device via an USB/RS232 
Connection is used when the DTM is installed on a PC and between the 
PC and the device 

• an USB connection 

• or a serial connection (RS232) exists. 
 

The DTM accesses the device via the USB interface or via the RS232 
interface. This requires either to connect an USB port of the PC to the USB 
interface of the device using an USB cable or to connect a physical COM 
port of the PC to the RS232 interface of the device via a serial cable. 

The netX Driver / USB/RS232 Connection supports all physical and 
virtual COM ports available on the PC. 

Via the RS232 interface or USB interface, the device is configured or 
diagnosis is performed. 
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4.3.5.1 Driver Parameters for netX Driver - USB/RS232 Connection 

The settings of the driver parameters for the USB/RS232 connection are 
made via the netX Driver / USB/RS232 Connection configuration dialog. 

 Open the USB/RS232 Connection dialog via navigation area Settings 
> Driver > netX Driver.  

 The USB/RS232 Connection dialog is displayed: 

 
Figure 9: netX Driver > USB/RS232 Connection  

 

Parameter Meaning Range of Value / 
Default Value 

Enable USB/RS232 
Connector (Restart of 
ODM required) 

checked: The netX Driver can communicate via the 
USB/RS232 interface. 
unchecked: The netX Driver can not communicate via the 
USB/RS232 interface. 
If the check mark for Enable USB/RS232 Connector is set 
or removed, then the ODM server must be restarted1, to 
make the new setting valid. 
_______ 
1 Restart the ODM server via the ODMV3 Tray Application: 

-In the foot line click on  using the right mouse key.  

- In the context menu select Service > Start. 

checked,  
unchecked; 
Default: 
unchecked  

Select Port Depending on the COM ports (interfaces) available on the 
PC, they will be listed under Select Port. 

COM 1 to COM N 

Port Configuration 
Disable Port checked: No connection. 

unchecked: The netX Driver tries to establish a connection 
using the configured USB/RS232 interface. 

checked,  
unchecked (Default) 

Baud rate Transfer rate: number of bits per second. 
The device must support the baud rate. 

9.6, 19.2, 38.4, 57.6 or 
115.2 [kBit/s]; 
Default (RS232): 115.2 
[kBit/s] 
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Parameter Meaning Range of Value / 
Default Value 

Stop bits Number of stop bits sent after the transfer of the send data 
for synchronization purposes to the receiver. 

Stop bit: 1, 1.5, 2; 
Default (RS232): 1 

Send Timeout Maximum time before the transfer of the transmission data is 
canceled, when the send process fails, for example, because 
of the transfer buffer is full.  

100 … 60.000 [ms]; 
Default (RS232 and 
USB): 1000 ms 

Reset Timeout Maximum time for a device reset, including the re-
initialization of the physical interface used for the 
communication. 

100 … 60.000 [ms]; 
Default (RS232 and 
USB): 5000 ms 

Byte size Number of bits per byte by byte specification 7 Bit, 8 Bit; 
Default (RS232): 8 Bit 

Parity In the error detection in data transmission using parity bits, 
"parity" describes the number of bits occupied with 1 in the 
transmitted information word. 
No Parity: no parity bit 
Odd Parity: The parity is "odd" if the number of bits occupied 
with 1 in the transmitted information word will be odd. 
Even parity: The parity is "even" if the number of bits 
occupied with 1 in the transmitted information word will be 
even. 
Mark Parity: if the parity bit is always 1, this will be named 
mark-parity (the bit does not contain any information). 
Space Parity: if the parity bit always 0, this will be named 
space-parity (the bit represents an empty space). 

No Parity,  
Odd Parity, 
Even Parity, 
Mark Parity, 
Space Parity; 
Default (RS232):  
No Parity 

Keep Alive Timeout The "Keep Alive" mechanism is used to monitor whether the 
connection to the device is active. Connection errors are 
detected using a periodic heartbeat mechanism. The 
heartbeat mechanism will be initiated after the set time has 
elapsed if the communication has failed. 

100 … 60.000 [ms]; 
Default (RS232 and 
USB): 2000 ms 

Restore Resets all settings in the configuration dialog to the default 
values. 

 

Save Saving all settings made in the configuration dialog netX 
Driver > Save USB/RS232 Connection, i. e. only for the 
selected connection type. 

 

Save All Saving all settings made in the configuration dialog netX 
Driver, i. e. for all connection types. 

 

Table 13: Parameters netX Driver > USB/RS232 Connection 
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4.3.6 netX Driver - TCP/IP Connection 
The communication from the DTM to the device via a TCP/IP Connection 
is used in the following two typical applications: 

Application 1: The device has its own Ethernet interface. The DTM is 
installed on a PC and the TCP/IP connection is established from this PC to 
the stand-alone device. The IP address of the device is used. 

Application 2: The device is installed in a remote PC. The DTM is installed 
on an additional PC and the TCP/IP connection is established from this PC 
to the remote PC. The IP address of the remote PC is used. For the TCP/IP 
connection is made, on the remote PC the cifX TCP/IP server must be 
started. The cifX TCP/IP server allows the remote access to the device via 
a TCP/IP connection. 
 

 
Note: An exe file for the cifXTCP/IP server is provided on the product CD 
in the Tools directory. 

 

Via the TCP/IP interface of the device or of the remote PC, the device is 
configured or diagnosis is performed. 
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4.3.6.1 Driver Parameters for netX Driver - TCP/IP Connection 

The settings of the driver parameters for the TCP/IP connection are made 
via the netX Driver / TCP Connection configuration dialog. 

 Open the TCP Connection dialog via navigation area Settings > 
Driver > netX Driver.  

 The dialog netX Driver is displayed: 

 Select TCP Connection. 

 
Figure 10: netX Driver > TCP Connection  

 
 
 
 
 

Parameter Meaning Range of Value / 
Default Value 

Enable TCP Connector 
(Restart of ODM 
required) 

checked: The netX Driver can communicate via the TCP/IP 
interface. 
unchecked: The netX Driver can not communicate via the 
TCP/IP interface. 
If the check mark for Enable TCP Connector is set or 
removed, then the ODM server must be restarted1, to make 
the new setting valid. 
_______ 
1 Restart the ODM server via the ODMV3 Tray Application: 

-In the foot line click on  using the right mouse key.  

- In the context menu select Service > Start. 

checked,  
unchecked; 
Default: 
unchecked 

Select IP Range Via Select IP Range already created IP ranges can be 
selected. 

Via  an additional IP range can be added. 

Via  an IP range can be deleted. 
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Parameter Meaning Range of Value / 
Default Value 

Scan Timeout [ms] With Scan Timeout can be set, how long to wait for a 
response while a connection is established. 

10 … 10000 [ms]; 
Default: 100 ms 

IP Range Configuration 
Disable IP Range checked: No connection. 

unchecked: The netX Driver tries to establish a connection 
using the configured TCP/IP interface. 

checked,  
unchecked (Default) 

IP Address (left) Enter the IP address of the device, (if Use IP Range is not 
checked). 
Enter the start address of the IP scanning range, (if Use IP 
Range is checked). 

valid IP address; 
Default: 192.168.1.1 

Use IP Range checked: An IP address range is used. 
unchecked: Only one IP address is used. 

checked,  
unchecked; 
Default: 
unchecked 

IP Address (right) Enter the ending address of the IP scanning range, (only if 
Use IP Range is checked). 

valid IP address; 
Default: 0.0.0.0 

Address Count Displays the scanning range address count, depending on 
the selected IP-start or IP-end address. (For this read the 
note given below.) 

recommended: 10  

TCP Port Identifies the endpoint of a logical connection or addresses a 
specific endpoint on the device or PC. 

0 - 65535; 
Default Hilscher device: 
50111 

Send Timeout [ms] Maximum time before the transfer of the transmission data is 
canceled, when the send process fails, for example, because 
of the transfer buffer is full.  

100 … 60.000 [ms]; 
Default (TCP/IP): 1000 
ms 

Reset Timeout [ms] Maximum time for a device reset, including the re-
initialization of the physical interface used for the 
communication. 

100 … 60.000 [ms]; 
Default (TCP/IP): 2000 
ms 

Keep Alive Timeout 
[ms] 

The "Keep Alive" mechanism is used to monitor whether the 
connection to the device is active. Connection errors are 
detected using a periodic heartbeat mechanism. The 
heartbeat mechanism will be initiated after the set time has 
elapsed if the communication has failed. 

100 … 60.000 [ms]; 
Default (TCP/IP): 2000 
ms 

Restore Resets all settings in the configuration dialog to the default 
values. 

 

Save Saving all settings made in the configuration dialog netX 
Driver > Save TCP/IP Connection, i. e. only for the selected 
connection type. 

 

Save All Saving all settings made in the configuration dialog netX 
Driver, i. e. for all connection types. 

 

Table 14: Parameters netX Driver > TCP Connection 

 

 

Note: Do not use large IP ranges in combination with a low scan timeout. Microsoft 
introduced in Windows® XP SP2 a limit of concurrent half-open outbound 
TCP/IPconnections (connection attempts) to slow the spread of virus and malware from 
system to system. This limit makes it impossible to have more than 10 concurrent half-
open outbound connections. Every further connection attempt is put in a queue and 
forced to wait. Due to this limitation a large IP range used in combination with a low scan 
timeout could prevent the connection establishment to a device. 
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4.4 Device Assignment 
 

 
Note: In the Device Assignment dialog pane you first must assign the 
Sercos Slave device to the Sercos Slave DTM by checking the check box. 
This is essential to establish an online connection from the Sercos Slave 
DTM to the Sercos Slave device later, as described in section 
Connecting/Disconnecting Device on page 140. 

 

Therefore in the Device Assignment dialog pane you scan for the Sercos 
Slave device and select it.  

If the device did not get a firmware or shall get a new firmware: 

1. first you scan for the device (with or without firmware) and select the 
device,  

2. then you download a firmware to the device and 

3. subsequently you scan for the device (with firmware) once more and 
select the device again. 

 

 

4.4.1 Scanning for Devices 
 

1. Select Settings > Device Assignment in the navigation area. 

 The dialog pane Device Assignment is displayed. 

 
Figure 11: Device Assignment - detected Devices (* The name of the device class is 
displayed.) – Example for a device without firmware 

2. Under Device Selection select suitable only. 

3. Select Scan, to start the scanning process. 

 In the table all devices are displayed, which can be connected to the 
Sercos Slave DTM via the preselected driver. 

 

 
Note: For devices, which have been found via the cifX Device Driver in 
the column Access path the indication …\cifX[0toN]_SYS is displayed. 
This is correct, as long as a device did not get a firmware. After the 
firmware download has been completed, in the column Access path the 
indication …\cifX[0toN]_Ch[0to3] is displayed. 
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Parameter Meaning Range of Value / 
Default Value 

Device selection Selecting suitable only or all devices. suitable only, all 

Device Device class of the Sercos Slave devices.  

Hardware Port 
0/1/2/3 

Shows, which hardware is assigned to which communication interface.  

Slot number Shows the Slot Number (Card ID) preset at the PC card cifX via the Rotary 
Switch Slot Number (Card ID). 
The indication n/a means that no Slot-Nummer (Card ID) exists. This will 
occur if the PC card cifX is not equipped with a Rotary Switch Slot Number 
(Card ID) or for PC cards cifX equipped with a Rotary Switch Slot Number 
(Card ID) if the rotary switch is set to the value 0 (zero). 

1 to 9, 
n/a 
 

Serial number Serial number of the device  

Driver Name of the driver  

Channel Protocol Shows, which firmware is loaded to which device channel. 
The data for the used channel consists of the protocol class and the 
communication class. 
a.) For devices without firmware: Undefined Undefined, 
b.) For devices with firmware: Protocol name corresponding to the used 
Firmware 

 

Access path 
(last column on 
the right) 

Depending on the used driver in the column Access path different data to 
the device are displayed. 
For the cifX Device Driver the following data are displayed:  
a.) For devices without firmware: …\cifX[0toN]_SYS, 
b.) For devices with firmware: …\cifX[0toN]_Ch[0to3]. 
cifX[0toN] = Board number 0 to N 
Ch[0to3] = Channel number 0 to 3 

Depending on the 
device and on the 
driver:  
board or channel 
number, IP address 
or COM interface 

Access path  
(at the lower side 
of the dialog 
pane) 

If in the table a device is checked, under Access path (at the lower side of 
the dialog pane) the driver identification or depending on the used driver 
additional data to the device will be displayed. 
For the cifX Device Driver the following data are displayed:  
a.) For devices without firmware: …\cifX[0toN]_SYS, 
b.) For devices with firmware: …\cifX[0toN]_Ch[0to3]. 
cifX[0toN] = Board number 0 to N 
Ch[0to3] = Channel number 0 to 3 

driver identification 
(ID) 
depending on the 
device and on the 
driver:  
board or channel 
number, IP address 
or COM interface 

Table 15: Parameters of the Device Assignment 
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4.4.1.1 Scanning for all Devices or for suitable only 

all 
1. Under Device Selection select all. 

2. Select Scan. 

 
Figure 12: Device Assignment - detected Devices (* The name of the device class is 
displayed.) Example for Devices without Firmware 

 In the table all devices are displayed, which are attainable in the 
network and which can be connected to a single DTM each via the 
preselected drivers. 

 

 
Note: During a subsequent firmware download in the selection window 
Select Firmware File all files from the selected folder are displayed, 
under Files of Type „All Files (*.*)“ is displayed and the check box 
Validate the selected firmware file. is unchecked. 

 
 

suitable only 
1. Under Device Selection select suitable only. 

2. Select Scan. 

 In the table all devices are displayed, which can be connected to the 
Sercos Slave DTM via the preselected drivers. 

 

 
Note: During a subsequent firmware download in the selection window 
Select Firmware File only firmware files from the selected folder are 
displayed, under Files of Type „Firmware Files (*.nxm)“ or „Firmware 
Files (*.nxf)“ is displayed and the check box Validate the selected 
firmware file. is checked. 
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4.4.2 Selecting the Device (with or without firmware) 
 

 
Note: A connection with the Sercos Slave DTM can only be established 
with one Sercos Slave device. 

 

To select the physical Sercos Slave device (with or without firmware): 

1. Check the appropriate device. 

 
Figure 13: Device Assignment - Selecting the Device (* The name of the device class is 
displayed.) – Example for a device without firmware / one Device is selected  

 

 Under Access path (below in the dialog pane) the access path to the 
device, e. g. the driver identification, or depending on the used driver 
additional access data of the device are displayed. 

2. Select Apply, to apply the selection. 
 

 
Note: Before an online connection from the Sercos Slave DTM to the 
Sercos Slave device can be established, a firmware must be loaded to the 
device and the device must be selected once more. 

 
 

 

For further information refer to section to section Firmware Download on 
page 51 or to section Selecting the Device once more (with Firmware) on 
page 49. 
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4.4.3 Selecting the Device once more (with Firmware) 
 

 
Note: For repeated download this step is omitted. 

 

To select the Sercos Slave device (with firmware and defined system 
channel) once more, proceed as described hereafter: 

all 
1. Under Device Selection select all. 

2. Select Scan. 

 In the table all devices are displayed, which are attainable in the 
network and which can be connected to a DTM via the preselected 
drivers. 

3. Check the appropriate device. 

 
Figure 14: Device Assignment - Selecting the Device (* The name of the device class is 
displayed.) – Example for Devices with and without Firmware / one Device is selected 

 

 

Note: After the firmware download has been completed, for the devices which have been 
detected via the cifX Device Driver the following data are displayed:  
- In the column Channel Protocol: the data for the firmware for the used channel 
- In the column Access path or under Access path (below in the dialog pane):  
 the data: …\cifX[0toN]_Ch[0to3]. 
 cifX[0toN] = board number 0 to N  
 Ch[0to3] = channel number 0 to 3 

 

4. Select Apply, to apply the selection.  

5. Or select OK, to apply the selection and to close the DTM interface 
dialog.  

6. Connect the DTM to the device using the context menu (right mouse 
click). 
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Or: 

suitable only 
1. Under Device Selection select suitable only. 

2. Select Scan. 

 In the table all devices are displayed, which can be connected to the 
Sercos Slave DTM via the preselected drivers. 

3. Check the appropriate device. 

 
Figure 15: Device Assignment - Selecting the Device (* The name of the device class is 
displayed.) – Example for a device with firmware / one Device is selected 

 

 

Note: After the firmware download has been completed, for the devices which have been 
detected via the cifX Device Driver the following data are displayed:  
- In the column Channel Protocol: the data for the firmware for the used channel 
- In the column Access path or under Access path (below in the dialog pane):  
 the data: …\cifX[0toN]_Ch[0to3]. 
 cifX[0toN] = board number 0 to N  
 Ch[0to3] = channel number 0 to 3 

 

4. Select Apply, to apply the selection.  

5. Or select OK, to apply the selection and to close the DTM interface 
dialog.  

6. Connect the DTM to the device using the context menu (right mouse 
click). 

 

 

For further information how to establish an online connection from the 
Sercos Slave DTM to the Sercos Slave device, refer to section 
Connecting/Disconnecting Device on page 140. 
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4.5 Firmware Download 
Using the Firmware Download dialog a firmware can be transferred to the 
device. 

 
Note: Prior to the firmware download, you must select the driver and the 
Slave device (with or without firmware) and the device must be assigned 
to the hardware. For further information refer to section Overview Settings 
on page 32. 

To load the firmware to the device: 

1. In the navigation area select Settings > Firmware Download. 

 The dialog Firmware-Download pane is displayed. 

 
Figure 16: Firmware Download 

Element Meaning 
Name The path and name of the firmware file selected are displayed. 

Version The version and build version of the firmware file selected are displayed. 

Browse… Via ‘Browse…’ you can select the firmware file for the download.  

Download Via ‘Download’ you can download the firmware to the device. 

Table 16: Parameter Firmware Download 

 Select Browse. 

Device is not assigned to the Hardware 
If the device is not assigned to the Hardware, the error message ‘The 
device is not assigned to the hardware!’ is displayed: 

 
Figure 17: Error Message ‘The device is not assigned to the hardware!’ 
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 Click OK and select and assign the Slave device as described in 
section Device Assignment.  

Device is assigned to the Hardware 
 The selection window Select Firmware File is displayed. 

 Enlarge the selection window to view the columns Hardware and 
Version.  

 

 
Figure 18: Window ‘Select Firmware File’ (Example CIFX) 
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Parameter Meaning Range of Value / 
Default Value 

Column Name File name of the firmware file 
To sort the entries of the window Select Firmware File by name click to 
the column head . 

nxf, nxm 

Column 
Firmware 

Name of the firmware (consisting of the protocol name and protocol class)  

Column 
Hardware 

Device class of the associated hardware e. g. CIFX,  
COMX, COMX 51,  
NETJACK 10,  
NETJACK 50,  
NETJACK 51,  
NETJACK 100, 
NETTAP 50 (Gateway), 
NETTAP 100 (Gateway), 
NETBRICK 100 (Gateway) 

Column 
Version 

Firmware version x.x (build x) 

Tooltip  To view the tooltip information move with the mouse pointer over the 
selected firmware line. 

 

 

Files of Type „All Files (*.*)“ if before in the Device Assignment pane under Device 
selection all was selected.  
„ Firmware Files (*.nxm)“ or Firmware Files (*.nxf) if before in the Device 
Assignment pane under Device selection suitable only was selected. 

All Files (*.*), 
Firmware Files (*.nxm), 
Firmware Files (*.nxf) 

Recent folders Path of the recently opened folder  
Firmware As soon as the firmware file has been selected, under Firmware the 

name, the version and the build version as well as the device class for the 
selected firmware is displayed. 

Name, Version, Build 
Version, Device Class 
for the selected firmware 

Help Button, to open the online help of the DTM.  

Table 17: Parameters Select Firmware File 

 

Further descriptions to the selection window Select Firmware File are 
included in the context sensitive help (F1 key) of the Microsoft 
Corporation. 

 

 

Note: After in the Device Assignment pane under Device selection all or suitable only 
has been set, during a subsequent firmware download in the selection window Select 
Firmware File the following data are displayed or set: 

(for list box entry ) all suitable only 
In the selection window 
Select Firmware File: 

all files from the 
selected folder 

only firmware files from the 
selected folder 

Under Files of Type*: „All Files (*.*)“ „Firmware Files (*.nxm)“, 
„Firmware Files (*.nxf)“ 

Validation: A restricted validation 
will be performed if 
the selected firmware 
is applied for the 
download. 

A validation is made whether 
the firmware file is suitable for 
the Sercos Slave DTM. 

*These settings in the selection window Select Firmware File can also be changed 
manually. 

3. In the selection window mark the firmware file to be loaded using the 
mouse. 

 In the selection window under Firmware the name and the version of 
the firmware are displayed. 
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4. In the selection window select the Open button. 

Validation 
 A validation is made, whether the selected firmware file is suitable for 

the Sercos Slave device. 

Invalid Firmware 
 

  
Invalid Firmware 
Loading invalid firmware files could render your device unusable. 

  Only proceed with a firmware version valid for your device. 

 If a firmware file is selected, which is not valid for the assigned device, 
the request Select Firmware File will be displayed. 
‘Invalid firmware for assigned device!   
[detailed explication]  
Shall firmware file nevertheless be applied for the download?’ 

 
Figure 19: Request Select Firmware File - Example Invalid Firmware 

 Answer to the request with No and select a valid firmware. 

 The selection window is closed. 



Settings 55/189 

DTM for Hilscher Sercos Slave Device | Configuration of Hilscher Slave Devices  
DOC110701OI05EN | Revision 5 | English | 2018-04 | Released | Public  © Hilscher, 2012-2018 

Valid Firmware 
 The selection window is directly closed (without dialog). 
 

5. Start firmware upgrade.   
 

  
Communication Stop caused by Firmware Update,  
faulty System Operation possible, Overwriting of Firmware or  
Loss of Device Parameters 
Before you initiate a firmware download process, while the bus is still in 
operation status: 
 Stop the application program. 

 Make sure that all network devices are placed in a fail-safe condition. 
 

  
Firmware Corruption or Loss of Parameters caused by Power 
Disconnect during Firmware Download 

  During firmware download process, do not interrupt the power supply to 
the PC, or to the device and do not perform a reset to the device! 

 In the dialog pane Firmware Download click to the Download button, 
to download the firmware. 

 The request Do you really want to download the firmware? is 
displayed. 

 
Figure 20: Request - Do you really want to download the firmware? 

6. Click Yes. 

 If you are sure, that you have selected the appropriate firmware file 
answer to the request with Yes otherwise with No.  

 During the download a progress bar is displayed (‘Download active, 
device performs initialization…’), in the status line a clock / green hook 
symbol is displayed and in the dialog pane Firmware Download 
Download is grayed out. 

 
Figure 21: Firmware Download - Progress Bar  
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Figure 22: Clock Symbol and Hook Symbol green 

 In the Firmware-Download dialog pane the path and name as well as 
the version of the selected firmware file are displayed. 

 
Figure 23: Firmware Download – Download 
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5 Offline Parameterization 
Device configuration is done by first clicking at the device in the netDevice 
frame with the right mouse button and afterwards selecting option 
“Configuration->Offline Parameterization” on the menu appearing then. 
 

5.1 Support for Multi-Slave Devices 
The Sercos Slave DTM supports Multi-Slave Devices with multiple slaves 
within one single device. 

The information that will be displayed at the top of the navigation area will 
depend on the number of slaves integrated within the IO Device. 

If the device contains only one single slave (for instance, a compact IO 
device), at the top level of the navigation pane there will be an entry 
“Single-Slave Device”  

 

Figure 24: Navigation Area for Single-Slave Devices 

 
The corresponding dialog pane for a single slave device looks like: 
 

 
Figure 25: Dialog Pane - Single-Slave Device 



Offline Parameterization 58/189 

DTM for Hilscher Sercos Slave Device | Configuration of Hilscher Slave Devices  
DOC110701OI05EN | Revision 5 | English | 2018-04 | Released | Public  © Hilscher, 2012-2018 

Contrary to this, for a multi-slave device, in the topmost line there will be 
written “Device with x Slaves” where x is the number of slaves of the 
device.  It must be at least 2.  

 
Figure 26: Navigation Area for Multi-Slave Devices 

There is another difference compared to the single slave device: In the third 
line, the entry “Configuration” is extended by the index and address of the 
slave having been selected.  

Selection of the slave device to parameterize in devices containing multiple 
slaves is done by the slave selection selection list appearing in the Devices 
with x Slaves window, see figure below: 
 

 
Figure 27: Dialog Pane - Multi-Slave Device - Slave Selection 

 

In the example above, it is possible to choose between a slave with index 0 
at address 2 and a slave with index 1 at address 3. 

The following items are displayed in the dialog pane both in the single-slave 
and the multi-slave case: 
 

Name Meaning 
Description Contains a description of the device 
Component name Contains the name of the component 
Device name Contains the name of the device 

Table 18: Contents of Dialog Pane Single Slave Device /Multi Slave Device 
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5.2 Setting Slave Parameters 
The steps provided in the following two sections are alternatively required 
for the two cases listed hereafter, to set the parameters of the Sercos Slave 
device using the Sercos Slave DTM: 

• Slave DTM at the Root-Line (Stand-Alone Slave)  

• and Slave DTM at the Master bus line.  

5.2.1 Slave DTM at the Root-Line (Stand-Alone Slave) 
If in the network project the Sercos Slave DTM is dropped to the root bus 
line, the following steps are needed to set the Slave device parameters 
using the Sercos Slave DTM: 

Electronic Label 
1. Check device specific information about the Slave: 

 Select Electronic Label in the navigation area. 

General Parameters: Sercos Address 
2. Check the Sercos address: 

 Select Configuration > General in the navigation area.  

Interface, Ident and Slave-specific and Bus Parameters 
3. Set the Interface, Ident and Slave-specific parameters and  check the 

Bus parameters 

 Select Configuration > Configuration in the navigation area.  

User-defined Parameters 
4. Set user-defined parameters of the device: 

 Select Configuration > User-defined Parameters in the navigation 
area. 

FSP IO Parameters 
5. Only in case of an FSP IO Device: 

      Set some essential parameters for FSP IO Devices: 

 Select Configuration > FSP IO in the navigation area. 

FSP Drive Parameters 
6. Only in case of an FSP Drive 

      Set some essential parameters for FSP Drives: 

 Select Configuration > FSP Drive in the navigation area. 

Close Slave DTM Configuration Dialog 
 Click OK in order to close the Slave DTM configuration dialog and to 

store your configuration. 
 



Offline Parameterization 60/189 

DTM for Hilscher Sercos Slave Device | Configuration of Hilscher Slave Devices  
DOC110701OI05EN | Revision 5 | English | 2018-04 | Released | Public  © Hilscher, 2012-2018 

Configuration Download to the Sercos Slave Device 
 Adhere to the necessary safety precautions to prevent personnel injury 

and property damage.  
 

 
Note: In order to transfer the configuration to the Sercos Slave device, 
download the data of the configuration parameters in the Sercos Slave 
device. See section Download Configuration on page 142. 

 
 

Further Information 

 

For more information refer to section Electronic Label on page 62, to 
section General on page 66, to section Configuration on page 67, to 
section User-defined Parameters on page 93, to section FSP IO on page 
102 and to section FSP Drive on page 116 of this document. 

 

5.2.2 Slave DTM at the Master bus line 
If in the network project the Sercos Slave DTM is dropped to the Master 
bus line of the Sercos Master DTM, the following steps are needed to set 
the Slave device parameters using the Sercos Slave DTM: 

Electronic Label 
1. Check device specific information about the Slave: 

 Select Electronic Label in the navigation area. 

General Parameters: Sercos Address 
2. Check the Sercos address: 

 Select Configuration > General in the navigation area.  

Interface, Ident and Slave-specific and Bus Parameters 
3. Set the Interface, Ident and Slave-specific parameters and  check the 

Bus parameters 

 Select Configuration > Configuration in the navigation area.  

User-defined Parameters 
4. Set user-defined parameters of the device: 

 Select Configuration > User-defined Parameters in the navigation 
area. 

FSP IO Parameters 
5. Only in case of an FSP IO Device: 

      Set some essential parameters for FSP IO Devices: 

 Select Configuration > FSP IO in the navigation area. 
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FSP Drive Parameters 
6. Only in case of an FSP Drive 

      Set some essential parameters for FSP Drives: 

 Select Configuration > FSP Drive in the navigation area. 

Close Slave DTM Configuration Dialog 
 Click OK in order to close the Slave DTM configuration dialog and to 

store your configuration. 

Configuration Download to the Sercos Slave Device 
 Adhere to the necessary safety precautions to prevent personnel injury 

and property damage.  
 

 
Note: In order to transfer the configuration to the Sercos Slave device, 
download the data of the configuration parameters in the Sercos Slave 
device. See section Download Configuration on page 142. 

 
 

Further Information 

 

For more information refer to section Electronic Label on page 62, to 
section General on page 66, to section Configuration on page 67, to 
section User-defined Parameters on page 93, to section FSP IO on page 
102 and to section FSP Drive on page 116 of this document. 
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5.3 Electronic Label 

 
Figure 28: Navigation Area - Electronic Label 

The menu entry Configuration > Electronic Label is available at all 
Sercos Slave modules independently of being a FSP IO or FSP Drive 
module. It reflects the “Electronic Label” of the Sercos device as defined in 
IDN S-0-1300 according to the specification of Sercos in the third 
generation. 

 
Figure 29: Configuration > Electronic Label 
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The following items are displayed: 
 

Name Meaning 
Vendor ID Vendor Code as defined in IDN S-0-1300.x.03 
Device ID Device ID as defined in IDN S-0-1300.x.05 
Vendor name Vendor name as defined in IDN S-0-1300.x.02 
Component name Component name as defined in IDN S-0-1300.x.01 
Revision Revision as defined in IDN S-0-1300.x.07 
Hardware revision Hardware revision as defined in IDN S-0-1300.x.08 
Software revision Software revision as defined in IDN S-0-1300.x.09 
Firmware loader revision Firmware loader revision as defined in IDN S-0-1300.x.10 
Serial number Serial number as defined in IDN S-0-1300.x.12 

Table 19: Device > Electronic Label 

For each item an associated check button can be checked (located at the 
most left part of the window): 

If this button is checked, the master will check this item for correctness, 
otherwise the master will assume the correctness without performing a 
check. 
 

• The Vendor ID is a 16 bit wide unique code introduced for identification 
of devices within the Sercos network.  

• If the value differs from 0, the device comes from a registered vendor 
which has been assigned to that code by Sercos international. 

• If the value is 0, the device comes from an unregistered vendor. 

• The Device ID is a unique string managed by the vendor for separating 
the various types of devices the vendor offers. 

• The component name contains the name of the device as it would for 
instance be published in vendor’s price list. 

• The revision is an integer numeric value (16 bit) which should be 
incremented each time when there is a significant change in the function 
of the device (i.e. a functional correction of the device). 

• The hardware revision identifies the version number of the hardware of 
the device. This value is specified by the manufacturer. 

• The software revision identifies the version number of the software or 
firmware of the device. This value is specified by the manufacturer. 

• The firmware loader revision identifies the version number of the 
firmware loader which may be contained in the device. This value is 
specified by the manufacturer. 

• The serial number. It identifies the unique number of the individual 
device which has been assigned to the device at the manufacturer. 

•  
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5.4 Overview Configuration 

Dialog Panes “Configuration” 
The table below gives an overview about the available Configuration 
dialog panes descriptions: 
 

Folder Name / 
Section 

Subsection Manual  
Page 

Configuration General 66 
 Configuration 67 
 FSP IO 102 
 IO Modules 103 
 Process Data 114 
 FSP Drive 116 

Table 20: Dialog Panes Configuration 

The Sercos device model covers drives, IO devices and hybrid devices 
whereas the latter is the combination of drive and IO. 

• Sercos drive implements FSP Drive according to specification “Function 
Specific Profile Drives V1.1.2.11” (Reference #8) 

• Sercos IO device implements FSP IO according to specification 
“Function Specific Profile IO V1.1.2.1.3, (Reference #7) 

• Sercos hybrid device implements both FSP Drive and FSP IO. 

FSP IO Devices 
For FSP IO devices, the Configuration dialog pane looks like: 
 

 
Figure 30: Navigation Area - Configuration for FSP IO Modules 
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FSP Drive  
For drives according to FSP Drive, the Configuration dialog pane appears 
like: 
 

 
Figure 31: Navigation Area - Configuration for FSP Drive Modules 

In both example figures a device with 2 slaves has been used. There would 
be no difference except the top level entry, if a single slave device would 
have been used. 
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5.5 General 

 
Figure 32: Configuration > General 

On a single slave device  the headline is only “General“, on a device with 
multiple slaves additionally index and address of the selected slave are 
stated there (such as displayed in Figure 32: Configuration > General). 

The menu entry Configuration > General is available at all Sercos Slave 
modules independently of being a FSP IO or FSP Drive module. 

The following items are displayed: 
 

Name Meaning 
Sercos address Contains the Sercos address 

Table 21: Configuration > General 

The following checkboxes are present: 

Optional: 

indicates that the item is optional and may be omitted.  

VAR_CFG: 

indicates that variable configuration is allowed (i.e. the user may at least 
partly change the configuration originating from the SDDML file of the 
device. 
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5.6 Configuration 
At the Configuration pane device related settings for Sercos can be made. 
These settings are assigned with the download of the configuration. 
 

 

Information about the download you find in section Download 
Configuration on page 142. 

 

 
Figure 33: Dialog Pane “Configuration” 
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Note: The setting options at the dialog pane Configuration for client 
specific variants of the configuration software can differ from the setting 
options displayed here. 

 

 

5.6.1 Interface Parameters 

 
Figure 34: Interface Parameters 

Bus Startup 
This parameter contains information on the bus startup method. It offers the 
options Automatic and Application Controlled. 

If Automatic is selected, the Sercos Master device starts with the data 
exchange on the bus after the initializing has been ended.  

When Application Controlled is selected, the application program must 
activate the data exchange on the bus by itself. 
 

 
Note: The setting options under Bus Startup for client specific variants of 
the configuration software can differ from the setting options displayed 
here. 

 

Watchdog Time for Application Monitoring 
 

The Watchdog time determines the time within which the device watchdog 
must be re-triggered from the application program while the application 
program monitoring is activated. When the watchdog time value is equal to 
0, then the watchdog is deactivated and the application program monitoring 
is also deactivated. 
 

Watchdog time Range of Value / Value 
Permissible range of values 20 … 65535 ms 
Default 1000 ms 
The software watchdog is deactivated. 0 (ms) 

Table 22: Range of Value / Value for the Watchdog time 

 

 
Note: The setting options under Watchdog Time for client specific 
variants of the configuration software can differ from the setting options 
displayed here. 

 

If a (non-zero) watchdog time outside of the above mentioned permissible 
range of 20 up to 65535 ms is specified, an according error message will 
be issued. 
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5.6.2 Ident Parameters 

 
Figure 35: Ident Parameters 

The ident parameters of the Sercos Stand-alone Slave DTM are: 

Device ID 
This parameter contains the Device ID as defined in IDN S-0-1300.x.05. 
Possible values are: 

• CIFX_RE_S3S_FIXCFG (for fixed configurations) 

• CIFX_RE_S3S_VARCFG (for variable configurations) 
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The value for parameter Device ID can be taken from the XML file which is 
bundled with the particular firmware. 

Vendor Code 
This parameter contains the Vendor code: as defined in IDN S-0-1300.x.03. 
The allowed range of values extends from 1 to 65535. The default value is 
1000 (denoting “Hilscher GmbH”). 

According to reference #5, the vendor code is a unique number assigned to 
each vendor of Sercos devices assigned by Sercos international and can 
be used to identify Sercos devices. Use 1000 (0x3E8) for “Hilscher GmbH”. 

The value for the parameter Vendor Code can be taken from the XML file 
which is bundled with the particular firmware. 

If an invalid Vendor code outside of the above mentioned permissible range 
of 0 up to 65535 ms is specified, an according error message will be 
issued. 

Version of SCP Sync 
This parameter contains the version number of the SCP Sync profile as 
defined in IDN S-0-1000 The allowed range of values extends from 0 to 
255. The default value is 0.  

If 0 is chosen, all fields related to SCP Sync within the Bus Parameters 
section of the Configuration screen will be deactivated and grayed out. 
These are the values in the lower part of the Bus Parameters section 
beginning with “Controller Clock Length”. 

If an invalid version number of the SCP Sync profile outside of the above 
mentioned permissible range of 0 up to 255 is specified, an according error 
message will be issued. 

Version of SCP NRT 
This parameter contains the Version number of SCP NRT profile as defined 
in IDN S-0-1000 The allowed range of values extends from 0 to 255. The 
default value is 0. 

If 0 is chosen, all fields related to SCP NRT within the Bus Parameters 
section of the Configuration screen will be deactivated and grayed out. 
These are the values in the upper part of the Bus Parameters section up to  
“TCP Flags”. 

If an invalid version number of the SCP NRT profile outside of the above 
mentioned permissible range of 0 up to 255 is specified, an according error 
message will be issued. 
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5.6.3 Bus Parameters  

 
Figure 36: Bus Parameters 

The following are the bus parameters of the Configuration pane. 

IP Address 
This parameter contains the IP Address of the device. You must specify a 
valid IP Address. The default is 0.0.0.0.  

The IP Address input field can be switched on and off by the check button 
Enable IP Address. Note, that switching off Enable IP Address will also 
switch off Enable Net Mask and Enable Gateway. 
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If no valid IP address according to the IP address rules is specified, an 
according error message is issued. 

Net mask 
This parameter contains the net mask of the device. You must specify a 
valid net mask. The default is 0.0.0.0.  

The Net Mask input field can be switched on and off by the check button 
Enable Net Mask. Note, that switching on Enable Net Mask will also 
activate Enable IP Address if grayed out previously. 

If no valid net mask is specified, an according error message is issued. 

Gateway 
This parameter contains the IP Address of the gateway, if any is used. You 
must then specify a valid IP Address. The default is 0.0.0.0.  

The Gateway input field can be switched on and off by the check button 
Enable Gateway. Note, that switching on Enable Gateway will also activate 
Enable IP Address if grayed out previously. 

If no valid IP address for a gateway is specified, an according error 
message is issued. 

There are two TCP flags: 

BOOTP Flag 
The BOOTP Flag decides whether IP address is tried to be fetched from a 
BOOTP server. Note, that switching on the BOOTP Flag will deactivate 
Enable IP Address, Enable Net Mask and Enable Gateway. 

 

DHCP Flag 
The DHCP Flag decides whether IP address is tried to be fetched from a 
DHCP server. Note, that switching on the BOOTP Flag will deactivate 
Enable IP Address, Enable Net Mask and Enable Gateway. 
 

 
Note: All subsequently described timing values specified in nanoseconds 
are handled as multiple of 10 ns (e. g. Controller Clock Length = 1005 ns 
is handled as 1000 ns).  

 

Controller Clock Length 
This parameter contains the Controller Clock Length specified in 
nanoseconds.  

Values must be larger or equal to 1000. The maximum valid value of 
Controller Clock Length depends on the configured cycle time. In general: 
the signal must go to inactive again before the next cycle starts. 

The default value is 1000. 

If an invalid Controller Clock Length outside of the range of 1000 up to 
10,000,000 ns is specified, an according error message will be issued. 

This field is grayed out in case of Controller Clock Output set to “Disabled”. 



Offline Parameterization 73/189 

DTM for Hilscher Sercos Slave Device | Configuration of Hilscher Slave Devices  
DOC110701OI05EN | Revision 5 | English | 2018-04 | Released | Public  © Hilscher, 2012-2018 

Time Divided Control Clock 
This parameter contains the Time Divided Control Clock specified in 
nanoseconds. The allowed range of values extends from 0 to 0xFFFFFF. 
The default value  is 20000. 

If an invalid Time Divided Control Clock outside of the permissible range of 
0 up to 16,777,210 ns is specified, an according error message will be 
issued. 

This field is grayed out in case of Divided Control Clock Output set to 
“Disabled”. 

Delay Time of Divided Clock 
This parameter contains the Delay Time of Divided Control Clock specified 
in nanoseconds. The allowed range of values extends from 0 
to0x3FFFFFF. The default value  is 20000. 

If an invalid Delay Time of Divided Control Clock outside of the permissible 
range of 0 up to 67,108,860 ns is specified, an according error message 
will be issued. 

This parameter is ignored in Mode 1 (see below). Therefore, this field is 
grayed out in case of Divided Control Clock Mode set to 1. 

Divided Control Clock Length 
This parameter contains the Divided Control Clock Length specified in 
nanoseconds. The allowed range of values extends from 1000 to 20000. 
The default value is 1000. 

If an invalid Divided Control Clock Length outside of the permissible range 
of 1000 up to 20,000 ns is specified, an according error message will be 
issued 

This field is grayed out in case of Divided Control Clock Output set to 
“Disabled”. 

Count Register 
This parameter contains the Count Register. It contains the number of 
pulses (Mode 0) or cycles (Mode 1). Concerning Mode 0 and Mode 1, refer 
to Divided Control Clock Mode. 

The default value is 2. 

If an invalid Count Register value outside of the permissible range of 0 up 
to 255 is specified, an according error message will be issued 

Divided Control Clock Output 
This selection list decides whether the Divided Control Clock Signal is 
inactive or active on high level or low level.  

The possible options to choose are: 

Disabled 

High active 

Low active 



Offline Parameterization 74/189 

DTM for Hilscher Sercos Slave Device | Configuration of Hilscher Slave Devices  
DOC110701OI05EN | Revision 5 | English | 2018-04 | Released | Public  © Hilscher, 2012-2018 

The default is High active. If Disabled is chosen, the fields Time Divided 
Control Clock and Divided Control Clock Length are inactive and grayed 
out. 

Divided Control Clock Mode 
This selection list selects the Divided Control Clock Mode. The possible 
options to choose are: 

Mode 0  

Mode 1 

The default is Mode 1. In Mode 1, the input field Delay Time of Divided 
Control Clock is grayed out. 

For an explanation of Mode 0 and Mode 1, see subsection “Divided Control 
Clock Modes” below! 

Controller Clock Output 
This selection list decides whether the Controller Clock Signal is active on 
high or low level. The possible options to choose are: 

Disabled 

High active 

Low active 

The default is High active. 
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5.6.3.1 Divided Control Clock Modes 

Divided Control Clock Mode 0 – N-times within one communication 
cycle 

The Divided Control Clock Signal (Div_Clk) becomes active several times 
within a communication cycle. The delay time for the first pulse is provided 
with the Time Divided Control Clock parameter. The distance between two 
pulses is provided with the Delay Time of Divided Control Clock parameter. 
The number of pulses within a communication cycle is provided with the 
Count Register parameter. The pulse length of the Div_Clk is provided with 
Divided Control Clock Length. The following condition must be fulfilled in 
mode 0: Divided Control Clock Length + 100 <= Delay Time of Divided 
Control Clock. 

 
Figure 37: Div_Clk in Mode 0 

Divided Control Clock Mode 1 – once after N communication cycles 

Div_Clk signal becomes active once after N communication cycles. The 
delay time for the first pulse is provided with Time Divided Control Clock 
parameter. The number of communication cycles is provided with the Count 
Register parameter. The pulse length of the Div_Clk is provided with the  
Divided Control Clock Length parameter. 

 
Figure 38: Div_Clk in Mode 1 
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5.6.4 Slave-specific Parameters 

 
Figure 39: Slave-specific Parameters 

5.6.4.1 Number of Slaves 

The number of slaves (the allowed values range from 1 to 8) can be 
specified in the input field Number of Slaves. For each slave, a register 
card is created within the card register quite below, so there are up to 8 
cards named Slave 1 up to Slave 8 available depending on your input in 
this field. 



Offline Parameterization 77/189 

DTM for Hilscher Sercos Slave Device | Configuration of Hilscher Slave Devices  
DOC110701OI05EN | Revision 5 | English | 2018-04 | Released | Public  © Hilscher, 2012-2018 

If a number of slaves outside of the above mentioned permissible range of 
1 up to 8 is specified, an according error message will be issued. 

5.6.4.2 Contents of Register Card for one single Slave 

The register card for a single slave consists of the following elements: 

• 5 input fields/ selection lists for slave parameter settings 

• 3 Slave Flags 

• A list field for up to 20 entries (for the User SCP Types) 

• An array of input fields to configure 4 connections with 3 input fields per 
connection 

5.6.4.3 Slave Parameter Settings 

Sercos Address 
This input field contains the Sercos address used to uniquely identify the 
Sercos slave device within the Sercos network. Allowed values range from 
0 to 511. 

If a Sercos address outside of the above mentioned permissible range of 0 
up to 511 is specified, an according error message will be issued. 

FSP Type 
This selection list contains the FSP Type according to IDN 
S-0-1302.x.01 (FSP Type & Version)  (in this context FSP means Function 
Specific Profile). Possible values are: 

• IO V1 (Default) 

• Drive V1 

Use IO V1 when the device is an IO device according to the FSP IO 
Specification (Reference #7) and Drive V1 when the device is a drive 
according to the FSP Drive Specification (Reference #8) 

SCP Configuration Type 
This selection list contains the SCP configuration type according to 
specification of Sercos in the third generation. It is defined in IDN S-0-1000 
(SCP Type & Version). It can have the following values: 

• SCP_FixCFG Version 1.1.1 

• SCP_VarCFG Version 1.1.1 

• SCP_VarCFG Version 1.1.3 

The default depends on the device description file. 

Output Size for Fixed Configuration 
This input field contains the output data in bytes (SCP configuration type 
FixCFG only, master->slave) (excluding connection control and I/O 
Control). The default value is 2. 

The output size may not exceed the value 200. Otherwise, an according 
message is issued. 
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The output size may not be odd. Otherwise, an according message is 
issued. 

The total sum of all input data must not exceed a value depending on the 
used netX processor (for example: 252 for netX 50, 126 for netX 100/500) 

If this limit is violated, an according message is issued. 

Input Size for Fixed Configuration 
This input field contains the Input data in bytes  (SCP configuration type 
FixCFG only,  slave->master) (excluding connection control and I/O 
Status). The default value is 2. 

The input size may not exceed the value 200. Otherwise, an according 
message is issued. 

The input size may not be odd. Otherwise, an according message is 
issued. 

The total sum of all input data must not exceed a value depending on the 
used netX processor (for example: 252 for netX 50, 126 for netX 100/500). 

If this limit is violated, an according message is issued. 
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5.6.4.4 Slave Flags 

The following Slave Flags can be set on the Configuration pane: 

Setup a Default OD 
This Slave Flag decides whether or not a default object dictionary is set up. 

If this flag is „set“, a default object dictionary is set up which is only 
available for SCP_FixCFG. This only makes sense if non-stack objects are 
deleted on Channel Init, see just below. The default is „not set“. 

Non-stack objects are deleted 
This Slave Flag decides whether or not non-stack objects are deleted on 
Channel Init. If this flag is „set“, non stack objects will be deleted in case a 
Channel Init of the netX processor occurs. The default is „not set“. 

Sercos Address may not be changed by Master 
This Slave Flag decides whether or not the Sercos master may change the 
Sercos address. If this flag is „set“, the Sercos Address may not be 
changed by Master. The default is „not set“. 

5.6.4.5 List Field User SCP Types 

There is a list field displaying up to 20 User SCP Types.  
 Currently, the following User SCP types may appear in this list: 

• SCP_WD Version 1.1.1 for monitoring connections 

• SCP_Diag Version 1.1.1 for bus-diagnosis 

• SCP_RTB Version 1.1.1 for using real time bits 

• SCP_Mux Version 1.1.1 for multiplexed cyclic data 

• SCP_Sig Version 1.1.1 for using signal status/control words 
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5.6.4.6 Connection Configuration 

For each slave, four slave connections can be configured at maximum. For 
each slave connection the following parameters can be adjusted. 

 
Figure 40: Connection Configuration 

Connection Control Offset 
This parameter specifies the position of the offset of connection control in 
the process image within the Dual Port Memory. It relates to IDN  
S-0-1050.x.03 Telegram Assignment.  

Allowed values range from 0 to 5758. The default value is 0.  

Real Time Data Process Image Offset 
This parameter contains the Process Image Offset of Real Time Data. 
Notes 1 and 2 below apply. 

Real Time Data Maximum Length 
This parameter contains the Maximum Length of Real Time Data. Notes 1, 
2 and 3 below apply. 
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For the range of values of the parameters Real Time Data Process Image 
Offset and Real Time Data Maximum Length the following applies: 

• Note 1: The lower limit for each of Real Time Data Process Image 
Offset and Real Time Data Maximum Length is 0. 

• Note 2: The sum of Real Time Data Process Image Offset and Real 
Time Data Maximum Length must be less than or equal to 5760. 

• Note 3: Compute the value of Real Time Data Maximum Length 
according to the following rules: 

• The overall sum of the input data of all connections of all slaves must not 
exceed 255 bytes. 

• Similarly, the overall sum of the output data of all connections of all 
slaves must not exceed 255 bytes. 
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5.6.5 Messages of Configuration Pane 

5.6.5.1 Errors in Interface Section 

The following table provides an overview which error situations might occur 
in the Interface section of the “Configuration” pane. 

Problem The error message  

 
appears. 

Explanation The watchdog time interval is not adjusted correctly.  
Allowed values include: 

0: Watchdog functionality is switched off 
20-65535: The watchdog time interval is set to the specified value. 

Action Set correct value for watchdog time in interface section of configuration pane. 
Table 23: Possible Error Messages issued at Configuration Pane 
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5.6.5.2 Errors in Ident Section 

The following table provides an overview which error situations might occur 
in the Ident section of the “Configuration” pane. 

Problem The error message  

 
appears. 

Explanation The Vendor ID has not been specified correctly. Allowed values range from 0 to 
65535:  

Action Set correct value for Vendor ID in ident section of configuration pane. 

Problem The error message  

 
appears. 

Explanation The version of SCP Sync has not been specified correctly. Allowed values range 
from 0 to 255. 

Action Set correct value for version of SCP Sync in ident section of configuration pane. 
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Problem The error message  

 
appears. 

Explanation The version of SCP NRT has not been specified correctly. Allowed values range from 0 
to 255. 

Action Set correct value for version of SCP NRT in ident section of configuration pane. 
Table 24: Possible Error Messages issued at Configuration Pane 
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5.6.5.3 Errors in Bus Section (IP Configuration) 

The following table provides an overview which error situations related to IP 
configuration might occur in the Bus section  “Configuration” pane. 

Problem The error message  

 
appears. 

Explanation Either BOOTP or DHCP must be selected or the IP configuration must be 
performed manually (by specifying IP address, net mask and gateway address)s. 

Action Activate either BOOTP or DHCP by the respective check button or manually 
perform complete IP configuration. 

Problem The error message  

 
appears. 

Explanation The IP address has not been specified correctly. Specify an IP address 
according to the applicable rules for IP addresses. 

Action Specify valid IP address in IP address field of bus section of configuration pane. 

Problem The error message  

 
appears. 

Explanation The network mask has not been specified correctly. Specify an IP address 
according to the applicable rules for IP addresses used as network mask. 
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Action Specify valid network mask in Net Mask field of bus section of configuration 
pane. 

Problem The error message  

 
appears. 

Explanation The IP address of the gateway to be used has not been specified correctly. 
Specify an IP address according to the applicable rules for IP addresses. 

Action Specify valid IP address of the gateway in Gateway field of bus section of 
configuration pane. 

Problem The error message  

 
appears. 

Explanation The combination of flags chosen for manual IP configuration is not allowed. 

Action Choose an allowed combination of flags. 
Table 25: Possible Error Messages issued at Configuration Pane 
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5.6.5.4 Errors in Bus Section (Sync Configuration) 

The following table provides an overview which error situations might occur 
in the “Configuration” pane. 

Problem The error message  

 
appears. 

Explanation The Controller Clock Length has not been specified correctly. Allowed values 
range from 1000 to 10,000,000. 

Action Set correct value for Controller Clock Length in bus section of configuration pane. 

Problem The error message  

 
appears. 

Explanation The Time Divided Control Clock has not been specified correctly. Allowed values 
range from 0 to 16,777,210. 

Action Set correct value for Time Divided Control Clock in bus section of configuration 
pane. 

Problem The error message  

 
appears. 

Explanation The Delay Time of Divided Control Clock  has not been specified correctly. 
Allowed values range from 0 to 67,108,860. 
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Action Set correct value for the Delay Time of Divided Control Clock  in bus section of 
configuration pane. 

Problem The error message  

 
appears. 

Explanation The Divided Control Clock Length  has not been specified correctly. Allowed 
values range from 1000 to 20,000. 

Action Set correct value for Divided Control Clock Length in bus section of configuration 
pane. 

Problem The error message  

 
appears. 

Explanation The Count Register has not been specified correctly. Allowed values range from 
0 to 255. 

Action Set correct value for Count Register in bus section of configuration pane. 
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Problem The error message  

 
appears. 

Explanation The sum of the values for Divided Control Clock Length and 100 must be less 
than or equal to the Delay Time of the Divided Control Clock. This limit has been 
exceeded. 

Action Adapt the Divided Control Clock Length accordingly to meet this requirement. 
Table 26: Possible Error Messages issued at Configuration Pane 

5.6.5.5 Errors in the Slave Configuration section 

The following table provides an overview which error situations might occur 
in the Slave Configuration section  “Configuration” pane. 

Problem The error message  

 
appears. 

Explanation The Sercos address of the slave has not been specified correctly. Allowed values 
range from 0 up to 511. 

Action Set correct value for the Sercos address in the slave configuration section of 
configuration pane. 

Problem The error message  
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appears. 

Explanation The number of slaves has not been specified correctly.  
Allowed values range from 1 to 8. 

Action Set correct value for the number of slaves in slave configuration section of 
configuration pane. 

Problem The error message  

 
appears. 

Explanation The input data size has not been specified correctly. Allowed values range from 0 
to 200. 

Action Set correct value for input data size in the slave configuration section of 
configuration pane. 

Problem The error message  

 
appears. 

Explanation The output data size has not been specified correctly. Allowed values range from 
0 to 200. 

Action Set correct value for output data size in the slave configuration section of 
configuration pane. 

Problem The error message  
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appears. 

Explanation The total sum of input data sizes of all connections of all configured slaves 
exceeds the netX-chip –dependent upper limit. 

Action Choose lower data sizes for some input connections / slaves in order to decrease 
the total sum so that the limit is not exceeded. 

Problem The error message  

 
appears. 

Explanation The total sum of output data sizes of all connections of all configured slaves 
exceeds the netX-chip –dependent upper limit. 

Action Choose lower data sizes for some output connections / slaves in order to 
decrease the total sum so that the limit is not exceeded. 

Problem The error message  

 
appears. 

Explanation You specified an odd value for an input data size. This is not allowed. 

Action Specify an even value instead. 

Problem The error message  
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appears. 

Explanation You specified an odd value for an input data size. This is not allowed. 

Action Specify an even value instead. 

Problem The error message  

 
appears. 

Explanation The sum of the values for Real Time Data Process Image Offset and for Real 
Time Data Maximum Length must be less than or equal to 5760. This limit has 
been exceeded. 

Action Change one of these values in such a way that the sum is not larger than 5760. 
Table 27: Possible Error Messages issued at Configuration Pane 
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5.7 User-defined Parameters 
This dialog pane displays information on the IDN parameter sets 
associated to different communication phases. 
 

 
Figure 41: User-defined Parameters Dialog Pane  (for FSP IO) 

This dialog pane mainly consists of two tables: 

The upper table contains a list of parameters that are set during CP2, CP3 
or CP4.  

The contents of the upper table depends on the choice of the selection list 
just above the table (which offers CP2, CP3 and CP4 as alternatives). 

The lower table is described in section ‘Columns of the lower Tree-List Grid 
on page 100 of this document. 
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5.7.1 Columns of upper Table 
The columns within the upper table have the following meaning: 

IDN  

This column identifies the IDN (including Structure Index and Structure 
Element) to be processed in CP2, CP3 or CP4. 

 

Action 

Here the action to be performed with the IDN has to be specified. The 
choice between three alternatives is offered here: 
 

Action code Performed action 
WR Write 
RDCMP Read and compare 
EXEC Execution of Procedure Command 

Table 28: Possible Actions to be performed with chosen IDN 

Format  

This column contains the information about the data type of the data 
associated with the IDN. The possible data types available for your choice 
are: 

• Binary 

• Unsigned decimal 

• Signed decimal 

• Hex 

• Text 

• IDN 

• Float 

 

Data Length  

This column contains the length of the data associated with the IDN. 

Possible values are: 

• 2 Octets 

• 4 Octets 

• 8 Octets 

• 1 Octet List 

• 2 Octet List 

• 4 Octet List 

• 8 Octet List 
 

 
Note: An octet corresponds to a byte in this context. 
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Not all combinations may be applied. The following table shows which 
combinations may be chosen: 
 

Data type 2 
Octets 

4 
Octets 

8 
Octets 

1 Octet 
List 

2 Octet 
List 

4 Octet 
List 

8 Octet 
List 

Binary X X X  X X x 

Unsigned decimal X X X X X X X 

Signed decimal X X X  X X X 

Hex X X X X X X X 

Text    x    

IDN X X   X X  

Float  X X   X X 

Table 29: Allowed Data Length Value in Dependence of Format/Data Type 

An incorrect choice of the data length which does not match with the 
selected value of Format will be marked with a red exclamation mark in the 
cell where the incorrect choice was made. This looks like: 

 
 

Value  

This column contains 

• The value to be written into the IDN (in case of Action code = WR, see 
below)  

• The value to be compared with the contents of the IDN (in case of 
Action code = RDCMP, see below) 

• In case of Action code = EXEC, there is no need to fill in a value here. 

The allowed input to be specified in column ‘value’ depends on the values 
specified in columns ‘Format’ and ‘Data Length’ according to the rules 
subsequently described in subsection Rules for Input in Column ‘Value’ of 
upper Table on page 97 of this document. 

If the value put in here is not compatible with the values specified at Format 
and Data Length, this will be indicated by  

 
You should then fill in a correct value. 

For an explanation of the navigation buttons see section “Navigation Area” 
of this document. 

If data cells have been recognized as faulty (marked with a red exclamation 
mark such as )  or not sufficiently precise (such 
as ), a more precise error description can be obtained 
via „tool tip“. 

 In order to obtain a detailed problem or error description, move the 
cursor of the mouse to the according problem or error icon, for which 
you want to have an explanation. Please wait for about a second. 

 The desired explanation appears at the location of the cursor. 
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5.7.2 Rules for Input in Column ‘Action’ of upper Table 
EXEC is applicable only in case the IDN contains a Procedure Command. 
On the other hand, WR and RDCMP are applicable only if the IDN does not 
contain a Procedure Command. The following Sercos IDNs are assigned to 
a procedure command: 
 

IDN Name (abbreviation) 
S-0-0099 Reset class 1 diagnostic 
S-0-0127  CP3 transition check 
S-0-0128  CP4 transition check 
S-0-0139 Park axis procedure command 
S-0-0146 Control unit controlled homing procedure command 
S-0-0148 Drive controlled homing procedure command 
S-0-0149 Positive stop drive procedure command 
S-0-0152 Position spindle procedure command 
S-0-0170 Probing cycle procedure command 
S-0-0171 Calculate displacement procedure command 
S-0-0172 Displacement to the referenced system procedure command 
S-0-0190 Drive controlled gear engaging procedure command 
S-0-0191 Cancel reference point procedure command 
S-0-0197 Set coordinate system procedure command 
S-0-0199 Shift coordinate system procedure command 
S-0-0216 Switch parameter set procedure command 
S-0-0223 Drive controlled synchronous operation procedure command 
S-0-0262 Load defaults procedure command 
S-0-0263 Load working memory procedure command 
S-0-0264 Backup working memory procedure command 
S-0-0276 Return to Module range procedure command 
S-0-0293 Selectively backup working memory procedure command 
S-0-0420 Activate parameterization level 1 procedure command (PL1) 
S-0-0422 Exit parameterization level procedure command 
S-0-0447 Set absolute position procedure command 
S-0-1024 SYNC delay measuring procedure command 

Table 30: List of commonly available Procedure Commands 

 

Additional IDNs assigned to procedure commands may also be contained 
in Sercos profiles. For more information refer to the documentation of all 
Sercos profiles you use. 

 Use action code EXEC only with IDNs mentioned in Table 30: List of 
commonly available Procedure Commands on page 96 and with those 
IDNs which have been defined by Sercos Profiles and relate to 
procedure commands (according to the profile specification). 

 Use action codes WR and RDCMP only with IDNs not mentioned in Table 
30: List of commonly available Procedure Commands on page 96 and 
with those IDNs which have been defined by Sercos Profiles and do not 
relate to procedure commands (according to the profile specification). 
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5.7.3 Rules for Input in Column ‘Value’ of upper Table 
The following rules apply for input into the column ‚Value’ of the upper 
table. 

Rule for data type Float: 

When working with floating point values, the integer part and the fractional 
part have to be separated by a decimal point, not by a comma. 

1. Rule for data type List: 

Single entries within list data types have to be separated by a semicolon. 

2. Rule for input of single values 

For all data types besides list data types, no data may be separated with a 
semicolon as a semicolon would be interpreted as an error in such a case. 

3. Rule for input of binary values: 

Values specified as Binary should also be represented in the binary format 
such as 10111000011100, for instance. 

4. Rule for input of hexadecimal values: 

Hexadecimal values can be specified with but also without a preceding „0x“ 
such as „222“. This will be interpreted as „0x222“. 

5. Rule for input of decimal values: 

Decimal values may not be specified in hexadecimal format. For instance,  
0x1234 would cause an error. 

6. Rule for input of IDN values: 

IDN values must be specified only in the format [S/P]-X-XXXX or  
[S/P]-X-XXXX.X.X. 

7. Rule for input of negative values: 

Input of negative values (usage of minus sign) is only possible when using 
data type Signed Decimal. 
 

 
Note:  
Even syntactically correct entries may cause an error if one (or more) 
element(s) of these entries has (have) an incorrect data length. 
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5.7.4 Messages Issued when Editing the Upper Table 

5.7.4.1 Errors 

The following table provides an overview which error situations might occur 
in the “User-defined Parameters” pane. 

Problem The error message  

 
appears. 

Explanation IDN Duplicate Error 
A duplicate IDN has been used in the currently selected list (CP2, CP3 or CP4 
list). If the same IDN is entered twice for the same communication phase, this 
error message box will appear.  

The example picture applies to CP2. Similarly, the message box will also appear 
for CP3 and CP4 instead of CP2 used in the example. 

Action Use another IDN that has not been used in the CP2, CP3 or CP4 list already! 

Problem The error message  

 
appears. 

Explanation IDN Format Error  
At input of an IDN different from the given format, this message appears. It 
indicates that the format has been specified in neither of the two permitted 
formats: 

• [S/P]-X-XXXX 

• [S/P]-X-XXXX.X.X 

Action Use one of the correct formats for the IDN as specified! 

Only the two IDN formats [S/P]-X-XXXX or [S/P]-X-XXXX.X.X will be 
accepted as valid. 

Here: 
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[S/P] denotes either “S” or “P”. 

X denotes a number in the range 0 to 7. 

XXXX denotes a value in the range 0000 up to 4095. 

Problem The error message 

 

appears. 

Explanation Common Error 
This message box will appear, if you try to store data although already errors are 
currently indicated. 

Action In order to solve the problem, correct the errors indicated by 
 or  first! 

The problem needs to be solved in exactly the column and line where the 
exclamation mark or the question mark are displayed by typing in a correct value, 
i.e. a value within the allowed range in the correct format. 

Table 31: Possible Error Messages issued at User-defined Parameters Pane 
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5.7.5 Columns of the lower Tree-List Grid 
The lower tree-list grid is used as tool for easily filling the upper table with 
standard data. It is not editable. 

It contains representations of lists of proposed IDNs and their Structure 
Instances and Structure Elements: 

At first, the lower tree-list grid contains nothing.  

Clicking the button “Show standard parameters” right above the lower tree-
list grid will fill the tree-list grid with a list of the applicable functions 
(structured by their IDNs, Structure Instance and Structure Element).  

At the top of each such list, there is one line representing the entire IDN. In 
the first column there is a symbol allowing to expand or collapse the list of 
that IDN. Besides this column, there is only one column filled, namely the 
IDN column containing the complete denomination of the IDN. 
 

Under each IDN list entry, you can find one or more Structure Instance 
entries. These also have a node symbol in the structure tree in the first 
column which again can be expanded or collapsed. (These node symbols 
are shifted a bit to the right compared to the node symbols of the IDN list 
entries.) Besides this column, there is only one column filled, namely the 
IDN column containing the text Structure Instance and the number of the 
Structure Instance. 

Under each Structure Instance entry, you can find one or more Structure 
Element entries. Only these contain the relevant information to be selected 
and only for these the columns Format, Data Length, Name, Min.Value, 
Max.Value, Value, Unit, CP may be filled with data. 

In order to transfer the data of a single Structure Element entry of the lower 
tree-list grid to the upper table for the currently chosen communication 
phase:  

• either click the button “Select entry ” , when the desired line of the lower 
tree-list grid is marked, 

• or double click at the desired line of the lower tree-list grid. 
 

 
Note: It is not allowed to select more than one single line in the lower tree-
list grid. 

 

The columns within the lower tree-list grid have the following meaning: 

IDN  

This column identifies the IDN (including Structure Index and Structure 
Element) of the function proposed in the current line. For FSP Drives, only 
structure instances and structure elements of IDN S-0-1300 are available. 

Format  

This column contains the information about the data type of the data 
associated with the IDN. The possible data types allowed here are: 

• Binary 

• Unsigned decimal 

• Signed decimal 

• Hex 
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• Text 

• IDN 

• Float 

Data Length  

This column contains the length of the data associated with the IDN. 

The possible data types that may appear here: 

• 2 Octets 

• 4 Octets 

• 8 Octets 

• 1 Octet List 

• 2 Octet List 

• 4 Octet List 

• 8 Octet List 
 

 
Note: An octet represents a byte in this context. 

 

Name  

This column contains a descriptive text for the function associated with the 
IDN. 

Min.Value  

If the range of allowed values for this IDN is restricted, this column contains 
the minimum allowed value. 

Max.Value  

If the range of allowed values for this IDN is restricted, this column contains 
the maximum allowed value. 

Value  

This column contains the stored standard value of the respective IDN 
originating from the SDDML file. 

Unit  

This column contains a unit associated with the value, if one has been 
specified.  

CP 

This column contains the numbers of the communication phases, when the 
respective IDN is applicable. Allowed values are 2, 3 and 4 denoting the 
communication phases CP2, CP3 and CP4. 
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5.8 FSP IO 
In Sercos there are three kinds of IO devices according to the FSP IO 
specification (reference [7]): 

• Compact IO Devices 

A compact IO device contains one or more fixed IO functions, for instance a 
16 bit digital input module could be considered to be a compact IO device. 
It is not structured into separate modules. 

• Modular IO Devices 

A modular IO device contains a complex or variable configurable device 
which is structured into separate modules. 

• Hybrid IO Devices 

A hybrid IO device combines an IO device with a drive. 

A function group within a Sercos IO device is defined as a group of identical 
IO functions, such as a 16 bit digital input module or 4 bit analog output 
module.  A function group is usually denominated like the associated IDN, 
see list below.  

Example of a Compact IO Device 

For example, a compact device may contain 16 digital Outputs according to 
FG S-0-1502 and 16 digital Inputs according to FG S-0-1503. So the bus 
head includes the function groups FG S-0-1500, FG S-0-1502 and FG S-0-
1503. 

Example of a Modular IO Device 

For example, a modular device may contain  

Module 1 8 digital Outputs according to FG S-0-1502 

Module 2 16 digital Outputs according to FG S-0-1502 

Module 3 4 analog Inputs according to FG S-0-1505 and 4 analog 
outputs according to FG S-0-1504 

Module 4 16 digital Inputs according to FG S-0-1503 

So the bus head includes exactly one function group FG S-0-1500 and 
there are four modules with together 5 function groups.  

Module 3 contains 2 function groups (FG S-0-1505 and FG S-0-1504) while 
all other modules only contain one single function group (Module 1 and 
module 2: FG S-0-1502, Module 4: FG S-0-1503) 
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5.8.1 IO Modules 
At the pane IO Modules compact or modular devices can be configured.  

For instance, the figure displays the configuration of a compact device 
consisting of digital input and output. 
 

 
Figure 42: IO Modules Pane 

Upper part 
The upper part of the screen contains the module table, see section IO 
Modules - Module Configuration Table on page 105. 

The buttons have the following meaning: 
 

 Meaning 

 
A new slot is added in the configuration below the marked slot 

 
The marked slot is being removed. 

Table 32: Buttons for Slots in Module Configuration 

The values of the slot numbers must be included in the range from 0 and 
255. Each slot number can be assigned only once. For modular devices, 
this is already taken into account within the selection lists opening when 
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clicking at the fields of column Slot. Thus, the choice of an already used 
slot number is prohibited. 

Changes of the slot number immediately cause the list to be sorted again. 

• For modular IO devices, clicking at a field of column Name also opens a 
selection list allowing changing the module. 

• For compact IO devices there is no possibility to select any other 
numbers than the preselected slot numbers. There is also no possibility 
to change the module. 

Lower part 
The content of the lower part of the screen is a card register whose content 
depends on: 

• The module selected in the upper part of the screen (in the example: 
Digital Input IDN S-0-1503). 

• The selected card of the card register 

There are four register cards available: 

• Register Card ‘General’’ 

• Register Card ‘PDIN’’ 

• Register Card ‘’PDOUT’’ 

• Register Card ‘Parameter Set’’ 
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5.8.2 IO Modules - Module Configuration Table 
The upper part of the screen displays the module configuration table: 
Details may depend on whether the device is a compact or modular device. 
 

 
Figure 43: Configuration > Modules (Upper Part) 

The meaning of the various columns is the following: 

Slot 

The slot number where the module is plugged (indicating the order of 
modules). The value 0 is reserved for the bus head. If a compact device is 
shown, there will be only slot 0 as it only consists of a bus head.  

Module type code 

A code uniquely assigned to a specific module type of the list in section IO 
Modules on page 103. (Module type code relates only to the upper line.) 

Name 

The name of the module or function group associated with the selected row 
of the module configuration table. 

Config 

Boolean value indicating whether or not the function group is configured. 

Component Name 

The component name as defined in the Electronic Label. 

The module configuration table is organized as follows: 

• Each line, which is printed in strong and is not empty in the Slot column, 
represents an IO module in the sense of Sercos FSP IO. 

• Each other line (no entry in slot column, normally printed) represents a 
single function group (such as Digital Output and Digital Input in the 
example) within the IO module mentioned in the strongly printed line 
above. 
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The following function groups are defined within the Sercos FSP IO 
specification (see reference 7): 
 

IDN  Name of Function Group 

S-0-1501 Unknown 
S-0-1502 Digital Output 
S-0-1503 Digital Input 
S-0-1504 Analog Output 
S-0-1505 Analog Input 
S-0-1506 Counter 
S-0-1507 Complex Protocol 
S-0-1508 Sub bus Master 
S-0-1509 Sub bus Slave 
S-0-1510 Safety Output 
S-0-1511 Safety Input 
S-0-1512 Module-PLC 
S-0-1513 Motor starter 
S-0-1514 PWM 
S-0-1515 Positioning  
S-0-1516 Passive 

Table 33: Available Function Groups for IO Modules 
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5.8.3 IO Modules - Register Card ‘General’ 
This register card displays general information on the selected function 
group. 
 

 
Figure 44: Configuration > Modules (Lower Part), Register Card 'General' 

In detail, the following information is displayed: 

IDN of Function Group 
The IDN assigned to a specific function group of the list in Table 33: 
Available Function Groups for IO Modules on page 106 as defined by the 
Sercos FSP IO specification. 

FG Name 
The name of the function group associated with the selected line of the IO 
Modules - Module Configuration Table on page105 is displayed here. 

IO Type 
Here the IO Type corresponding to the selected function group is listed. 

Min delay time (μs) 
This value represents the minimum configurable delay time. The value is 
optional, so it may be missing as in the example above. 

Max delay time (μs) 
This value represents the maximum configurable delay time. The value is 
optional, so it may be missing as in the example above. 
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Removable 
The Boolean value indicates whether the function group is removable from 
a module. 

If this value it true, then user is allowed to change the “Config” flag of this 
function group upper Module Configuration Table. Please note that 
removable flag is only a configuration concept, a function group can not be 
physically removed from a module. 
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5.8.4 IO Modules - Register Card ‘PDIN’ 
This register card displays information on the PDIN data area of the 
selected function group. 
 

 
Figure 45: Configuration > Modules (Lower Part), Register Card ‘PDIN’ 

In detail, the following information is displayed: 

IDN of Function Group 

This is the IDN assigned to a specific function group of the list in Table 33: 
Available Function Groups for IO Modules on page 106 as defined by the 
Sercos FSP IO specification. See upper left corner. 

Channel quantity 

This item is configured within the SDDML file of the device. It contains the 
number of channels of the Process Data Input PDIN. 

Channel width 

This item is configured within the SDDML file of the device. It contains the 
number of bits within one channel of the Process Data Input PDIN. 

Configurable outside container 

This Boolean value is configured within the SDDML file of the device. It 
indicates whether the device is also configurable outside of the input data 
container or not.  

Configurable in CC related connection 

This Boolean value is configured within the SDDML file of the device. It 
indicates whether the device is also configurable in a connection related to 
cross communication. 

If the selected item has no inputs, the register card ‘PDIN’ is completely 
grayed out. 
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5.8.5 IO Modules - Register Card ‘PDOUT’ 
This register card displays information on the PDOUT data area of the 
selected function group. 
 

 
Figure 46: Configuration > Modules (Lower Part), Register Card ‘PDOUT’ 

In detail, the following information is displayed: 

IDN of Function Group 

This is the IDN assigned to a specific function group of the list in Table 33: 
Available Function Groups for IO Modules on page 106 as defined by the 
Sercos FSP IO specification. See upper left corner. 

Channel quantity 

This item is configured within the SDDML file of the device. It contains the 
number of channels of the Process Data Output PDOUT. 

Channel width 

This item is configured within the SDDML file of the device. It contains the 
number of bits within one channel of the Process Data Output PDOUT. 

Configurable outside container 

This Boolean value is configured within the SDDML file of the device. It 
indicates whether the device is also configurable outside of the output data 
container or not.  

Configurable in CC related connection 

This Boolean value is configured within the SDDML file of the device. It 
indicates whether the device is also configurable in a connection related to 
cross communication. 
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Freeze 

The Boolean value indicates the fall-back behavior of the device concerning 
the output data, i.e. whether the data will be frozen, or set to 0. 

If the selected item has no outputs, the register card ‘PDOUT’ is completely 
grayed out. 
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5.8.6 IO Modules - Register Card ‘Parameter Set’ 
This register card displays information on the parameter set of selected 
function group. 
 

 
Figure 47: Configuration > Modules (Lower Part), Register Card ‘Parameter Set’ 

The following information is accessible on the upper part of this register 
card: 

Frame: 
IDN of Function Group 

The IDN assigned to a specific function group of the list in section IO 
Modules - Module Configuration Table as defined by the Sercos FSP IO 
specification. 

Text fields in upper part: 
IDN 

This text field contains the number of the IDN. 

Phase 

This text field contains the affected communication phase. 

Length 

This text field contains the total length. 

Checkboxes: 
Editable 

This checkbox decides whether only editable parameters of function groups 
or all parameters are displayed. 

Visible 

This checkbox decides whether only visible parameters of function groups 
or all parameters are displayed.  
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Download 

The following information is accessible on the lower part of this register 
card: 

Table in lower part 
The meaning of the various columns of the table in the lower part is the 
following: 

Name 

This column contains the name of the parameter associated with the 
selected line of the parameter set table. 

Length 

This column contains the length (specified in units of bits) of the parameter 
associated with the selected line of the parameter set table. 

Byte offset 

This value contains the position, i.e. the offset in bytes within the data 
container (for input or output data, respectively) of the data selected with 
this line. 

Bit offset 

This value is always 1 if the data are byte aligned. Otherwise it contains the 
bit offset within the respective byte. 

Value 

The numeric value of the data of the selected function group. 

Description 

This column contains a description of the meaning of the selected function 
group. 

Visible  

This Boolean value indicates whether the selected function group is visible 
or not. 

Editable 

This Boolean value indicates whether the selected function group is 
editable or not. 
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5.9 Process Data 
This dialog pane displays information on the process data (both input and 
output data) sorted according to modules and function groups. 

 
Figure 48: Process Data Pane 

 

This pane consists mainly of two tables: 

• The upper table contains a list of channels defined for PDIN. 

• The lower table contains a list of channels defined for PDOUT. 
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Both tables have the same structure.  

The columns have the following meaning: 

Type 

This column shows the type of the channel. It is not editable. 

Tag 

This column shows a tag (short name) of the channel. This column is the 
only editable one in this table. 

Local offset 

This column shows the local offset of the channel as a numeric value. It is 
not editable. 

Length 

This column shows the length of the channel (i.e. the number of bits 
contained within the channel) as a numeric value in units of bits. It is not 
editable. 

Comment 

This column may contain a comment (originating from the SDDML file). It is 
not editable. 
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5.10 FSP Drive 

5.10.1 Producer Connections 
In order to configure producer connections for drives, the pane Producer 
can be used:  
 

 

Figure 49: Drive Connections > Producer 

The upper part of the dialog pane displays a table containing all configured 
producer connections. Each entry in the table corresponds to a configured 
producer connection which can be selected.  
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The columns of this table have the following meaning: 

IDN 

The symbolic notation of a 4-byte IDN. 

Byte length 

If a row represents an IDN, the value in this column is the length of IDN.  

If a row represents a connection, the value in this column is the total IDN 
data length of this connection. Please note, the current connection length 
(IDN S-0-1050.x.5) contains this total data length plus 2 byte connection 
control word. 

If a row represents a connections’ list, the value in this column is the total 
data length of all connections. 

Producer Cycle Time 

The producer cycle time (tPcyc, IDN S-0-1050.x.10). Each connection has a 
producer cycle time, which should be an integer multiple of the 
communication cycle time (tScyc) according to the following formula: 

tPcyc = tScyc × n  

where n is a natural number. 

The navigation buttons within the upper part of the dialog pane allow 
creation and deletion of producer connection entries. For a detailed 
explanation of the navigation buttons also see section “Table Line” on  
page 18 . 

Within the lower part of the dialog pane (this is below the title ‘Connection 
Setup’) you can adjust and configure the following settings related to the 
selected producer connection (according to IDN S-0-1050.x.1) via a 
separate selection list each: 

Usage of configuration (D15) 
Possible choices for this selection list are Used and Not used. 

• Used : 

If this option is chosen, the connection is allowed to be used by the Sercos 
Slave. 

• Not used : 

If this option is chosen, the Sercos Slave will not use the connection. 

Function within connection (D14) 
This selection list is fixed to the value Producer. 

Source of connection configuration (D12-D13) 
The only allowed choice for this selection list is currently Master. 
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Type of configuration (D4-D5) 
Possible choices for this selection list are variable configuration of IDNs, 
configuration with connection length and standard telegram. 

• variable configuration of IDNs 

This choice means that the producer connection is configured with variable 
length using IDN S-0-1050.x.6.  

• configuration with connection length 

This choice means that the producer connection is configured with fixed 
length using C-CON IO-Control (IDN S-0-1500.x.5) and IO-Status (IDN S-0-
1500.x.9). However, IDN S-0-1050.x.6 is not used in this case. 

• standard telegram 

This choice means that a standard telegram according to IDN S-0-0015 is 
used to configure the producer connection. 

Mechanism of producing (D3) 
Possible choices for this selection list are: producer cycle synchronous and 
asynchronous. 

• producer cycle synchronous 

• This choice means the producing mechanism works synchronously to 
the cycle of the producer. 

• asynchronous 

• This choice means the producing mechanism works asynchronously. 
Mechanism of monitoring (D0-D1) 
Possible choices for this selection list are producer cycle synchronous 
operation, asynchronous operation with watchdog and asynchronous 
operation without watchdog. 

• producer cycle synchronous operation 

Monitoring takes place synchronously to the cycle of the producer. 

• asynchronous operation with watchdog 

There is an asynchronous monitoring mechanism with a watchdog timer. 
The timeout value of the watchdog time corresponds to the producer cycle 
time (IDN S-0-1050.x.10) of this connection. 

• asynchronous operation without watchdog 

There is an asynchronous monitoring mechanism without any watchdog 
timer. 
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5.10.2 Consumer Connections 
In order to configure consumer connections for drives, the pane Consumer 
can be used:  
 

 

Figure 50: Drive Connections > Consumer 

The upper part of the dialog pane displays a table containing all configured 
consumer connections. Each entry in the table corresponds to a configured 
consumer connection which can be selected.  

The columns of this table have the following meaning: 

IDN 

The symbolic notation of 4-byte IDN. 

Byte length 

If a row represents an IDN, the value in this column is the length of IDN.  

If a row represents a connection, the value in this column is the total IDN 
data length of this connection. Please note, the current connection length 
(IDN S-0-1050.x.5) contains this total data length plus 2 byte connection 
control word. 
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If a row represents connections list, the value in this column is the total data 
length of all connections. 

Allowed Data Losses 

This value represents the allowed number of consecutive data loss events 
for the chosen connection before it will be interrupted. It corresponds to IDN 
S-0-1050.x.11. 

Producer Cycle Time 

The producer cycle time (tPcyc, IDN S-0-1050.x.10). Each connection has a 
producer cycle time, which should be an integer multiple of the 
communication cycle time (tScyc) according to the following formula: 

tPcyc = tScyc × n  

where n is a natural number. 

 

The navigation buttons within the upper part of the dialog pane allow 
creation and deletion of consumer connection entries. For a detailed 
explanation of the navigation buttons also see section “Table Line” on page 
6  . 

Within the lower part of the dialog pane (this is below the title ‘Connection 
Setup’) you can adjust and configure the following settings related to the 
selected producer connection (according to IDN S-0-1050.x.1) via a 
separate selection list each: 

Usage of configuration (D15) 
Possible choices for this selection list are Used and Not used. 

• Used: 

If this option is chosen, the connection is allowed to be used by the Sercos 
Slave. 

• Not used: 

If this option is chosen, the Sercos Slave will not use the connection. 

Function within connection (D14) 
This selection list is fixed to the value Consumer. 

Source of connection configuration (D12-D13) 
The only allowed choice for this selection list is currently Master. 
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Type of configuration (D4-D5) 
Possible choices for this selection list are variable configuration of IDNs, 
configuration with connection length and standard telegram. 

• variable configuration of IDNs 

This choice means that the consumer connection is configured with 
variable length using IDN S-0-1050.x.6.  

• configuration with connection length 

This choice means that the consumer connection is configured with fixed 
length using C-CON IO-Control (IDN S-0-1500.x.5) and IO-Status (IDN S-0-
1500.x.9). However, IDN S-0-1050.x.6 is not used in this case. 

• standard telegram 

This choice means that a standard telegram according to IDN S-0-0015 is 
used to configure the consumer connection. 

Mechanism of producing (D3) 
Possible choices for this selection list are: producer cycle synchronous and 
asynchronous. 

• producer cycle synchronous 

• This choice means the producing mechanism works synchronously to 
the cycle of the producer. 

• asynchronous 

• This choice means the producing mechanism works asynchronously. 
Mechanism of monitoring (D0-D1) 
Possible choices for this selection list are producer cycle synchronous 
operation, asynchronous operation with watchdog and asynchronous 
operation without watchdog. 

• producer cycle synchronous operation 

• Monitoring takes place synchronously to the cycle of the producer. 

• asynchronous operation with watchdog 

• There is an asynchronous monitoring mechanism with a watchdog timer. 
The timeout value of the watchdog time corresponds to the producer 
cycle time (IDN S-0-1050.x.10) of this connection. 

• asynchronous operation without watchdog 

• There is an asynchronous monitoring mechanism without any watchdog 
timer. 
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5.10.3 Error Messages when Editing Producer or Consumer Dialog 
Pane 

When editing either in the producer or consumer dialog pane, the following 
error situations might occur: 

Problem The error message  

 
appears. 

Explanation IDN Format Error 
If deviations between the specified IDN and the expected format occur, this error 
message will appear. 

Action Correct the IDN format error then! 

Only the two IDN formats [S/P]-X-XXXX or [S/P]-X-XXXX.X.X will be 
accepted as valid. 

Here: 

[S/P] denotes either “S” or “P”. 

X denotes a number in the range 0 to 7. 

XXXX denotes a value in the range 0000 up to 4095. 

Problem The error message  

 
appears. 

Explanation Duplicate IDN Error 
If multiple identical IDNs are specified, you will receive this message. 

Action Use another IDN that has not already been used in the connection list! 
(to be continued on next page) 
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Problem The error message  

 
appears. 

Explanation Last Connection IDN Error 
If there is only one single IDN configured below a connection instance and you try 
to delete the line representing this IDN. you will receive this error message: 

Action No action required – just leave at least one IDN below the connection instance. 

Problem The error message  

 
appears.  

(The upper value of the range mentioned here might vary in the range between 1 
and 1480 depending on how much bytes have already been used by other 
entries.) 

Explanation Range Error (concerning Byte Length) 
If an incorrect value for the byte length has been specified, this error message is 
issued. 

Action Specify a value not exceeding the limits mentioned in the error message. 

Problem The error message  

 
appears. 

Explanation Range Error (concerning Total Byte Length) 
If you try to add another line although the sum of the length of all present entries 
already have a byte length equal to the maximum (1480 bytes), this error message 
is issued.  

Action No action required – just do not add more lines. If you still intend to add another 
line, the Byte Length specified in at least one of the lines needs to be decreased. 

(to be continued on next page) 
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Problem The error message  

 
appears. 

Explanation Range Error (concerning Producer Cycle Time or Allowed Number of Lost 
Cycles)  
This error message will be displayed only when editing the Consumer dialog pane. 

When entering either the value of the Producer Cycle Time or the allowed number 
of lost cycles on the Consumer dialog pane, incorrect input might cause this error 
message to be displayed. 

Action Specify a value not exceeding the limits mentioned in the error message. 

Problem The error message  

 
appears. 

(The microseconds value within the brackets might vary depending on the chosen 
value of the communication cycle time!) 

Explanation Producer Cycle Time Error  
This error message will be displayed only when editing the Producer dialog pane. 

When entering the value of the Producer Cycle Time on the Producer dialog pane, 
values which are no integer multiple of the communication cycle time will cause 
this error message box to be displayed. 

Action As stated in the message, specify only integer multiples of the currently specified 
value of the communication cycle time. 

(to be continued on next page) 
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Problem The error message  

 
appears. 

Explanation Common Error 
If you try to store data although currently errors are indicated, this message box 
will appear. 

Action In order to solve the problem, correct the errors indicated by 
 or  first! 

Table 34: Possible Error Messages issued at Producer or Consumer Dialog Pane 
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5.11 Device Description 
The Slave DTM for Sercos allows to directly view the device description file 
by its integrated SDDML Viewer. 
 

 
Figure 51: Navigation Area - Device Description 

5.11.1 SDDML Viewer 
The SDDML Viewer shows the content of the SDDML file in a text view. 

Under Filename the absolute file directory path and the file name of the 
displayed SDDML file is displayed. Find what offers a search feature to 
search for text contents within the text of the SDDML file. 

In the SDDML Viewer window on the left side, the line number is displayed 
for simple overview, the further entries show the SDDML file in text format. 
 

Parameter Meaning 
File name File directory path and the file name of the displayed SDDML 

file. 
Find what Search feature to search for text contents within the text of the 

SDDML file. 
Match case Search option 
Match whole word Search option 

Table 35: Device Description – SDDML Viewer 
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Figure 52: SDDML Viewer 

 

The SDDML Viewer page consists of the following elements: 

• File name shows the absolute path of the DDF file. 

• Find what offers searching for specific text within the DDF file. 

• Using the Find Next button allows you to jump to the next occurrence of 
the text to be searched for within the XML DDF file. 

• Check Match case if you want to perform a case-sensitive search. 

• Check Match whole word if only entire words should match and 
fragments of words should be excluded from matching. 

 

 
Note: You can also access the search functionality of the SDDML Viewer 
by typing Ctrl-F on the keyboard. 
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6 Online Parameterization 
You can access this dialog pane via right clicking on the slave device icon 
and selecting the menu entry Configuration > Online Parameterization if 
the device has already been connected correctly. 

This dialog pane offers you the opportunity to manually read and write 
parameter data and to execute procedure commands associated with 
certain IDNs. 

In detail, it looks like this: 
 

 
Figure 53: Configuration->Online Parameterization 
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6.1 Upper Part of Dialog Pane 
In the upper left corner of the dialog pane, you can find a selection list titled 
List IDNs.  
 

 
This selection list provides the following selection of IDN lists ordered by 
their List IDNs: 
 

List IDN Associated IDN List 
S-0-0017 IDN-list of all operation data 
S-0-0021 IDN-list of invalid operation data for CP2 
S-0-0022 IDN-list of invalid operation data for CP3 
S-0-0025 IDN-list of all procedure commands 
S-0-0187 IDN-list of configurable data as producer 
S-0-0188 IDN-list of configurable data as consumer 
S-0-0192 IDN-list of all backup operation data 
S-0-0219 IDN–list of parameter set 
S-0-0270 IDN list of selected backup operation data 
S-0-0279 IDN list of password protected data 
S-0-0327 IDN list of checksum parameter 
S-0-0398 IDN list of configurable real-time/status bits 
S-0-0399 IDN list of configurable real-time/control bits 
S-0-0423 IDN-list of invalid data for parameterization level 
S-0-0428 IDN list of configurable measuring data 
S-0-0444 IDN-list of configurable data in the AT data container 
S-0-0445 IDN-list of configurable data in the MDT data container 

Table 36: Available IDN Lists 

The listed items are “List IDNs” i.e. IDNs really containing a list of other IDN 
numbers. These IDN numbers are listed in the list box below if you click on 
the Upload List button right below the List IDNs selection list. 

In order to fill the table in the left upper part of the dialog pane with the 
listed IDNs associated to that List IDN, perform the following: 

 Choose one of these List IDNs from the selection list mentioned above. 

 Click on button Upload list to upload the list associated with the chosen 
List IDN. 

 
 The table in the left upper part of the dialog pane with the listed IDNs is 

filled with the IDN numbers of all IDNs currently listed within the chosen 
List IDN.  

In the next step, you may choose which IDNs should be displayed in detail 
in the large table in the upper right part of the dialog pane. This done by 
checking or unchecking the check boxes just left of the IDN numbers.  

You may choose none, a single, multiple or all IDN numbers for display in 
the large table on the upper right part of the dialog pane. 
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To select all IDNs,  

 check the check box at the List IDN itself (serving as the root item of the 
displayed tree view), and all subordinated IDNs will be checked as well 
immediately. 

To exclude all IDNs from selection,  

 uncheck the List IDN itself similarly. 

To select or unselect a single IDN,  

 only check or uncheck the check box located at that IDN. 

In order to display those selected IDNs,  

 Just click the button Upload Selected Parameters. 

 The large table in the upper right part of the dialog pane will now be 
filled with all relevant information about the selected IDNs. It looks like: 

 

 
Figure 54: Upper right Part of the Dialog Pane 

 

The columns provide the following information about each IDN: 

IDN 
The IDN whose information is displayed on the same line in the other 
columns. 

Attribute 
The numerical value of the attribute. This item is only displayed if the check 
box Attribute above the table has been checked. 

Format 
The format (i.e. the data representation) in which the data contained in the 
IDN are stored (such as hexadecimal or unsigned decimal storage). 

Data Length 
The reserved length for storage of that data. 
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Value  
The stored value of the IDN itself. This item is only displayed if the check 
box Data above the table has been checked. 

Name  
The name of the IDN, if available. This item is only displayed if the check 
box Name above the table has been checked. 

Min.  
The minimum allowed value of the value of the IDN. This item is only 
displayed if the check box Min.,Max. above the table has been checked. 

Max.  
The maximum allowed value of the value of the IDN. This item is only 
displayed if the check box Min.,Max. above the table has been checked. 

Unit 
The unit associated with the value of the IDN, if any is associated at all. 
This item is only displayed if the check box Unit. above the table has been 
checked. 

For each displayed IDN, the table contains one line containing the above 
mentioned information about the IDN itself, and, if necessary, one or more 
additional lines for possibly present data (depending on the chosen IDN). In 
these additional lines, only the columns IDN and Value are filled.  

Some additional information on these columns follow here: 

6.1.1 Attribute 
This column contains additional information required for administrative 
purposes. It is mandatory. 

It is a 32-bit wide bit mask to be interpreted according to the subsequent 
table: 
 

 
Note:  
UTF8 is supported. 

 

Coding of Attribute Information in IDN 

D31 D30 D29 D28 D27-
D24 

D23 D22-
D20 

D19 D18-D16 D15-D0 

         Conversion factor used for conversion of 
data to display format, specified as 
unsigned integer. Use 1 if not required 
(for instance for binary, character string 
or floating point number data) 

        Data length (required for correct termination of data 
transmission on the service channel) 

        000 Reserved 

        001 Two bytes of operation data 

        010 Four bytes of operation data 
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D31 D30 D29 D28 D27-
D24 

D23 D22-
D20 

D19 D18-D16 D15-D0 

        011 Eight bytes of operation data 

        100 Length is variable/ 1-byte data strings 

        101 Length is variable/ 2-byte data strings 

        110 Length is variable/ 4-byte data strings 

        111 Length is variable/ 8-byte data strings 

       Function 

       0 Operation data/parameter 

       1 Command 

      Coding for data type and display format 

       Data type Display format 

      000 Binary value Binary 

      001 Unsigned integer Decimal 

      010 Signed integer Decimal + sign 

      011 Unsigned integer Hexadecimal 

      100 Extended 
character set 

Text 

      101 Unsigned integer IDN 

      110 ANSI 754-1985 
floating point 
number (single 
precision) 

Decimal value with exponent (fraction 
after decimal point is not taken into 
account) 

      111 Reserved Reserved 

     Reserved 

    Position of decimal point for input and display (not applicable to floating point data) 

    0000 No places following the decimal point 

    …  

    1111 15 places following the decimal point 

   Write protection in CP2 

   0 Write protection not effective for operation data 

   1 Write protection effective for operation data 

  Write protection in CP3 

  0 Write protection not effective for operation data 

  1 Write protection effective for operation data 

 Write protection in CP4 

 0 Write protection not effective for operation data 

 1 Write protection effective for operation data 

Reserved 

Table 37: Coding of Attribute Information in IDN 
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The display format and the data length must match. Corresponding 
combinations are marked in the table below:  
 

Data 
Length 

Binary Unsigned 
decimal 

Signed 
decimal 

Hex  Text IDN Float Time 

2 octet Yes Yes Yes Yes No No No No 
4 octet Yes Yes Yes Yes No Yes Yes No 
8 octet Yes Yes Yes Yes No No Yes Yes 
1 octet No Yes No Yes Yes No No No 
2 octet list Yes Yes Yes Yes No No No No 
4 octet list Yes Yes Yes Yes No Yes Yes No 
8 octet list Yes Yes Yes Yes No No Yes Yes 

Table 38: Allowed Combinations of Display Format and Data Length 

 

For more information on the extended character set see the specification of 
Sercos in the third generation, appendix E. 

6.1.2 Value 
This column contains the stored value of the IDN itself.  
 

 
Note:  
This item is only displayed if the check box Data above the table has been 
checked. 

 

There are 3 formats defined in the Sercos standard which can be applied 
here: 

• Fixed length format with 2 bytes 

• Fixed length format with 4 bytes 

• Variable length format with support for up theoretically up to 65532 bytes 
(limited to 1368 bytes in the current implementation of the Sercos 
firmware.) 

In case of the variable length format these bytes are structured as follows: 

• The first two bytes contain the hexadecimally coded value of the current 
length of the data. This is the text the master proposes to the slave. If 
these two bytes are 0, no other data are required and a zero-length 
datum will be defined therefore. 

• The next two bytes contain the hexadecimally coded value of the 
maximum allowed length of data if the slave is permitted to change the 
text. (If this length is equal to 0, the slave is not permitted to do so.) 

• Beginning from the fifth byte there is a string consisting of up to 1368 
bytes (characters) space for the data of the object assigned to the IDN. 
Characters exceeding the amount specified in the length bytes should 
be truncated by the Sercos slaves. 
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6.1.3 Name 
This column holds the name of the operational data which are stored under 
the respective IDN. It is optional. 

The length is limited to at most 64 bytes. At least 2 bytes need to be used.  

These bytes are structured as follows: 

• The first two bytes contain the hexadecimally coded value of the length 
of the programmed text. This is the text the master proposes to the 
slave. If these two bytes are 0, no other data are required and a zero-
length name will be defined therefore. 

• The next two bytes contain the hexadecimally coded value of the 
maximum allowed length of this text if the slave is permitted to change 
the text. (If this length is equal to 0, the slave is not permitted to do so.) 

• Beginning from the fifth byte there is a string consisting of up to 60 bytes 
(characters) space for the actual name of the object assigned to the IDN. 
Characters exceeding the amount specified in the length bytes should 
be truncated by the Sercos slaves. 

Also see Figure 1: Name structure of the Sercos Spec: 

For more information, refer to the specification of Sercos in the third 
generation. 

 

6.1.4 Min. 
This column holds the minimum value allowed for the operational data 
which are stored under the respective IDN. It is optional. 

Lower values cannot be processed by the slave, i.e. when a write request 
occurs with a lower value, the original value will not be changed.. 

The length is fixed to 64 bytes.  

In the following cases this element is not applicable: 

• Working with binary numbers 

• Working with character strings 

• Operation data have variable length 
 

 
Note:  
This item is only displayed if the check box Min.,Max. above the table has 
been checked! 
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6.1.5 Max. 
This column holds the maximum value allowed for the operational data 
which are stored under the respective IDN. It is optional. 

Higher values cannot be processed by the slave, i.e. when a write request 
occurs with a higher value, the original value will not be changed. 

The length is fixed to 64 bytes.  

In the following cases this element is not applicable: 

• Working with binary numbers 

• Working with character strings 

• Operation data have variable length 
 

 
Note:  
This item is only displayed if the check box Min.,Max. above the table has 
been checked! 
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6.1.6 Unit 
This column holds the name of unit to be applied to the operational data 
which are stored under the respective IDN. It is optional. 
 

 
Note:  
This item is only displayed if the check box Unit. above the table has been 
checked! 

 

For each displayed IDN, the table contains one line containing the above 
mentioned information about the IDN itself, and, if necessary, one or more 
additional lines for eventually present data (depending on the chosen IDN). 
In these additional lines, only the columns IDN and Value are filled.  

The length is limited to at most 16 bytes. At least 2 bytes need to be used.  

These bytes are structured as follows: 

• The first two bytes contain the hexadecimally coded value of the length 
of the programmed text. This is the text the master proposes to the 
slave. If these two bytes are 0, no other data are required and a zero-
length name will be defined therefore. 

• The next two bytes contain the hexadecimally coded value of the 
maximum allowed length of this text if the slave is permitted to change 
the text. (If this length is equal to 0, the slave is not permitted to do so.) 

• Beginning from the fifth byte there is a string consisting of up to 12 bytes 
(characters) space for the actual unit of the object assigned to the IDN. 
Characters exceeding the amount specified in the length bytes should 
be truncated by the Sercos slaves. 

When the data type is either binary or character string, the data has no unit. 

Also see Figure 2: Unit structure of the specification of Sercos in the third 
generation. 
 

 
Note: As the service channel transfers data in a word-aligned manner, it is 
recommended to use even values for the two length specifications 
described in this context. 

 

For more information, refer to the specification of Sercos in the third 
generation. 
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6.2 Lower Part of Dialog Pane 
You can highlight one single line of the large table in the upper right part of 
the dialog pane representing one specific IDN in order to be accessed 
within lower part of the dialog pane. (In the example given above in section 
’Upper Part of Dialog Pane’, this specific IDN is IDN S-0-1012.)  

Three kinds of actions can be performed with a single parameter of an IDN: 

    

    

         

In order to select a single parameter of a specific IDN for accessing, do the 
following: 

 Highlight the line of your choice in the large table in the upper right part 
of the dialog pane. 

 Click on the button Select IDN in the center of the dialog pane. 

 
Figure 55: Button 'Select IDN' 

 The IDN associated to the chosen line is selected for single parameter 
access. Which specific IDN has been chosen is now displayed on the 
left side at IDN. 

 
Figure 56: IDN Display 

 Everything displayed within the lower part of the dialog pane i.e. below 
the line with the text “Single parameter access” now just relates to this 
chosen IDN. 

 The table on the right side of the lower part of the dialog pane is now 
filled with current data. It allows you to enter the data to be changed. 

 
Figure 57: Lower Part of the Dialog Pane 

 

The selection list Action on the left side of the lower part of the dialog pane 
allows you now to decide whether to read, write or execute the IDN 
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Figure 58: Selection list 'Action’ 

The IDN field shows the selected IDN according to the procedure described 
above: 

 
Figure 59: IDN field 

This field is editable. 

The Attribute field shows the attribute data of the selected IDN in 
hexadecimal representation. It is interpreted according to the procedure 
described in section Attribute. 

This field is not editable. 

The field Display format informs about the data format in which the data are 
stored and display depending on the data type. The following display 
formats are possible: 

• Binary 

• Unsigned decimal 

• Signed decimal 

• Hex 

• Text 

• IDN 

• Float 

• Time 

This field is not editable. 

The field Data length informs about the data length of the data associated 
with the IDN. The following values are possible: 

• 2 octet 

• 4 octet 

• 8 octet 

• 1 octet 

• 2 octet list 

• 4 octet list 

• 8 octet list 

This field is not editable. 

The field Procedure command shows whether the IDN contains a 
procedure command which can be executed by selecting Execute in the 
Action selection list, or not. This field is not editable. 

The field Writable in displays the communication phase(s), when the IDN is 
writable. This field is not editable. 
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Figure 60: Table for reading and writing values of IDN Data and for Execution of Procedure 
Commands 

The following is the meaning of the columns of table in the right lower part 
of the dialog pane: 

The column DB Element lists the elements of the selected IDNs such as 
data, name, unit, minimum and maximum value. 

The column Value contains the value of the DB Element. The value is 
editable. 

The column Status shows whether changes were successful (Ok) or 
unsuccessful (Error). 

In order to make your changes of IDN data effective which you made in the 
Value column of the table: 

 Click the Execute action button in order to make your changes effective. 

 
Figure 61: Execute Action' Button 

 Depending on the chosen action in the Action selection list, data are 
read, written or the procedure command associated to the IDN is 
executed. 

You can use the checkboxes above the table to display or inhibit displaying 
the items Data, Name, Unit, Minimum Value and Maximum Value: 

These are 

 
Figure 62: Checkboxes Data, Name, Unit, Minimum Value and Maximum Value 
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7 Online Functions 
 

This section describes how to connect to or disconnect from a device and 
how to download a configuration. 

7.1 Connecting/Disconnecting Device 
 

 
Note: Several Sercos Slave DTM functions e. g. Diagnosis or the 
configuration download in the FDT Framework require an online 
connection from the Sercos Slave DTM to the Sercos Slave  device. 

Connecting Device 
The following steps are needed to establish a connection from the Sercos 
Slave DTM to a Sercos Slave device: 

Under Settings in the Driver pane: 

1. Verify that the default driver is checked and respectively check another 
or multiple drivers. 

2. Configure the driver if necessary. 

Under Settings in the Device Assignment pane: 

3. Scan for the devices (with or without firmware). 

4. Select the device (with or without firmware) and apply the selection. 
 

 

Before you download the firmware adhere to the necessary safety 
precautions to prevent personnel injury and property damage. For more 
refer to section Safety Messages on Firmware or Configuration Download 
on page 31. 

Under Settings in the Firmware Download pane if not yet a firmware was 
loaded to the device: 

5. Select and download the firmware. 

Under Settings in the Device Assignment pane if not yet a firmware was 
loaded to the device: 
 

6. Scan for the device (with firmware) once more. 

7. Select the device (with firmware) once more. 
 

 

An overview of the descriptions for these steps you find in the section 
Overview Settings on page 32. 

 

8. In the DTM interface dialog select the OK button, to apply the selection 
and to close the DTM interface dialog. 

9. Put a right-click on the Sercos Slave device icon. 

10. Select the Connect command from the context menu. 

 The Sercos Slave device now is connected to the Sercos Slave  DTM 
via an online connection. In the network view the device description at 
the device icon of the Slave is displayed with a green colored 
background. 
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Disconnecting Device 
To disconnect an online connection from the Sercos Slave device to a 
Sercos Slave DTM take the following steps: 

1. In the DTM interface dialog select the OK button, to close the DTM 
interface dialog. 

2. Right-click on the Sercos Slave device icon. 

3. Select the Disconnect command from the context menu. 

 In the network view the device description at the device icon of the 
Slave is not any more displayed with a green colored background. Now 
the Sercos Slave device is disconnected from the DTM. 
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7.2 Download Configuration 
The device configuration is created offline in the DTM (application 
program). A download to the device is required, to transfer the configuration 
with the parameter data to the device.  
 

 
Note: To download configuration parameter data to the Sercos Slave 
device an online connection from the Sercos Slave DTM to the Sercos 
Slave device is required. Further information can be found in the 
Connecting/Disconnecting Device section on page 140. 

 

Safety Precautions 
If you plan to perform a configuration download via the Sercos Slave DTM 
be aware of the following: 
 

  
Communication Stop due to Configuration Download,  
Faulty System Operation possible or Loss of Device Parameters  
Before you initiate a configuration dowload process, while the bus is still in 
operation status: 
 Stop the application program. 

 Make sure that all network devices are placed in a fail-safe condition. 
 

  
Mismatching System Configuration,  
faulty System or Device Operation possible 
 In the device use only a configuration suitable for the system. 
 

 
 
 

 
Loss of Parameters caused by Power Disconnect during 
Configuration Download 
 During configuration download process, do not interrupt the power supply 

to the PC, or to the device and do not perform a reset to the device! 

For more see next page. 
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Download Steps 
To transfer the configuration with the corresponding parameter data to the 
Sercos Slave device you download the data using the frame application of 
the configuration software.  

For netDevice the download is made via Device > Download or use the 
context menu with Download. 

1. Select Download in the context menu of the device.  

 If the download is started as long as the Slave devices are connected to 
the Master device, the following message is displayed: ‘If you attempt to 
download during bus operation, communication between Master and 
Slaves is stopped. Do you really want to download?’ 

 
Figure 63: netDevice Message: Download 

 

Important: If the communication between the Master and the Slave 
devices is stopped, the data exchange between the Master device and the 
Slave devices is stopped. 

 

2. Click to Yes if you intend to download the configuration.  

 Then the current configuration in the application program is down 
loaded to the device. 

3. Otherwise click to No. 
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8 Diagnosis 
8.1 Overview Diagnosis 

The dialog Diagnosis serves to diagnose the device behavior and 
communication errors. For diagnosis the device must reside in online state.  

Diagnosis Panes 
The table below gives an overview for the individual Diagnosis dialog 
panes descriptions: 
 

Sercos Slave DTM Folder Name / Section Manual Page 

 
Navigation Area - Diagnosis 

General Diagnosis  145 

Firmware Diagnosis 147 

Table 39: Descriptions of the Diagnosis Panes 

Online Connection to the Device 

 
Note: Accessing the Diagnosis panes of the Sercos Slave DTM requires 
an online connection from the Sercos Slave DTM to the Sercos Slave 
device. For further information refer to section Connecting/Disconnecting 
Device on page 140. 

 
 

How to proceed 
1. In the Slave DTM diagnosis dialog check whether the communication is 

OK: 

Diagnosis > General Diagnosis > Device status "Communication" must 
be green! 

2. "Communication" is green: Open the IO Monitor and test the input or 
output data.. 

3. "Communication" is not green: Use Diagnosis and Extended 
diagnosis for troubleshooting. 

 
 

Extended Diagnosis 
The Extended Diagnosis helps to find communication and configuration 
errors, when default diagnosis fails. For further information refer to section 
Overview Extended Diagnosis on page 148. 
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8.2 General Diagnosis 
Information regarding the Device State and other general diagnosis 
parameters are displayed in the General Diagnosis dialog. 

 
Figure 64: General Diagnosis 

LED Meaning Color State 

Device State 

Communication Shows whether the Sercos device executes the 
network communication. 

 (green) In COMMUNICATION 
state 

 (gray) Not in 
COMMUNICATION state 

Run Shows whether the Sercos device has been 
configured correctly. 

 (green) Configuration OK 

 (gray) Configuration not OK 

Ready Shows whether the Sercos device has been started 
correctly. The Sercos device waits for a 
configuration. 

 (yellow) Device READY 

 (gray) Device not READY 

Error Shows whether the Sercos device records a device 
status error. For further information about the error 
characteristics and the number of counted errors 
refer to the extended diagnosis. 

 (red) ERROR 

 (gray) No ERROR 

Network State 

Operate Shows whether the Sercos device is in data 
exchange. In a cyclic data exchange the input data 
or the output data of the Sercos Slave are 
transmitted to the Sercos Master. 

 (green) In OPERATION state 

 (gray) Not  
in OPERATION state 

Idle Shows whether the Sercos device is in idle state.  (yellow) In IDLE state 

 (gray) Not in IDLE state 
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LED Meaning Color State 

Stop Shows whether the Sercos device is in Stop state: 
There is no cyclic data exchange at the Sercos 
network. The Sercos device was stopped by the 
application program or it changed to the Stop state 
because of a bus error. 

 (red) In STOP state 

 (gray) Not in STOP state 

Offline  The Sercos Slave is offline as long as it does not 
have a valid configuration. 

 (yellow) In OFFLINE state 

 (gray) Not in OFFLINE state 

Configuration State 

Configuration 
locked 

Shows whether the Sercos device configuration is 
locked, to avoid the configuration data are typed 
over. 

 (yellow) Configuration LOCKED 

 (gray) Configuration not 
LOCKED 

New Configura-
tion pending 

Shows whether a new Sercos device configuration 
is available. 

 (yellow) New Configuration 
pending 

 (gray) No new Configuration 
pending 

Reset required Shows whether a firmware reset is required as a 
new Sercos device configuration has been loaded 
into the device. 

 (yellow) RESET required 

 (gray) No RESET required 

Bus ON Shows whether the bus communication was started 
or stopped. I. e., whether the device is active on the 
bus or no bus communication to the device is 
possible and no response telegrams are sent. 

 (green) Bus ON 

 (gray) Bus OFF 

Table 40: Indication General Diagnosis 

 
 

Parameter Meaning 
Communication Error Shows the name of the communication error. If the cause of error is resolved, the value will be 

set to zero again. 

Watchdog time Shows the watchdog time in ms. 

Error Count This field holds the total number of errors detected since power-up, respectively after reset. 
The protocol stack counts all sorts of errors in this field no matter whether they were network 
related or caused internally. 

Table 41: Parameter General Diagnosis 
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8.3 Firmware Diagnosis 
In the dialog Firmware Diagnosis the current task information of the 
firmware is displayed.  

Under Firmware or Version the name of the firmware and version 
(including the date) are indicated. 
 

 
Figure 65: Firmware Diagnosis (Example) 

Task Information: 
The table Task Information is listing the task information of the single 
firmware tasks. 
 

Column Meaning 
Task Task number  

Name of task Name of the task 

Version Version number of the task 

Prio Priority of the task 

Description Description of the task 

Status Current status of the task 

Table 42: Description Table Task Information 
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9 Extended Diagnosis 
 

9.1 Overview Extended Diagnosis 
The Extended Diagnosis of the Sercos Slave DTM helps to find 
communication and configuration errors. Therefore it contains a list of 
diagnosis structures as online counter, states and parameters.  

Dialog Panes “Extended Diagnosis” 
The table below gives an overview for the Extended Diagnosis dialog 
panes descriptions: 
 

Sercos Slave DTM Folder Name in the 
Navigation Area 

Dialog Pane Page 

 
Navigation Area - Extended Diagnosis 

RX-SYSTEM Task Information  149 
 IniBatch Status 150 
DPM_COM0_SMBX
 Task Information  149 
DPM_COM0_RMBX
 Task Information  149 
S3S_SVC Task Information  149 
S3S_IDN Task Information  149 
S3S_COM Task Information  149 
S3S_AP Task Information  149 
S3S_NRT Task Information  149 
TCP_UDP Task Information 149 
 IP Information 151 
 IP Packet Counter 152 
 IP Code Diagnosis 152 
 TCP_UDP Information 153 
 TCP_UDP Code Diagnosis 153 
S3S_SIP Task Information 149 
MARSHALLER Task Information  149 
PACKET_ROUTER Task Information  149 

Table 43: Descriptions of the Dialog Panes Extended Diagnosis 
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Online Connection to the Device 

 
Note: Accessing the Extended Diagnosis dialog panes of the Sercos 
Slave DTM requires an online connection from the Sercos Slave DTM to 
the Sercos Slave device. For further information refer to section 
Connecting/Disconnecting Device on page 140. 

 
 

9.2 Task Information 

 
Figure 66: Extended Diagnosis > [Folder Name] > Task Information Example Display 

Name Description 
Identifier Identification number of the task 

Major version Task version, contains incompatible changes 

Minor version Task version, contains compatible changes 

Maximum packet size Maximum packet size, which the task sends 

Default Queue Queue handle, which is accessible via DPM by mailbox. 

UUID Unique user ID, 16 Byte indicator used for task identification and its affiliation e. g. to a stack 
(therein different identification data are coded in). 

Init result Error Code, 0= no Error 
The description of the error codes can be found in this manual or in the corresponding 
software reference manuals. 

Table 44: Extended Diagnosis > [Folder Name] > Task Information 
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9.3 IniBatch Status 

 
Figure 67: Extended Diagnosis > [Folder Name] > IniBatch Status Example Display 

Name Description 
Communication Channel Number of the communication channel used by the device. 

Current State Idle; 
IniBatch packets in progress; 
Retrying to send last packet; 
Error 

IniBatch Result Ok; 
No DBM file; 
No Packet table; 
No data set available;  
Data set is shorter than packet length; 
Packet Buffer is shorter than Packet length; 
Invalid packet destination; 
Logical queue not defined 
Send packet failed; 
Too many retries; 
Error in confirmation packet status 

OpenDbm Result Error when opening the IniBatch data base 
Under "OpenDbm Result" the error code is typed in, when "IniBatch Result" == "No DBM 
file" (1) is. 

SendPacket Result Error when sending a packet 
Under "SendPacket Result" the error code is typed in, when "IniBatch Result" == “send 
packet failed" (8) is. 

Confirmation Result Confirmation error when sending packets 
Under "Confirmation Result" the packet specific error code from the ulSta is typed in, when 
"IniBatch Result " == "Error in confirmation packet status" (10) is. 

Last Packet Number Value depends by the communication system. 

Last Packet Command Value depends by the communication system. 

Last Packet Length Value depends by the communication system. 

Last Packet Destination Value depends by the communication system. 

Table 45:  Extended Diagnosis > [Folder Name] > IniBatch Status 

The task status "Confirmation Result" is bus specific. The other task 
statuses are rcx-related error codes. 
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9.4 TCP_UDP 
 

9.4.1 IP Information 

 
Figure 68: Extended Diagnosis > TCP_UDP > IP-Information 

Name Description 
Task State Actual state of the protocol process: 

0 = Task not initialized 
1 = Task is running 
2 = Task initialized 
3 = Initialization error 

Error Counter Counter for errors 
Last Error Last occurred error (Description see appropriate manual) 
IP Address IP address of the PROFINET IO Device station. 
Net Mask Network mask of the PROFINET IO Device station. 
Gateway Gateway address of the PROFINET IO Device station. 
IP config source IP configuration is done through the following sources: 

None (receive no configuration), 
DHCP server, 
BOOTP server, 
Database, warm-start packet, 
ICMP (ping) (not supported), 
Hilscher NetIdent protocol 

Table 46: Extended Diagnosis > TCP_UDP > IP-Information 
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9.4.2 IP Packet Counter 

 
Figure 69: Extended Diagnosis > TCP_UDP > Packet Counter 

Name Description 
Packet Recv TCP Counter for received TCP packets 

Packet Recv UDP Counter for received UDP packets 

Packet Recv ICMP Counter for received ICMP packets 

Packet Recv IP Header Err Counter for received IP packets with errors 

Packet Recv ARP Counter for received ARP packets 

Packet Recv Unknown Counter for received packets of an unknown type 

Table 47:  Extended Diagnosis > TCP_UDP > Packet Counter 

9.4.3 IP Code Diagnosis 

 
Figure 70: Extended Diagnosis > TCP_UDP > IP Code Diagnosis 

Name Description 
Info Counter Counter for information reports 

Warning Counter Counter for warning reports 

Error Counter Counter for errors 

Severity Level Level of the last occurred error: 
Values: “None”, “Information”, “Warning”, “Error”, “Fatal Error” 

Code Code of the last occurred error 

Parameter Additional information to the error 

Module Software module 

Line number Line number inside the software module  

Table 48: Extended Diagnosis > TCP_UDP > IP Code Diagnosis 
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9.4.4 TCP_UDP Information 

 
Figure 71: Extended Diagnosis > TCP_UDP > TCP_UDP Information  

Name Description 
Task State Actual state of the protocol process: 

0 = Task not initialized 
1 = Task is running 
2 = Task initialized 
3 = Initialization error 

Error Count Counter for errors 

Last Error Last occurred error (Description see appropriate manual) 

Table 49: Extended Diagnosis > TCP_UDP > TCP_UDP Information 

9.4.5 TCP_UDP Code Diagnosis 

 
Figure 72: Extended Diagnosis > TCP_UDP > TCP_UDP Code Diagnosis 

Name Description 
Information Counter Counter for information reports 

Warning Counter Counter for warning reports 

Error Counter Counter for errors 

Severity Level Level of the last occurred error:  
Values: “None”, “Information”, “Warning”, “Error”, “Fatal Error” 

Code Code of the last occurred error 

Parameter Additional information to the error 

Module Software module 

Line Number Line number inside the software module  

Table 50: Extended Diagnosis > TCP_UDP > TCP_UDP Code Diagnosis 
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10 Tools 
10.1 Overview Tools 

Under Tools the Packet Monitor and the IO Monitor are provided for test 
and diagnosis purposes.  

Tools Panes 
The table below gives an overview for the individual Tools dialog panes 
descriptions: 
 

Sercos Slave DTM Folder Name / Section Manual Page 

 
Navigation Area - Tools 

Packet Monitor  155 

IO Monitor 158 

Table 51: Descriptions of the Diagnosis Panes 

Online Connection to the Device 

 
Note: Accessing the Tools dialog panes of the Sercos Slave DTM 
requires an online connection from the Sercos Slave DTM to the Sercos 
Slave device. For further information refer to section 
Connecting/Disconnecting Device on page 140. 
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10.2 Packet Monitor 
The Packet Monitor serves for test and diagnosis purposes.  

Data packets, i. e. messages are self-contained blocks of defined data 
length. The packets are used to communicate with the firmware and they 
are exchanged between the application (configuration software) and the 
firmware in the device. Packets can be sent once or cyclically to the 
connected device controlled by the user and packets received can be 
displayed. 

Data packets comprise from a Packet Header and the Send Data or from 
a Packet Header and the Receive Data. The packet header can be 
evaluated by the receiver of the packet and contain the sender and receiver 
address, the data length, an ID number, status and error messages and the 
command or response code. The minimum packet size amounts 40 Byte 
for the packet header. The sending and receiving data are added. 
 

 

For further information to the packet description refer to the Protocol API 
Manual.  

 Open the Packet Monitor via Tools > Packet Monitor. 

 
Figure 73: Packet Monitor 

Display Mode switches the representation of the send and reception data 
between decimal and hexadecimal. 

 Select Reset Counter to reset the packet counter. 
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10.2.1 Sending Packet 

 
Figure 74: Send > Packet Header and Send Data 

Packet Header 
Under Send > Packet Header the elements of the packet header of the 
sending packet are displayed, which is transmitted from the application 
(configuration software) to the device. The packet header of the sending 
packets contain the elements described in the following table. 
 

Element Description 
Dest Destination Queue Handle Contains the identifier of the receiver for the packet (destination task 

queue of the firmware).  
Src Source Queue Handle Contains the identifier of the sender of the packet (sending task).  
Dest 
ID 

Destination Queue Reference Contains an identifier for the receiver of unsolicited sent packets from the 
firmware to the application (configuration software).  

Src ID Source Queue Reference Contains an identifier of the sender.  
Len Packet Data Length (in Bytes) Length of the send respectively receive data. 
ID Packet Identification As 

Unique Number  
Identifies identical data packets among each other. 

State Status / Error Code Transmits status or error codes to the packet sender. 
Cmd Command / Response Code Command or respond code.  
Ext Extension Field for extensions (reserved). 
Rout Routing Information Internal value of the firmware. 

Table 52: Descriptions Packet Header 

 

 Under Dest select the receiver (destination task queue). 

 Under Cmd select the command identification (Request). 

Auto Increment ID is an increment for the identifier of the data packets 
and increments the ID by 1 for each newly sent packet. 

Send Data 
 Under Send > Send data enter the send data of the packet, which shall 

be transmitted from the application (configuration software) to the 
mailbox of the device. The meaning of the transmitted data depends on 
the command or response code. 
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Sending Packets once or cyclic 
 To send packet once, select Put packet. 
 To send packet cyclic, select Put cyclic. 
 

10.2.2 Receiving Packet 

 
Figure 75: Packet Header and Receive Data 

Packet Header 
Under Receive > Packet Header the elements of the packet header of the 
receiving packet are displayed, which are transmitted back from the device 
to the application (configuration software). The packet header of the 
receiving packets contain the elements described in the following table. 
 

Element Description 
Dest Destination Queue Handle Contains the identifier of the receiver for the packet (destination task 

queue of the firmware).  
Src Source Queue Handle Contains the identifier of the sender of the packet (sending task).  
Dest ID Destination Queue Reference Contains an identifier for the receiver of unsolicited sent packets from 

the firmware to the application (configuration software).  
Src ID Source Queue Reference Contains an identifier of the sender.  
Len Packet Data Length (in Bytes) Length of the send respectively receive data. 
ID Packet Identification As 

Unique Number  
Identifies identical data packets among each other. 

State Status / Error Code Transmits status or error codes to the packet sender. 
Cmd Command / Response Code Command or respond code.  
Ext Extension Field for extensions (reserved). 
Rout Routing Information Internal value of the firmware. 

Table 53: Descriptions Packet Header 

Receive Data 
Under Receive > Receive Data the receiving data of the packet, which is 
transmitted back from the device to the application (configuration software) 
are displayed. 
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10.3 IO Monitor 
The IO Monitor serves for test and diagnosis purposes. It provides to view 
data of the process data image and to change output data easily. The 
display is always in a Byte manner.  
 

 
Note: Only change and write output data if you know that no plant 
disturbances are caused by this. All output data written by the IO Monitor 
are transmitted at the bus and have effect on subordinate drives, IO etc. 

 

 
Figure 76: IO Monitor 

Columns switches the number of columns.  

Display mode switches the representation of the input and output data 
between decimal and hexadecimal. 

Offset / Go moves the indication of the data to the entered offset value. 

 Enter the output value and select Update.  

 Always the data of the process image are displayed, also when these 
Bytes have not been reserved by the configuration.  
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11 Error Codes 
11.1 Error Code Definition 

For COM based application, like the ODM Server and ODM drivers, a 
common error definition is used, similar to the Microsoft Windows® 
HRESULT definition. 

Error Code Structure: 

COM Errors are HRESULTs, which are 32 bit values using the following 
layout: 

 3 3 2 2 2 2 2 2 2 2 2 2 1 1 1 1 1 1 1 1 1 1 

 1 0 9 8 7 6 5 4 3 2 1 0 9 8 7 6 5 4 3 2 1 0 9 8 7 6 5 4 3 2 1 0 

+---+-+-+-----------------------+-------------------------------+ 

|Sev|C|R|     Facility          |               Code            | 

+---+-+-+-----------------------+-------------------------------+ 

 

where 

Sev       - is the severity code: 

       00 - Success 

       01 - Informational 

       10 - Warning 

       11 - Error 

C         - is the Customer code flag 

R         - is a reserved bit 

Facility  - is the facility code 

Code      - is the facility's status code 

In this common error definition, several error code regions are already 
reserved by Windows® itself, the ODM and some other modules.  
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11.2 Overview Error Codes 
 
 

Overview Error Codes Range 

General Hardware Errors 
RCX Operating System 

RCX General Task: 0xC02B0001 to 0xC02B4D52 

RCX Common Status & Errors Codes: 0x00000000 to 0xC002000C 

RCX Status & Error Codes: 0x00000000 to 0xC0000008 

ODM Server General ODM Error Codes: 0x8004C700 to 0x8004C761 

General ODM Driver Error Codes: 0x8004C7A0 to 0x8004C7C2 

ODM Drivers cifX Driver Specific ODM Error: 0x8004C001 to 0x8004C0A4 

cifX Device Driver  
and netX Driver 

Generic Error: 0x800A0001 to 0x800A0017 

Generic Driver Error: 0x800B0001 bis0x800B0042 

Generic Device Error: 0x800C0010 bis0x800C0041 

netX Driver CIFX API Transport: 0x800D0001 to 0x800D0013 

CIFX API Transport Header State Error: 0x800E0001 to 0x800E000B 

DBM ODM Error Codes: 0xC004C810 to 0xC004C878 

Table 54: Overview Error Codes and Ranges 

 
 

 

The fieldbus specific error codes are described in the manuals of the 
corresponding protocol tasks. 
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11.3 General Hardware Error Codes 

11.3.1 RCX General Task Errors 
 

Error Code (Definition) Value Description 
RCX_E_QUE_UNKNOWN 0xC02B0001 Unknown Queue 
RCX_E_QUE_INDEX_UNKNOWN 0xC02B0002 Unknown Queue Index 
RCX_E_TASK_UNKNOWN 0xC02B0003 Unknown Task 
RCX_E_TASK_INDEX_UNKNOWN 0xC02B0004 Unknown Task Index 
RCX_E_TASK_HANDLE_INVALID 0xC02B0005 Invalid Task Handle 
RCX_E_TASK_INFO_IDX_UNKNOWN 0xC02B0006 Unknown Index 
RCX_E_FILE_XFR_TYPE_INVALID 0xC02B0007 Invalid Transfer Type 
RCX_E_FILE_REQUEST_INCORRECT 0xC02B0008 Invalid File Request  
RCX_E_TASK_INVALID 0xC02B000E Invalid Task 
RCX_E_SEC_FAILED 0xC02B001D Security EEPROM Access Failed 
RCX_E_EEPROM_DISABLED 0xC02B001E EEPROM Disabled 
RCX_E_INVALID_EXT 0xC02B001F Invalid Extension 
RCX_E_SIZE_OUT_OF_RANGE 0xC02B0020 Block Size Out Of Range 
RCX_E_INVALID_CHANNEL 0xC02B0021 Invalid Channel 
RCX_E_INVALID_FILE_LEN 0xC02B0022 Invalid File Length 
RCX_E_INVALID_CHAR_FOUND 0xC02B0023 Invalid Character Found 
RCX_E_PACKET_OUT_OF_SEQ 0xC02B0024 Packet Out Of Sequence 
RCX_E_SEC_NOT_ALLOWED 0xC02B0025 Not Allowed In Current State 
RCX_E_SEC_INVALID_ZONE 0xC02B0026 Security EEPROM Invalid Zone 
RCX_E_SEC_EEPROM_NOT_AVAIL 0xC02B0028 Security EEPROM Eeprom Not Available 
RCX_E_SEC_INVALID_CHECKSUM 0xC02B0029 Security EEPROM Invalid Checksum 
RCX_E_SEC_ZONE_NOT_WRITEABLE 0xC02B002A Security EEPROM Zone Not Writeable 
RCX_E_SEC_READ_FAILED 0xC02B002B Security EEPROM Read Failed 
RCX_E_SEC_WRITE_FAILED 0xC02B002C Security EEPROM Write Failed 
RCX_E_SEC_ACCESS_DENIED 0xC02B002D Security EEPROM Access Denied 
RCX_E_SEC_EEPROM_EMULATED 0xC02B002E Security EEPROM Emulated 
RCX_E_INVALID_BLOCK 0xC02B0038 Invalid Block 
RCX_E_INVALID_STRUCT_NUMBER 0xC02B0039 Invalid Structure Number 
RCX_E_INVALID_CHECKSUM 0xC02B4352 Invalid Checksum 
RCX_E_CONFIG_LOCKED 0xC02B4B54 Configuration Locked 
RCX_E_SEC_ZONE_NOT_READABLE 0xC02B4D52 Security EEPROM Zone Not Readable 

Table 55: RCX General Task Errors 
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11.3.2 RCX Common Status & Errors Codes 
 

Error Code (Definition) Value Description 
RCX_S_OK 0x00000000 Success, Status Okay 
RCX_E_FAIL 0xC0000001 Fail 
RCX_E_UNEXPECTED 0xC0000002 Unexpected 
RCX_E_OUTOFMEMORY 0xC0000003 Out Of Memory 
RCX_E_UNKNOWN_COMMAND 0xC0000004 Unknown Command 
RCX_E_UNKNOWN_DESTINATION 0xC0000005 Unknown Destination 
RCX_E_UNKNOWN_DESTINATION_ID 0xC0000006 Unknown Destination ID 
RCX_E_INVALID_PACKET_LEN 0xC0000007 Invalid Packet Length 
RCX_E_INVALID_EXTENSION 0xC0000008 Invalid Extension 
RCX_E_INVALID_PARAMETER 0xC0000009 Invalid Parameter 
RCX_E_WATCHDOG_TIMEOUT 0xC000000C Watchdog Timeout 
RCX_E_INVALID_LIST_TYPE 0xC000000D Invalid List Type 
RCX_E_UNKNOWN_HANDLE 0xC000000E Unknown Handle 
RCX_E_PACKET_OUT_OF_SEQ 0xC000000F Out Of Sequence 
RCX_E_PACKET_OUT_OF_MEMORY 0xC0000010 Out Of Memory 
RCX_E_QUE_PACKETDONE 0xC0000011 Queue Packet Done 
RCX_E_QUE_SENDPACKET 0xC0000012 Queue Send Packet 
RCX_E_POOL_PACKET_GET 0xC0000013 Pool Packet Get 
RCX_E_POOL_GET_LOAD 0xC0000015 Pool Get Load 
RCX_E_REQUEST_RUNNING 0xC000001A Request Already Running 
RCX_E_INIT_FAULT 0xC0000100 Initialization Fault 
RCX_E_DATABASE_ACCESS_FAILED 0xC0000101 Database Access Failed 
RCX_E_NOT_CONFIGURED 0xC0000119 Not Configured 
RCX_E_CONFIGURATION_FAULT 0xC0000120 Configuration Fault 
RCX_E_INCONSISTENT_DATA_SET 0xC0000121 Inconsistent Data Set 
RCX_E_DATA_SET_MISMATCH 0xC0000122 Data Set Mismatch 
RCX_E_INSUFFICIENT_LICENSE 0xC0000123 Insufficient License 
RCX_E_PARAMETER_ERROR 0xC0000124 Parameter Error 
RCX_E_INVALID_NETWORK_ADDRESS 0xC0000125 Invalid Network Address 
RCX_E_NO_SECURITY_MEMORY 0xC0000126 No Security Memory 
RCX_E_NETWORK_FAULT 0xC0000140 Network Fault 
RCX_E_CONNECTION_CLOSED 0xC0000141 Connection Closed 
RCX_E_CONNECTION_TIMEOUT 0xC0000142 Connection Timeout 
RCX_E_LONELY_NETWORK 0xC0000143 Lonely Network 
RCX_E_DUPLICATE_NODE 0xC0000144 Duplicate Node 
RCX_E_CABLE_DISCONNECT 0xC0000145 Cable Disconnected 
RCX_E_BUS_OFF 0xC0000180 Network Node Bus Off 
RCX_E_CONFIG_LOCKED 0xC0000181 Configuration Locked 
RCX_E_APPLICATION_NOT_READY 0xC0000182 Application Not Ready 
RCX_E_TIMER_APPL_PACKET_SENT 0xC002000C Timer App Packet Sent 

Table 56: RCX Common Status & Errors Codes 
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11.3.3 RCX Status & Error Codes 
 

Error Code (Definition) Value Description 
RCX_S_OK  0x00000000 SUCCESS, STATUS OKAY  
RCX_S_QUE_UNKNOWN  0xC02B0001 UNKNOWN QUEUE  
RCX_S_QUE_INDEX_UNKNOWN  0xC02B0002 UNKNOWN QUEUE INDEX 
RCX_S_TASK_UNKNOWN 0xC02B0003 UNKNOWN TASK  
RCX_S_TASK_INDEX_UNKNOWN 0xC02B0004 UNKNOWN TASK INDEX  
RCX_S_TASK_HANDLE_INVALID 0xC02B0005 INVALID TASK HANDLE  
RCX_S_TASK_INFO_IDX_UNKNOWN 0xC02B0006 UNKNOWN INDEX  
RCX_S_FILE_XFR_TYPE_INVALID 0xC02B0007 INVALID TRANSFER TYPE  
RCX_S_FILE_REQUEST_INCORRECT 0xC02B0008 INVALID FILE REQUEST  
RCX_S_UNKNOWN_DESTINATION 0xC0000005 UNKNOWN DESTINATION  
RCX_S_UNKNOWN_DESTINATION_ID 0xC0000006 UNKNOWN DESTINATION ID  
RCX_S_INVALID_LENGTH 0xC0000007 INVALID LENGTH  
RCX_S_UNKNOWN_COMMAND 0xC0000004 UNKNOWN COMMAND  
RCX_S_INVALID_EXTENSION 0xC0000008 INVALID EXTENSION  

Table 57: RCX Status & Error Codes 

 

11.3.3.1 RCX Status & Error Codes Slave State 
 

Error Code (Definition) Value Description 
RCX_SLAVE_STATE_UNDEFINED 0x00000000 UNDEFINED 
RCX_SLAVE_STATE_OK 0x00000001 OK 
RCX_SLAVE_STATE_FAILED 0x00000002 FAILED (at least one slave) 

Table 58: RCX Status & Error Codes Slave State 
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11.4 ODM Error Codes 
 

11.4.1 General ODM Error Codes 
 

Error Code (Definition) Value Description 

CODM3_E_INTERNALERROR 0x8004C700 Internal ODM Error 

ODM3_E_DESCRIPTION_NOTFOUND 0x8004C701 Description not found in ODM database 

CODM3_E_WRITEREGISTRY 0x8004C710 Error writing to the registry 

CODM3_E_BAD_REGULAR_EXPRESSION 0x8004C711 Invalid regular expression 

CODM3_E_COMCATEGORIE_MANAGER_ 
FAILED 

0x8004C712 Component Category Manager could not 
be instantiated 

CODM3_E_COMCATEGORIE_ENUMERATION_
FAILED 

0x8004C713 Driver could not be enumerated by the 
Category Manager 

CODM3_E_CREATE_LOCAL_BUFFER 0x8004C714 Error creating local buffers 

CODM3_E_UNKNOWNHANDLE 0x8004C715 Unknown handle 

CODM3_E_QUEUE_LIMIT_REACHED 0x8004C717 Queue size limit for connection reached 

CODM3_E_DATASIZE_ZERO 0x8004C718 Zero data length passed 

CODM3_E_INVALID_DATA 0x8004C719 Invalid data content 

CODM3_E_INVALID_MODE 0x8004C71A Invalid mode 

CODM3_E_DATABASE_READ 0x8004C71B Error reading database 

CODM3_E_CREATE_DEVICE_THREAD 0x8004C750 Error creating device thread 

CODM3_E_CREATE_DEVICE_THREAD_STOP_
EVENT 

0x8004C751 Error creating device thread stop event 

CODM3_E_CLIENT_NOT_REGISTERED 0x8004C752 Client is not registered at the ODM 

CODM3_E_NO_MORE_CLIENTS 0x8004C753 Maximum number of clients reached 

CODM3_E_MAX_CLIENT_CONNECTIONS_ 
REACHED 

0x8004C754 Maximum number of client connections 
reached 

CODM3_E_ENTRY_NOT_FOUND 0x8004C755 Driver/device not found 

CODM3_E_DRIVER_NOT_FOUND 0x8004C757 The requested driver is unknown to the 
ODM 

CODM3_E_DEVICE_ALREADY_LOCKED 0x8004C758 Device is locked by another process 

CODM3_E_DEVICE_UNLOCKED_FAILED 0x8004C759 Device could not be unlocked, lock was 
set by another process 

CODM3_E_DEVICE_LOCK_NECCESSARY 0x8004C75A Operation requires a device lock to be set 

CODM3_E_DEVICE_SUBSCRIPTIONLIMIT 0x8004C75B Maximum number of servers registered for 
this device reached 

CODM3_E_DEVICE_NOTSUBSCRIBED 0x8004C75C Process is not registered as a server on 
this device 

CODM3_E_DEVICE_NO_MESSAGE 0x8004C75D No message available 

CODM3_E_TRANSFERTIMEOUT 0x8004C760 Message transfer timeout 

CODM3_E_MESSAGE_INSERVICE 0x8004C761 Message in service 

Table 59: ODM Error Codes - General ODM Error Codes 
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11.4.2 General ODM Driver Error Codes 
 

Error Code (Definition) Value Description 
CODM3_E_DRV_OPEN_DEVICE 0x8004C7A0 Packet type unsupported by driver 
CODM3_E_DRV_INVALID_IDENTIFIER 0x8004C7A1 Invalid device identifier 
CODM3_E_DRV_DEVICE_PARAMETERS_ 
MISMATCH 

0x8004C7A3 Parameters differ from requested device 

CODM3_E_DRV_BROWSE_NO_DEVICES 0x8004C7A4 No devices found 
CODM3_E_DRV_CREATE_DEVICE_INST 0x8004C7A5 Device instance could not be created 
CODM3_E_DRV_DEVICE_NOMORE_TX 0x8004C7A6 Device connection limit reached 
CODM3_E_DRV_DEVICE_DUPLICATE_TX 0x8004C7A7 Duplicate transmitter ID 
CODM3_E_DRV_DEVICE_NOT_CONFIGURED 0x8004C7A8 Device is not configured 
CODM3_E_DRV_DEVICE_COMMUNICATION 0x8004C7A9 Device communication error 
CODM3_E_DRV_DEVICE_NO_MESSAGE 0x8004C7AA No message available 
CODM3_E_DRV_DEVICE_NOT_READY 0x8004C7AB Device not ready 
CODM3_E_DRV_INVALIDCONFIGURATION 0x8004C7AC Invalid driver configuration 
CODM3_E_DRV_DLINVALIDMODE 0x8004C7C0 Invalid download mode 
CODM3_E_DRV_DLINPROGRESS 0x8004C7C1 Download is active 
CODM3_E_DRV_ULINPROGRESS 0x8004C7C2 Upload is active 

Table 60: ODM Error Codes - General ODM Driver Error Codes 
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11.4.3 cifX Driver Specific ODM Error Codes 
 

 

cifX Driver Specific ODM Error Codes 
Error Code (Definition) Value Description 
DRV_E_BOARD_NOT_INITIALIZED 0x8004C001 DRIVER Board not initialized 
DRV_E_INIT_STATE_ERROR 0x8004C002 DRIVER Error in internal init state 
DRV_E_READ_STATE_ERROR 0x8004C003 DRIVER Error in internal read state 
DRV_E_CMD_ACTIVE 0x8004C004 DRIVER Command on this channel is 

active 
DRV_E_PARAMETER_UNKNOWN 0x8004C005 DRIVER Unknown parameter in function 
DRV_E_WRONG_DRIVER_VERSION 0x8004C006 DRIVER Version is incompatible with DLL 
DRV_E_PCI_SET_CONFIG_MODE 0x8004C007 DRIVER Error during PCI set configuration 

mode 

DRV_E_PCI_READ_DPM_LENGTH 0x8004C008 DRIVER Could not read PCI dual port 
memory length 

DRV_E_PCI_SET_RUN_MODE 0x8004C009 DRIVER Error during PCI set run mode 
DRV_E_DEV_DPM_ACCESS_ERROR 0x8004C00A DEVICE Dual port ram not 

accessable(board not found) 
DRV_E_DEV_NOT_READY 0x8004C00B DEVICE Not ready (ready flag failed) 
DRV_E_DEV_NOT_RUNNING 0x8004C00C DEVICE Not running (running flag failed) 
DRV_E_DEV_WATCHDOG_FAILED 0x8004C00D DEVICE Watchdog test failed 
DRV_E_DEV_OS_VERSION_ERROR 0x8004C00E DEVICE Signals wrong OS version 
DRV_E_DEV_SYSERR 0x8004C00F DEVICE Error in dual port flags 
DRV_E_DEV_MAILBOX_FULL 0x8004C010 DEVICE Send mailbox is full 
DRV_E_DEV_PUT_TIMEOUT 0x8004C011 DEVICE PutMessage timeout 
DRV_E_DEV_GET_TIMEOUT 0x8004C012 DEVICE GetMessage timeout 
DRV_E_DEV_GET_NO_MESSAGE 0x8004C013 DEVICE No message available 
DRV_E_DEV_RESET_TIMEOUT 0x8004C014 DEVICE RESET command timeout 
DRV_E_DEV_NO_COM_FLAG 0x8004C015 DEVICE COM-flag not set. Check if Bus is 

running 
DRV_E_DEV_EXCHANGE_FAILED 0x8004C016 DEVICE I/O data exchange failed 
DRV_E_DEV_EXCHANGE_TIMEOUT 0x8004C017 DEVICE I/O data exchange timeout 
DRV_E_DEV_COM_MODE_UNKNOWN 0x8004C018 DEVICE I/O data mode unknown 
DRV_E_DEV_FUNCTION_FAILED 0x8004C019 DEVICE Function call failed 
DRV_E_DEV_DPMSIZE_MISMATCH 0x8004C01A DEVICE DPM size differs from 

configuration 
DRV_E_DEV_STATE_MODE_UNKNOWN 0x8004C01B DEVICE State mode unknown 
DRV_E_DEV_HW_PORT_IS_USED 0x8004C01C DEVICE Output port already in use 
DRV_E_USR_OPEN_ERROR 0x8004C01E USER Driver not opened (device driver not 

loaded) 
DRV_E_USR_INIT_DRV_ERROR 0x8004C01F USER Can't connect to device 
DRV_E_USR_NOT_INITIALIZED 0x8004C020 USER Board not initialized (DevInitBoard 

not called) 
DRV_E_USR_COMM_ERR 0x8004C021 USER IOCTRL function failed 
DRV_E_USR_DEV_NUMBER_INVALID 0x8004C022 USER Parameter DeviceNumber invalid 
DRV_E_USR_INFO_AREA_INVALID 0x8004C023 USER Parameter InfoArea unknown 
DRV_E_USR_NUMBER_INVALID 0x8004C024 USER Parameter Number invalid 
DRV_E_USR_MODE_INVALID 0x8004C025 USER Parameter Mode invalid 
DRV_E_USR_MSG_BUF_NULL_PTR 0x8004C026 USER NULL pointer assignment 
DRV_E_USR_MSG_BUF_TOO_SHORT 0x8004C027 USER Message buffer too small 
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cifX Driver Specific ODM Error Codes 
Error Code (Definition) Value Description 
DRV_E_USR_SIZE_INVALID 0x8004C028 USER Parameter Size invalid 
DRV_E_USR_SIZE_ZERO 0x8004C02A USER Parameter Size with zero length 
DRV_E_USR_SIZE_TOO_LONG 0x8004C02B USER Parameter Size too long 
DRV_E_USR_DEV_PTR_NULL 0x8004C02C USER Device address null pointer 
DRV_E_USR_BUF_PTR_NULL 0x8004C02D USER Pointer to buffer is a null pointer 
DRV_E_USR_SENDSIZE_TOO_LONG 0x8004C02E USER Parameter SendSize too large 
DRV_E_USR_RECVSIZE_TOO_LONG 0x8004C02F USER Parameter ReceiveSize too large 
DRV_E_USR_SENDBUF_PTR_NULL 0x8004C030 USER Pointer to send buffer is a null 

pointer 
DRV_E_USR_RECVBUF_PTR_NULL 0x8004C031 USER Pointer to receive buffer is a null 

pointer 

DRV_E_DMA_INSUFF_MEM 0x8004C032 DMA Memory allocation error 
DRV_E_DMA_TIMEOUT_CH4 0x8004C033 DMA Read I/O timeout 
DRV_E_DMA_TIMEOUT_CH5 0x8004C034 DMA Write I/O timeout 
DRV_E_DMA_TIMEOUT_CH6 0x8004C035 DMA PCI transfer timeout 
DRV_E_DMA_TIMEOUT_CH7 0x8004C036 DMA Download timeout 
DRV_E_DMA_DB_DOWN_FAIL 0x8004C037 DMA Database download failed 
DRV_E_DMA_FW_DOWN_FAIL 0x8004C038 DMA Firmware download failed 
DRV_E_CLEAR_DB_FAIL 0x8004C039 DMA Clear database on the device failed 
DRV_E_DEV_NO_VIRTUAL_MEM 0x8004C03C DMA USER Virtual memory not available 
DRV_E_DEV_UNMAP_VIRTUAL_MEM 0x8004C03D DMA USER Unmap virtual memory failed 
DRV_E_GENERAL_ERROR 0x8004C046 DRIVER General error 
DRV_E_DMA_ERROR 0x8004C047 DRIVER General DMA error 
DRV_E_WDG_IO_ERROR 0x8004C048 DRIVER I/O WatchDog failed 
DRV_E_WDG_DEV_ERROR 0x8004C049 DRIVER Device Watchdog failed 
DRV_E_USR_DRIVER_UNKNOWN 0x8004C050 USER Driver unknown 
DRV_E_USR_DEVICE_NAME_INVALID 0x8004C051 USER Device name invalid 
DRV_E_USR_DEVICE_NAME_UKNOWN 0x8004C052 USER Device name unknown 

DRV_E_USR_DEVICE_FUNC_NOTIMPL 0x8004C053 USER Device function not implemented 

DRV_E_USR_FILE_OPEN_FAILED 0x8004C064 USER File could not be opened 

DRV_E_USR_FILE_SIZE_ZERO 0x8004C065 USER File size zero 

DRV_E_USR_FILE_NO_MEMORY 0x8004C066 USER Not enough memory to load file 

DRV_E_USR_FILE_READ_FAILED 0x8004C067 USER File read failed 

DRV_E_USR_INVALID_FILETYPE 0x8004C068 USER File type invalid 

DRV_E_USR_FILENAME_INVALID 0x8004C069 USER Invalid filename 

DRV_E_FW_FILE_OPEN_FAILED 0x8004C06E USER Firmware file could not be opened 

DRV_E_FW_FILE_SIZE_ZERO 0x8004C06F USER Not enough memory to load 
firmware file 

DRV_E_FW_FILE_NO_MEMORY 0x8004C070 USER Not enough memory to load 
firmware file 

DRV_E_FW_FILE_READ_FAILED 0x8004C071 USER Firmware file read failed 

DRV_E_FW_INVALID_FILETYPE 0x8004C072 USER Firmware file type invalid 

DRV_E_FW_FILENAME_INVALID 0x8004C073 USER Firmware file name not valid 

DRV_E_FW_DOWNLOAD_ERROR 0x8004C074 USER Firmware file download error 

DRV_E_FW_FILENAME_NOT_FOUND 0x8004C075 USER Firmware file not found in the 
internal table 

DRV_E_FW_BOOTLOADER_ACTIVE 0x8004C076 USER Firmware file BOOTLOADER active 
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cifX Driver Specific ODM Error Codes 
Error Code (Definition) Value Description 
DRV_E_FW_NO_FILE_PATH 0x8004C077 USER Firmware file no file path 

DRV_E_CF_FILE_OPEN_FAILED 0x8004C078 USER Configuration file could not be 
opend 

DRV_E_CF_FILE_SIZE_ZERO 0x8004C079 USER Configuration file size zero 

DRV_E_CF_FILE_NO_MEMORY 0x8004C07A USER Not enough memory to load 
configuration file 

DRV_E_CF_FILE_READ_FAILED 0x8004C07B USER Configuration file read failed 

DRV_E_CF_INVALID_FILETYPE 0x8004C07C USER Configuration file type invalid 

DRV_E_CF_FILENAME_INVALID 0x8004C07D USER Configuration file name not valid 

DRV_E_CF_DOWNLOAD_ERROR 0x8004C07E USER Configuration file download error 

DRV_E_CF_FILE_NO_SEGMENT 0x8004C07F USER No flash segment in the 
configuration file 

DRV_E_CF_DIFFERS_FROM_DBM 0x8004C080 USER Configuration file differs from 
database 

DRV_E_DBM_SIZE_ZERO 0x8004C083 USER Database size zero 

DRV_E_DBM_NO_MEMORY 0x8004C084 USER Not enough memory to upload 
database 

DRV_E_DBM_READ_FAILED 0x8004C085 USER Database read failed 

DRV_E_DBM_NO_FLASH_SEGMENT 0x8004C086 USER Database segment unknown 

DEV_E_CF_INVALID_DESCRIPT_VERSION 0x8004C096 CONFIG Version of the descript table 
invalid 

DEV_E_CF_INVALID_INPUT_OFFSET 0x8004C097 CONFIG Input offset is invalid 

DEV_E_CF_NO_INPUT_SIZE 0x8004C098 CONFIG Input size is 0 

DEV_E_CF_MISMATCH_INPUT_SIZE 0x8004C099 CONFIG Input size does not match 
configuration 

DEV_E_CF_INVALID_OUTPUT_OFFSET 0x8004C09A CONFIG Invalid output offset 

DEV_E_CF_NO_OUTPUT_SIZE 0x8004C09B CONFIG Output size is 0 

DEV_E_CF_MISMATCH_OUTPUT_SIZE 0x8004C09C CONFIG Output size does not match 
configuration 

DEV_E_CF_STN_NOT_CONFIGURED 0x8004C09D CONFIG Station not configured 

DEV_E_CF_CANNOT_GET_STN_CONFIG 0x8004C09E CONFIG Cannot get the Station 
configuration 

DEV_E_CF_MODULE_DEF_MISSING 0x8004C09F CONFIG Module definition is missing 

DEV_E_CF_MISMATCH_EMPTY_SLOT 0x8004C0A0 CONFIG Empty slot mismatch 

DEV_E_CF_MISMATCH_INPUT_OFFSET 0x8004C0A1 CONFIG Input offset mismatch 

DEV_E_CF_MISMATCH_OUTPUT_OFFSET 0x8004C0A2 CONFIG Output offset mismatch 

DEV_E_CF_MISMATCH_DATA_TYPE 0x8004C0A3 CONFIG Data type mismatch 

DEV_E_CF_MODULE_DEF_MISSING_NO_SI 0x8004C0A4 CONFIG Module definition is missing,(no 
Slot/Idx) 

Table 61: cifX Driver Specific ODM Error Codes 
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11.5 Error Codes cifX Device Driver and netX Driver 
 

11.5.1 Generic Error Codes 
 

 
Error Code 
(Definition) 

Value Description 

CIFX_INVALID_POINTER  0x800A0001L Invalid pointer (NULL) passed to driver 
CIFX_INVALID_BOARD  0x800A0002L No board with the given nameindex 

available 
CIFX_INVALID_CHANNEL  0x800A0003L No channel with the given index 

available 
CIFX_INVALID_HANDLE 0x800A0004L Invalid handle passed to driver 
CIFX_INVALID_PARAMETER  0x800A0005L Invalid parameter 
CIFX_INVALID_COMMAND 0x800A0006L Invalid command 
CIFX_INVALID_BUFFERSIZE  0x800A0007L Invalid buffer size 
CIFX_INVALID_ACCESS_SIZE 0x800A0008L Invalid access size 
CIFX_FUNCTION_FAILED  0x800A0009L Function failed 
CIFX_FILE_OPEN_FAILED  0x800A000AL File could not be opened 
CIFX_FILE_SIZE_ZERO 0x800A000BL File size is zero 
CIFX_FILE_LOAD_INSUFF_MEM  0x800A000CL Insufficient memory to load file 
CIFX_FILE_CHECKSUM_ERROR  0x800A000DL File checksum compare failed 
CIFX_FILE_READ_ERROR  0x800A000EL Error reading from file 
CIFX_FILE_TYPE_INVALID  0x800A000FL Invalid file type 
CIFX_FILE_NAME_INVALID 0x800A0010L Invalid file name 
CIFX_FUNCTION_NOT_AVAILABLE 0x800A0011L Driver function not available 
CIFX_BUFFER_TOO_SHORT 0x800A0012L Given buffer is too short 
CIFX_MEMORY_MAPPING_FAILED  0x800A0013L Failed to map the memory 
CIFX_NO_MORE_ENTRIES 0x800A0014L No more entries available 
CIFX_CALLBACK_MODE_UNKNOWN  0x800A0015L Unkown callback handling mode 
CIFX_CALLBACK_CREATE_EVENT_FAILED  0x800A0016L Failed to create callback events 
CIFX_CALLBACK_CREATE_RECV_BUFFER  0x800A0017L Failed to create callback receive buffer 

Table 62: Generic Error Codes 
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11.5.2 Generic Driver Error Codes 
 

Error Code (Definition) Value Description 
CIFX_DRV_NOT_INITIALIZED  0x800B0001L Driver not initialized 
CIFX_DRV_INIT_STATE_ERROR 0x800B0002L Driver init state error 
CIFX_DRV_READ_STATE_ERROR 0x800B0003L Driver read state error 
CIFX_DRV_CMD_ACTIVE 0x800B0004L Command is active on device 
CIFX_DRV_DOWNLOAD_FAILED  0x800B0005L General error during download 
CIFX_DRV_WRONG_DRIVER_VERSION 0x800B0006L Wrong driver version 
CIFX_DRV_DRIVER_NOT_LOADED  0x800B0030L CIFx driver is not running 
CIFX_DRV_INIT_ERROR 0x800B0031L Failed to initialize the device 
CIFX_DRV_CHANNEL_NOT_INITIALIZED  0x800B0032L Channel not initialized (xOpenChannel 

not called) 
CIFX_DRV_IO_CONTROL_FAILED  0x800B0033L IOControl call failed 
CIFX_DRV_NOT_OPENED( 0x800B0034L Driver was not opened 
CIFX_DRV_DOWNLOAD_STORAGE_UNKN
OWN 

0x800B0040L Unknown download storage type 
(RAMFLASH based) found 

CIFX_DRV_DOWNLOAD_FW_WRONG_CHA
NNEL 

0x800B0041L Channel number for a firmware 
download not supported 

CIFX_DRV_DOWNLOAD_MODULE_NO_BAS
EOS  

0x800B0042L Modules are not allowed without a Base 
OS firmware 

Table 63: Generic Driver Error Codes 
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11.5.3 Generic Device Error Codes 
 

Error Code (Definition) Value Description 
CIFX_DEV_DPM_ACCESS_ERROR 0x800C0010L Dual port memory not accessable 

(board not found) 
CIFX_DEV_NOT_READY  0x800C0011L Device not ready (ready flag failed) 
CIFX_DEV_NOT_RUNNING  0x800C0012L Device not running (running flag failed) 
CIFX_DEV_WATCHDOG_FAILED  0x800C0013L Watchdog test failed 
CIFX_DEV_SYSERR 0x800C0015L Error in handshake flags 
CIFX_DEV_MAILBOX_FULL 0x800C0016L Send mailbox is full 
CIFX_DEV_PUT_TIMEOUT  0x800C0017L Send packet timeout 
CIFX_DEV_GET_TIMEOUT  0x800C0018L Receive packet timeout 
CIFX_DEV_GET_NO_PACKET  0x800C0019L No packet available 
CIFX_DEV_MAILBOX_TOO_SHORT  0x800C001AL Mailbox too short 
CIFX_DEV_RESET_TIMEOUT  0x800C0020L Reset command timeout 
CIFX_DEV_NO_COM_FLAG  0x800C0021L COM-flag not set 
CIFX_DEV_EXCHANGE_FAILED  0x800C0022L IO data exchange failed 
CIFX_DEV_EXCHANGE_TIMEOUT 0x800C0023L IO data exchange timeout 
CIFX_DEV_COM_MODE_UNKNOWN 0x800C0024L Unknown IO exchange mode 
CIFX_DEV_FUNCTION_FAILED  0x800C0025L Device function failed 
CIFX_DEV_DPMSIZE_MISMATCH 0x800C0026L DPM size differs from configuration 
CIFX_DEV_STATE_MODE_UNKNOWN 0x800C0027L Unknown state mode 
CIFX_DEV_HW_PORT_IS_USED  0x800C0028L Device is still accessed 
CIFX_DEV_CONFIG_LOCK_TIMEOUT  0x800C0029L Configuration locking timeout 
CIFX_DEV_CONFIG_UNLOCK_TIMEOUT  0x800C002AL Configuration unlocking timeout 
CIFX_DEV_HOST_STATE_SET_TIMEOUT 0x800C002BL Set HOST state timeout 
CIFX_DEV_HOST_STATE_CLEAR_TIMEOUT  0x800C002CL Clear HOST state timeout 
CIFX_DEV_INITIALIZATION_TIMEOUT 0x800C002DL Timeout during channel initialization 
CIFX_DEV_BUS_STATE_ON_TIMEOUT 0x800C002EL Set Bus ON Timeout 
CIFX_DEV_BUS_STATE_OFF_TIMEOUT  0x800C002FL Set Bus OFF Timeout 
CIFX_DEV_MODULE_ALREADY_RUNNING 0x800C0040L Module already running 
CIFX_DEV_MODULE_ALREADY_EXISTS  0x800C0041L Module already exists 

Table 64: Generic Device Error Codes 
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11.6 Error Codes netX Driver 
 

11.6.1 CIFX API Transport Error Codes 
 

Error Code (Definition) Value Description 
CIFX_TRANSPORT_SEND_TIMEOUT 0x800D0001L Time out while sending data 
CIFX_TRANSPORT_RECV_TIMEOUT 0x800D0002L Time out waiting for incoming data 
CIFX_TRANSPORT_CONNECT  0x800D0003L Unable to communicate to the deviceno 

answer 
CIFX_TRANSPORT_ABORTED  0x800D0004L Transfer has been aborted due to keep 

alive timeout or interface detachment 
CIFX_CONNECTOR_FUNCTIONS_READ_ERR
OR  

0x800D0010L Error reading the connector functions 
from the DLL 

CIFX_CONNECTOR_IDENTIFIER_TOO_LONG  0x800D0011L Connector delivers an identifier longer 
than 6 characters 

CIFX_CONNECTOR_IDENTIFIER_EMPTY 0x800D0012L Connector delivers an empty dentifier 
CIFX_CONNECTOR_DUPLICATE_IDENTIFIER  0x800D0013L Connector identifier already used 

Table 65: CIFX API Transport Error Codes 

 

 

11.6.2 CIFX API Transport Header State Error Codes 
 
Error Code 
(Definition) 

Value Description 

CIFX_TRANSPORT_ERROR_UNKNOWN  0x800E0001 Unknown error code in transport header 
CIFX_TRANSPORT_CHECKSUM_ERROR 0x800E0002 CRC16 checksum failed 
CIFX_TRANSPORT_LENGTH_INCOMPLETE  0x800E0003 Transaction with inclomplete length 

detected 
CIFX_TRANSPORT_DATA_TYPE_UNKOWN 0x800E0004 Device does not support requested data 

type 
CIFX_TRANSPORT_DEVICE_UNKNOWN 0x800E0005 Device not availableunknown 
CIFX_TRANSPORT_CHANNEL_UNKNOWN  0x800E0006 Channel not availableunknown 
CIFX_TRANSPORT_SEQUENCE 0x800E0007 Sequence error detected 
CIFX_TRANSPORT_BUFFEROVERFLOW 0x800E0008 Buffer overflow detected 
CIFX_TRANSPORT_RESOURCE 0x800E0009 Device signals out of resources 
CIFX_TRANSPORT_KEEPALIVE  0x800E000A Device connection monitoring error (Keep 

alive) 
CIFX_TRANSPORT_DATA_TOO_SHORT( 0x800E000B Received transaction data too short 

Table 66: CIFX API Transport Header State Error Codes 
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11.7 ODM Error Codes DBM V4 
 

 

ODM Error Codes DBM V4 
Error Code (Definition) Value Description 
CDBM_E_MD5_INVALID 0XC004C810 Checksum invalid 
CDBM_E_INTERNALERROR 0XC004C811 Internal Error 
CDBM_W_WRITEREGISTRY 0X8004C812 Error writing to the registry 
CDBM_E_UNEXPECTED_VALUE_ 
IN_OLD_HEADER_FORMAT 

0XC004C813 Error in a file containing the old DBM 
Header format. 

CDBM_E_CHECKSUM_INVALID 0XC004C814 The Checksum of the old Header is invalid 
CDBM_E_DB_ALREADY_LOADED_ FORMAT 0XC004C815 A database is already loaded 
CDBM_E_NO_VALID_TRANSACTION 0XC004C816 No valid transaction handle given 
CDBM_E_STD_STRUCT_ERROR 0XC004C817 An error occurred during validation of data 
CDBM_E_UNSUPPORTED_ 
DATA_TYPE_FORMAT 

0XC004C818 Unsupported DataType 

CDBM_W_CLASS_DELETED_ FORMAT 0X8004C819 
(Warning) 

Using an Object which is marked as 
deleted 

CDBM_W_CLIENT_DISCONNECTED 0X8004C81A 
(Warning) 

A Client has already an outstanding 
connection to a Table. The connection is 
now destroyed. 

CDBM_E_STRUCTURE_DEFINITION_ INVALID 0XC004C81B A structure definition of an Element in a 
Table is invalid 

CDBM_E_NO_DATA_AVAILABLE 0XC004C81C No data available for this operation 
CDBM_E_NO_VALID_STRUCTURE 0XC004C81D No valid structure available for this 

operation 
CDBM_E_NO_TOGGLE_STRING_ FOUND 0XC004C81E No Toggle string found for this number 
CDBM_E_ELEMENT_OUT_OF_RANGE 0XC004C81F An element wasn’t found in the Record of 

a Table 
CDBM_E_ELEMENT_NOT_IN_ TABLE 0XC004C820 The element is not part of the Table 
CDBM_E_CANNOT_CONVERT_ 
INTO_CLIENT_TYPE 

0XC004C821 The data can't be converted into the Client 
type 

CDBM_E_TRANSACTION_ ALREADY_OPEN 0XC004C822 A transaction is already open. Please 
close this one first before opening a new 
one. 

CDBM_I_OLD_WITHOUT_HEADER 0X4004C823 
(Informational) 

Use of an old DBM file Format without 
Header 

CDBM_E_HR_FROM 0XC004C824 An HRESULT was received from a 
Subroutine 

CDBM_E_PARAMETER 0XC004C825 A Parameter is invalid 
CDBM_E_NOTIMPL 0XC004C826 Method is currently not implemented 
CDBM_E_OUTOFMEMORY 0XC004C827 Out of memory 
CDBM_E_NO_OPEN_TRANSACTION 0XC004C828 No transaction open 
CDBM_E_NO_CONTENTS 0XC004C829 No contents available 
CDBM_REC_NO_NOT_FOUND 0XC004C82A Record not found 
CDBM_STRUCTURE_ELEMENT_ NOT_FOUND 0XC004C82B Element of the Structure not found 
CDBM_E_NO_MORE_RECORDS_ IN_TABTYPE 0XC004C82C Table type 3 can contain only one record 
CDBM_E_WRITE 0XC004C82D The data in the VARIANT must be given in 

a SafeArray 
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ODM Error Codes DBM V4 
Error Code (Definition) Value Description 
CDBM_E_WRITE_NO_PARRAY 0XC004C82E The VARIANT contains no valid [parray] 

element 
CDBM_E_WRITE_CANT_ ACCESS_DATA 0XC004C82F Unable to access SafeArray Data in the 

VARIANT 
CDBM_E_WRITE_DATA 0XC004C830 To write the data of this Element it must be 

given as a BSTR, or as an Array of 
VT_UI1/VT_I1 

CDBM_E_WRITE_BSTR_E1 0XC004C831 The BSTR string must have an even 
length. 

CDBM_E_WRITE_BSTR_E2 0XC004C832 The BSTR string must contain only hex 
digits (0..9 and a/A..f/F). 

CDBM_E_WRITE_CANT_ INTERPRET_ARRAY 0XC004C833 Unable to interpret data in the SafeArray. 
CDBM_E_WRITE_VT_ERROR 0XC004C834 Data type in the SafeArray is not VT_UI1 

or VT_I1. 
CDBM_E_WRITE_LENGTH 0XC004C835 Data length is invalid for write operation of 

this type. 
CDBM_WRITE_ELEMENT 0XC004C836 Element not found in the Record of the 

Table 
CDBM_MIN_MAX_ERROR 0XC004C837 Can't write data because of min underflow 

or max overflow 
CDBM_TABLE_EXIST 0XC004C838 Table already exist in the database 
CDBM_MIN_MAX_INVALID 0XC004C839 The Min value is greater than the Max 

Value 
CDBM_DEF_MIN_MAX_INVALID 0XC004C83A The Default Value is not in the range 

between the Min value and the Max Value 
CDBM_CANT_CHANGE_STRUCTURE_ 
WHILE_RECORDS_EXIST 

0XC004C83B It's not allowed to change the structure 
while Records exist in the Table 

CDBM_NEW_STRUCT_NEEDS_TYPE 0XC004C83C In a newly added structure the data type 
must be set also 

CDBM_VALUE_ERROR 0XC004C83D Range error while validating a value 
CDBM_DATATYPE_ UNSUPPORTED_IN_RCS 0XC004C83E The data type is unsupported in the RCS 

file format 
CDBM_I_COUNT_OF_TABLES_ 
EXCEEDS_RCS_RANGE 

0X4004C83F 
(Informational) 

The count of Tables exceeds the RCS 
range of Tables. This can cause problems 
if the file is downloaded to RCS Systems 

CDBM_I_COUNT_OF_TABLES_ 
EXCEEDS_OLDDBM_RANGE 

0X4004C840 
(Informational) 

The count of Tables exceeds the 
DBM32.DLL range of Tables. This can 
cause problems if the file is used with older 
Tools using the DBM32.DLL 

CDBM_UNSUPPORTED_DATATYPE_ 
IN_RCS_MODE 

0XC004C841 The Data type is not compatible with the 
old database format 

CDBM_WRITE_UNSTRUCTURED_1 0XC004C842 The data of an unstructured record can 
only be written with the 'Write' Method not 
with 'WriteElement'. 

CDBM_READ_UNSTRUCTURED_1 0XC004C843 The data of an unstructured record can 
only be read with the 'Read' Method not 
with 'ReadElement' 

CDBM_WRITE_DATA_LENGTH_ INVALID 0XC004C844 The given data length doesn’t correspond 
with the expected data length. 

CDBM_UNKNOWN_VIEW_MODE 0XC004C845 The View Mode is unknown. 
CDBM_E_DIAG_TABLE 0XC004C846 It doesn’t make much sense to add or 

delete records from a diagnostic table 
because those changes are never saved. 
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ODM Error Codes DBM V4 
Error Code (Definition) Value Description 
CDBM_E_ADR_STRING_ERROR 0XC004C847 The given Address string doesn’t fit the 

required format of this type where all 
address bytes must be in the range 
between 0 and FF 

CDBM_ERROR_FROM_VAR_ CHANGE_TYPE 0XC004C848 Function VariantChangeType return an 
error when trying to convert the Parameter 

CDBM_E_MINERROR 0XC004C849 Error while comparing the Value with the 
lower range 

CDBM_E_MAXERROR 0XC004C84A Error while comparing the Value with the 
upper range 

CDBM_E_RANGE_ERROR 0XC004C84B Value out of Range 
CDBM_E_TABLE_TYPE1 0XC004C84C Table type 1 doesn’t have a unique record 

length over all records 
CDBM_E_TABLE_TYPE3_ ADDREC 0XC004C84D Table type 3 doesn’t allow to insert more 

than one Record 
CDBM_E_TABTYPE1 0XC004C84E It's not allowed to insert more Records 

than structure definitions in Table Type 1 
CDBM_E_TOGGLE_NOT_FOUND 0XC004C84F Could not find the string for this value in 

the list of valid toggle strings 
CDBM_E_TOGGLE_VALUE_IS_ EMPTY_STRING 0XC004C850 The toggle string for this value is empty. 
CDBM_VARIANT2BYTEARRAY_ ERROR 0XC004C851 Error during conversion of Variant to byte 

array 
CDBM_E_SET_ELEM_PROP_ DEPENDENCY 0XC004C852 The Toggle Type needs also the additional 

string and the additional number  entries in 
the Method 

CDBM_E_TABTYPE1_REC_ 
DOESNT_CORRESPOND_ WITH_ELEMENT 

0XC004C853 When reading the records of Table type 1 
elementwise the record number must 
correspond with the element number 

CDBM_TABTYPE1_NO_DATA_ 
FOUND_FOR_RECORD 

0XC004C854 When reading the records of Table type 1 
and structure definitions are present it's 
assumed that for each structure element a 
corresponding record must exist 

CDBM_E_TABTYPE1_WRITE_ 
ELEMENT_NE_RECORD 

0XC004C855 When writing the records of Table type 1 
elementwise and structure definitions are 
present it's only allowed to write the 
corresponding element number in each 
record 

CDBM_E_TABTYPE1_WRITE_ 
ELEMENT_NOT_FOUND 

0XC004C856 When writing the records of Table type 1 
with an array and structure definitions are 
present it's assumed that a corresponding 
element number of this record exist 

CDBM_I_TABLE_NAME_EXCEEDS_ 
RCS_RANGE 

0X4004C857 
(Informational) 

The Table name exceeds the maximum 
length of RCS compatible Table names 

CDBM_W_CUT_STRING 0X8004C858 
(Warning) 

The string exceeds the maximum length 
and will be limited to the maximum length 

CDBM_I_STRING_TOO_SHORT 0X4004C859 
(Informational) 

The string is below the minimum length. 
The minimum length will be reduced. 

CDBM_I_STRING_TOO_LONG 0X4004C85A 
(Informational) 

The string is exceeding the maximum. The 
maximum length will be extended. 

CDBM_E_STRING_TOO_SHORT 0XC004C85B 
(Error) 

The string is below the minimum length. 

CDBM_E_STRING_TOO_LONG 0XC004C85C 
(Error) 

The string is exceeding the maximum 
length 
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ODM Error Codes DBM V4 
Error Code (Definition) Value Description 
CDBM_E_WRONG_TYPE_ FOR_WRITE 0XC004C85D Writing on the Element type with the given 

Data type is not implemented 
CDBM_E_NO_APPEND_IN_ 
STRUCTURED_RECORDS 

0XC004C85E Method IDbmRecord::AppendData is not 
allowed for structured records 

CDBM_E_DATA_UNAVAILABLE 0XC004C85F No data available 
CDBM_E_CANT_CONVERT_ INTO 0XC004C860 Unable to convert the value into the 

Element type 
CDBM_E_DBM_FILE_OVERFLOW 0XC004C861 You try to write a RCS like database which 

needs too much bytes 
CDBM_E_PW_ERROR 0XC004C862 Password not correct 
CDBM_E_FILELENGTH_CORRUPT 0XC004C863 The file length doesn’t correspond to the 

length given in the Header. 
CDBM_E_STRUCT_TYPE 0XC004C864 Error in the file. 
CDBM_E_MD5SUM_INVALID 0XC004C865 MD5 sum invalid 
CDBM_E_STRUCT_LENGTH 0XC004C866 Error in the expected and given structure 

length at a specific offset in the file. 
CDBM_E_APPEND 0XC004C867 Append of data is only allowed if the 

Record contains only one data field and 
the field type will support this 

CDBM_APPEND_NOT_ SUPPORTED 0XC004C868 Append of Data not supported by this filed 
type 

CDBM_DATA_TYPE_APPEND_ ERROR 0XC004C869 Can't append Data of this type. 
CDBM_E_UNSTRUCTURED_TABLE_ 
DOESNT_SUPPORT_LENGTH 

0XC004C86A A Table without structure information 
doesn’t support a record length 

CDBM_E_DISABLED_WHILE_ 
TRANSACTION_IS_OPEN 

0XC004C86B The Method is disabled while a transaction 
is open. Please close this one first and call 
the Method again. 

CDBM_E_UNABLE_TO_CALL_ 
READ_ON_LINKED_LIST 

0XC004C86C The Method is disabled on a LinkedList 
type. Please use the IRecordCollection on 
this type. 

CDBM_E_ELEMENT_HAS_NO_ 
SUBSTRUCTURE 

0XC004C86D An Element from a Table has no 
substructure 

CDBM_STRUCT_ERROR_FROM_ 
VAR_CHANGE_TYPE 

0XC004C86E Error from calling VariantChangeType 

CDBM_E_FOREIGNKEY_DEF 0XC004C86F The definition of a FOREIGNKEY must 
contain the name of the related Table in 
the description and this Table must exist at 
this time 

CDBM_E_FOREIGNKEY_ REF_TAB 0XC004C870 The description of a FOREIGNKEY must 
refer to a Table of type 
'eDbmTableTypeLinkedList' 

CDBM_E_KEY 0XC004C871 To create a Record Collection with a KEY 
it's necessary to have the data type KEY at 
the first position in all Records of the 
searched Table 

CDBM_E_KEY_TABLE_TYPE 0XC004C872 This Method needs a Table of type 
'eDbmTableTypeLinkedList' 

CDBM_DATATYPE_NOT_ IMPLEMENTED 0XC004C873 This data type is currently not implemented 
CDBM_INSERT_POS_NOT_ FOUND 0XC004C874 The position of the Record where the new 

one should be inserted wasn’t found 
CDBM_E_INSERT_REC_QI 0XC004C875 Error during insertion of a Record 
CDBM_E_TAB_PROP 0XC004C876 Invalid Property in Table 
CDBM_E_KEY_NOT_FOUND 0XC004C877 The KEY wasn’t found in the Table 



Error Codes 177/189 

DTM for Hilscher Sercos Slave Device | Configuration of Hilscher Slave Devices  
DOC110701OI05EN | Revision 5 | English | 2018-04 | Released | Public  © Hilscher, 2012-2018 

 

ODM Error Codes DBM V4 
Error Code (Definition) Value Description 
CDBM_E_KEY_INVALID 0XC004C878 The KEY is invalid for this operation 

Table 67: ODM Error Codes DBM V4 
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12 Appendix 
12.1 User Rights 

User-rights are set within the FDT-container. Depending on the level the 
configuration is accessible by the user or read-only. 

To access the Settings, Configuration, Device Description and 
Diagnosis panes of the Sercos Slave DTM you do not need special user 
rights. Also all users can select the decimal or hexadecimal Display mode 
or sort table entries. 
 

 
Note: To edit, set or configure the parameters of the Settings and 
Configuration panes, you need user rights for Maintenance, for Planning 
Engineer or for Administrator. 

 

The Device Description panes do not contain any editable elements. The 
indicated values in are only for information purposes. 

The following tables give an overview of the user right groups and which 
user rights you need to configure the single parameters. 
 

12.1.1 Settings 
 Observer Operator Maintenanc

e 
Planning 
Engineer 

Adminis-
trator 

Driver D D X X X 
 Verify or adapt Driver 
Settings  

- - X X X 

 Configuring netX Driver - - X X X 
Device Assignment D D X X X 
 Scanning for Devices - - X X X 
Selecting the Device (with or 
without firmware) 

- - X X X 

Selecting the Device once more 
(with Firmware) 

- - X X X 

Firmware Download D D X X X 

Table 68: Settings (D = Displaying, X = Editing, Configuring) 

 
 

12.1.2 Configuration 
 Observer Operator Maintenance Planning 

Engineer 
Administrator 

General D D X X X 
Electronic Label D D X X X 
Configuration D D X X X 
User-defined 
Parameters 

D D X X X 

FSP IO D D X X X 
FSP Drive D D X X X 

Table 69: Configuration (D = Displaying, X = Editing, Configuring) 
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12.5 Glossary 
AT 

Acknowledge Telegram  

(originally Antriebstelegramm which is the German expression for “Drive 
Telegram”)) 

The Acknowledge Telegram (AT) is a special telegram used for 
transmission of  real-time data from the slaves to the master and to other 
slave devices (if cross communication is used). The format of the AT is 
predefined within the specification of Sercos in the third generation. 

BOOTP 

Boot Protocol 

A protocol for automatic assignment of IP addresses to devices in a 
network. 

Bus Head 

The part of an IO Device which couples the device to the bus and does not 
belong to any function group. In the IO Modules - Module Configuration 
Table, the bus head is always located at slot 0. 

CC 

Cross communication between two slaves 

Communication phase 

During getting operational, a Sercos device runs through various phases. 
These are called communication phases.  

For a detailed description see references [3] and [4]. 

Compact IO Device 

A compact IO device is an IO Device which contains one or more fixed IO 
functions, for instance a 16 bit digital input module could be considered to 
be a compact IO device. It is not structured into separate function groups or 
modules. 

Consumer 

The consumer of a connection is a participant in unidirectional 
communication who receives (“consumes”) data. Within a producer-
consumer model, each connection can have one or multiple consumers. 

CP 

See Communication phase 

Cross communication 

Communication between participants which are not in a master-slave-
relation, for instance between 2 slaves or between 2 masters. 
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Device Type Manager 

The Device Type Manager (DTM) is a software module with graphical user 
interface for the configuration and/or for diagnosis of devices. 

DHCP 

Dynamic Host Configuration Protocol 

A protocol for automatic assignment of IP addresses to devices in a 
network. 

DTM 

See Device Type Manager 

Drive 

A drive is a (electromechanical) device according to FSP Drive 
specification. 

Electronic Label 

For each Sercos device an electronic label holds device-related 
information. It can be accessed via IDN S-0-1300. The following items may 
be stored in the electronic label: 

• S-0-1300.x.01 Component Name  

• S-0-1300.x.02 Vendor Name  

• S-0-1300.x.03 Vendor Code  

• S-0-1300.x.04 Device Name  

• S-0-1300.x.05 Vendor Device ID  

• S-0-1300.x.06 Connected to sub-device  

• S-0-1300.x.07 Function revision  

• S-0-1300.x.08 Hardware Revision  

• S-0-1300.x.09 Software Revision  

• S-0-1300.x.10 Firmware Loader Revision  

• S-0-1300.x.11 Order number  

• S-0-1300.x.12 Serial Number  

• S-0-1300.x.13 Manufacturing Date  

• S-0-1300.x.14 QS Date  

• S-0-1300.x.20 Operational Hours  

• S-0-1300.x.21 Service Date  

• S-0-1300.x.22 Calibration Date  

• S-0-1300.x.23 Calibration Due Date 

Field Device Tool 

FDT specifies an interface, in order to be able to use DTM (Device Type 
Manager) in different applications of different manufacturers. 
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FDT 

See Field Device Tool 

FSP Drive 

A specification for mechanical drives to be controlled by Sercos, see 
reference [8]. 

FSP IO 

A specification for IO Devices to be controlled by Sercos, see reference [7]. 

Function Group 

A function group combines related functions of a module within a modular 
IO Device. For instance, all digital input channels of a specific module 
would set up a function group “Digital Inputs” for that module. 

Hybrid IO Device 

A hybrid IO device combines an IO device (compact or modular IO Device) 
with a drive. 

IDN 

An IDN is a unique identification number for a parameter or procedure 
command within Sercos. For a list of generally applicable IDNs see 
reference [5]. 

IO Device 

An IO Device is a Sercos device according to the FSP IO specification 
(reference [7]) 

In Sercos there are three kinds of IO devices defined, see there: 

• Compact IO Devices 

• Modular IO Devices 

• Hybrid IO Devices 

IP Address 

An IP address is an address identifying a device or a computer within a 
network using the IP protocol. IP addresses are defined as a 32 bit number. 
Usually, for ease of notation the IP address is divided into four 8 bit 
numbers which are represented in decimal notation and separated by 
points: 

a.b.c.d 

where a.b.c.d are each integer values between 0 and 255.  

Example: 192.168.30.15 

However, not all combinations are allowed, some are reserved for special 
purposes. 

The IP address 0.0.0.0 is defined as invalid.  
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Master 

Sercos Master devices initiate the data traffic on the bus. In the Sercos 
protocol Master devices are called active participants. A master may send 
messages without external request. 

MDT 

Master Data Telegram 

The Master Data Telegram (MDT) is a special telegram used for 
transmission of  real-time data from the master to the slaves. The format of 
the MDT is predefined within the specification of Sercos in the third 
generation.  

Modular IO Device 

A modular IO device contains a complex or variable configurable device 
which is structured into separate modules. For these modules, there are 
separate function groups defined. 

Multi-Slave Device 

A multi-slave device contains multiple slaves in one device in a common 
housing  which can be separately accessed but commonly administered. 

Object Dictionary (OD) 

An object dictionary is a storage area for device parameter data structures 
and procedure commands within Sercos. It contains numerous data sets 
which can be accessed via their IDN. 

ODMV3 

The Online-Data-Manager Version 3 (ODMV3) is an application interface. 
The ODMV3 works as a server, which can be run as an out-proc server or 
system service. Its task is to provide different applications (e. g. 
SYCON.net), access to multiple devices and even share one device 
amongst several applications. 

PDIN 

This is an area in which process data input is stored. 

PDOUT 

This is an area in which process data output is stored. 

Procedure Command 

Some IDNs do not store values, but are connected to an action (the 
execution of a command). These are denominated as  command 
procedures. 

Producer 

The producer of a connection is a participant in unidirectional 
communication who sends (“produces”) data. Within a producer-consumer 
model, each connection can have only one unique producer. 
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Producer Cycle Time 

The (constant) time period between two directly subsequent data 
transmissions of a producer (within the producer-consumer model). 

RS232 

An interfacing standard for serial communication on data lines defined by 
EIA (Electronic Industries Alliance) in ANSI/EIA/TIA-232-F-1997. 

SDDML 

SDDML = Sercos Device Description Markup Language 

The device description file describes the technical characteristics of a 
device type in an exactly defined format. SDDML descriptions are 
generated by the device manufacturer individually for each device type and 
provided to the user as SDDML files. 

As the file format is standardized, the projecting system can easily access 
the description and take these data into account during system 
configuration. 

Sercos 

SErial Realtime COmmunication System 

A communication system for industrial Ethernet designed and developed by 
Bosch-Rexroth GmbH and supported by the user organization Sercos 
international e.V. (SI) located in Süssen, Germany. It provides a 
standardized interface for collision-free real time communication between 
up to 511 participants. It is especially suited for hard real-time 
requirements. 

Sercos address 

A Sercos address is a numerical value in the range between 0 and 511, 
which is used for unique identification of a device within the Sercos 
network. 

Slave 

Slave devices are peripheral devices, like for example I/O devices or 
drives. Slave devices are also called passive participants. They do not 
receive the bus access authorization. That means, they may only accept 
received messages from the Master or send a message to the Master after 
enquiry of the Master. 

Structure Element 

A structure instance may be divided in one or multiple structure elements.  

Structure Instance 

An IDN may be divided in one or multiple structure instances. Each 
structure instance may contain one or multiple structure elements 

 

TCP/IP 

Transmission Control Protocol/Internet Protocol 

A pair of protocols widely used in the Internet 
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USB 

Universal Serial Bus 

Watchdog Timer 

A watchdog timer provides an internal supervision mechanism of a 
communication system. It supervises that an important event happens 
within a given timeframe (the watchdog time which can be adjusted 
accordingly, for instance by a parameter in the “Set Configuration” 
message) and causes an alarm otherwise (usually this is accomplished by 
changing the operational state of the communication system to a more safe 
state). 
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Fax:     +49 (0) 6190 9907-50 
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Support 
Phone: +49 (0) 6190 9907-99 
E-Mail: de.support@hilscher.com 
 

 
 
 
 
 
 
 
 
 
 
 
 

Subsidiaries 
 

 

China 
Hilscher Systemautomation (Shanghai) Co. Ltd. 
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Support 
Phone: +33 (0) 4 72 37 98 40  
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Hilscher India Pvt. Ltd. 
Pune, Delhi, Mumbai 
Phone:  +91 8888 750 777 
E-Mail: info@hilscher.in 
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Hilscher Italia S.r.l. 
20090 Vimodrone (MI) 
Phone: +39 02 25007068 
E-Mail: info@hilscher.it 
Support 
Phone: +39 02 25007068 
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Hilscher Japan KK 
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Phone: +81 (0) 3-5362-0521 
E-Mail: info@hilscher.jp 
Support 
Phone: +81 (0) 3-5362-0521 
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Korea 
Hilscher Korea Inc. 
Seongnam, Gyeonggi, 463-400 
Phone: +82 (0) 31-789-3715 
E-Mail: info@hilscher.kr 
 
Switzerland 
Hilscher Swiss GmbH  
4500 Solothurn 
Phone: +41 (0) 32 623 6633 
E-Mail: info@hilscher.ch 
Support 
Phone: +49 (0) 6190 9907-99 
E-Mail: ch.support@hilscher.com 
 
USA 
Hilscher North America, Inc.  
Lisle, IL 60532 
Phone: +1 630-505-5301 
E-Mail: info@hilscher.us 
Support 
Phone: +1 630-505-5301 
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